CLARUS 500/580 GC

User’s Guide

PerkinElmer
For the Better
Clarus 500/580 GC
User’s Guide
Release History

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Release</th>
<th>Publication Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>09936625</td>
<td>C</td>
<td>February 2010</td>
</tr>
</tbody>
</table>

Any comments about the documentation for this product should be addressed to:

User Assistance
PerkinElmer, Inc.
710 Bridgeport Avenue
Shelton, Connecticut 06484-4794
U.S.A.

Or emailed to: info@perkinelmer.com

Notices
The information contained in this document is subject to change without notice.
Except as specifically set forth in its terms and conditions of sale, PerkinElmer makes no warranty of any kind with regard to this document, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose.
PerkinElmer shall not be liable for errors contained herein for incidental consequential damages in connection with furnishing, performance or use of this material.

Copyright Information
This document contains proprietary information that is protected by copyright.
All rights are reserved. No part of this publication may be reproduced in any form whatsoever or translated into any language without the prior, written permission of PerkinElmer, Inc.

Copyright © 2010 PerkinElmer, Inc.

Trademarks
Registered names, trademarks, etc. used in this document, even when not specifically marked as such, are protected by law.

PerkinElmer is a registered trademark of PerkinElmer, Inc.
# Table of Contents

**Introduction** .............................................................................................................. 1-1
  - About This Manual .................................................................................................. 1-3
  - Conventions Used in this Manual ........................................................................ 1-4
  - Warning Signs on the Instrument........................................................................ 1-5
  - Screen Abbreviations .............................................................................................. 1-6
  - Glossary of Clarus GC Terms ................................................................................ 1-7
  - Autosampler Terms .................................................................................................. 1-8
  - Instrument-Specific Terms ...................................................................................... 1-9
  - Glossary of Chromatographic Terms ..................................................................... 1-11

**Touch Screen Navigation** ......................................................................................... 2-1
  - Chapter Overview .................................................................................................... 2-3
  - Touch Screen .......................................................................................................... 2-4
  - Navigation Bar ........................................................................................................ 2-17
  - Injectors .................................................................................................................. 2-18
  - Oven ....................................................................................................................... 2-31
  - Aux Zone ................................................................................................................. 2-32
  - Detectors ................................................................................................................. 2-33
  - Timed Events .......................................................................................................... 2-49

**Using the Active Method** .......................................................................................... 3-1
  - Overview ................................................................................................................. 3-3
  - Editing the Active Method ...................................................................................... 3-4
  - Getting Ready to Edit the Active Method ............................................................. 3-5
  - Setting Up Oven and Inlet Temperature Programs ............................................ 3-6
  - Setting Injector Temperatures .............................................................................. 3-14
  - Viewing/Setting Carrier Gas Pressure/Flow/Velocity ......................................... 3-21
  - Setting the Septum Purge Mode and Offset ......................................................... 3-33
  - Setting Up Valves .................................................................................................... 3-41
  - Set up the Splitless Mode for a CAP or PSS Injector ......................................... 3-49
  - Controlling the Autosampler ................................................................................ 3-62

**Setting Up the Detectors** .......................................................................................... 4-1
  - Overview ................................................................................................................. 4-3
  - FID Overview ........................................................................................................ 4-5
  - Setting up an ECD ................................................................................................. 4-28
  - Setting up a TCD .................................................................................................... 4-43
  - Setting up a PID ..................................................................................................... 4-54
  - Setting Up a PID and EICD in Series .................................................................... 4-67
  - Setting Up a NPD ................................................................................................... 4-80
  - Setting up a FPD ................................................................................................... 4-99
  - Detector temperatures ......................................................................................... 4-128
  - Setting the Range ................................................................................................. 4-130
Changing the FID, PID, or NPD Range During a Run ............................ 4-131
Setting the TCD Current (Filament Current) ........................................... 4-133
Changing TCD Polarity During a Run ..................................................... 4-135
Routing Detector Output .......................................................................... 4-137
Attenuating Detector Signals Going to a Recorder ............................... 4-141
Optimizing a Detector Signal to an Integrator for Maximum Sample Dynamic Range .............................................................. 4-143
Matching Detector Signals with Your Integrator ..................................... 4-144
Autozeroing a Detector ............................................................................ 4-146

Using the Method Editor ........................................................................ 5-1
Method Editor .............................................................................................. 5-3
Method Edit Mode ....................................................................................... 5-5
Overwriting the Active Method ............................................................... 5-9

Using the Tools Menu .............................................................................. 6-1
Tools Menu .................................................................................................. 6-3
Method Editor .............................................................................................. 6-4
Event Log ..................................................................................................... 6-5
Maintenance ................................................................................................. 6-7
Configuration ............................................................................................... 6-9
Oven ........................................................................................................... 6-19
Connecting the PPC Modules .................................................................. 6-38
Calibrating the Flow Readout Using Manual Pneumatics ......................... 6-67
Calibrating the Oven Temperature ............................................................ 6-74
Utilities ....................................................................................................... 6-82
Release ....................................................................................................... 6-93
Reset ......................................................................................................... 6-94
Logout ......................................................................................................... 6-95
About ......................................................................................................... 6-96

Setting up a Typical Analysis ................................................................. 7-1
System Status Screen ................................................................................ 7-4
Injectors ....................................................................................................... 7-6
Detector ...................................................................................................... 7-10
Detector ...................................................................................................... 7-15
Autosampler ............................................................................................... 7-19
Introduction
About This Manual

This guide is divided into following chapters:

**Chapter 1 Introduction**

This chapter contains a brief introduction to the instrument, the conventions and warnings used in the manual.

**Chapter 2 Touch Screen Navigation**

This chapter contains information that introduces you to the look and feel of the touch screen. It shows you how to turn on the GC, check the status, and perform fundamental operations such as changing parameters, selecting options, using the tools menus, etc.

**Chapter 3 Active Method**

This chapter contains step by step explanation of the active method. Detailed information on setting up the autosampler is contained in this chapter.

**Chapter 4 Setting Up the Detectors**

This chapter contains detailed information on setting up the detectors.

**Chapter 5 Using the Method Editor**

This chapter describes how to modify, save and use the method editor.

**Chapter 6 Using the Tools Menu**

The chapter contains detailed information on the tools menu section of the touch screen.

**Chapter 7 Setting Up a Typical Analysis**

This chapter contains information on how to run a typical analysis on the Clarus GC using the most common configuration.
Introduction

**Conventions Used in this Manual**

Normal text is used to provide information and instructions.

**Bold** text refers to text that is displayed on the screen.

All eight-digit numbers are PerkinElmer part numbers unless stated otherwise.

**Notes, cautions and warnings**

Three terms, in the following standard formats, are also used to highlight special circumstances and warnings.

**NOTE:** A note indicates additional, significant information that is provided with some procedures.

---

**CAUTION**

*We use the term CAUTION to inform you about situations that could result in serious damage to the instrument or other equipment. Details about these circumstances are in a box like this one.*

---

**WARNING**

*We use the term WARNING to inform you about situations that could result in personal injury to yourself or other persons. Details about these circumstances are in a box like this one.*
## Warning Signs on the Instrument

For detailed safety information see the Safety Practices chapter in the Clarus 500/580 GC Hardware Guide (09936591).

<table>
<thead>
<tr>
<th>Image</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Caution, hot surface" /></td>
<td>Caution, hot surface.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Caution, risk of electric shock" /></td>
<td>Caution, risk of electric shock.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Caution, laser radiation hazard" /></td>
<td>Caution, laser radiation hazard.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Caution (refer to accompanying documents)" /></td>
<td>Caution (refer to accompanying documents).</td>
</tr>
</tbody>
</table>
Screen Abbreviations

AUX – Auxiliary zone
Cap – capillary split/splitless injector
Cmptr – computer
Ctrl – syringe control parameters
ECD – Electron Capture Detector
ElCD – Electrolytic Conductivity Detector
FID – Flame Ionization Detector
FPD – Flame Photometric Detector
Gen – generate
Inj/Vial – injections per vial
Int – integrator
kPa – kilopascals
NPD – Nitrogen Phosphorus Detector
PID – Photoionization Detector
Pkd – packed injector
POC – Programmed On-Column Capillary Injector
PPC – programmed pneumatic control
Pre – # of preinjection syringe washes
Psi or psig – pounds per square inch (gauge)
PSS – Programmed Split/Splitless Capillary Injector
TCD – Thermal Conductivity Detector
Glossary of Clarus GC Terms

The glossary of Clarus GC terms are divided into two types:

- Autosampler Terms
- Instrument-Specific Terms
# Autosampler Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Washes</td>
<td>Washing the syringe.</td>
</tr>
<tr>
<td>Pre</td>
<td>The number of prewashes of sample to prime the syringe (no pumping).</td>
</tr>
<tr>
<td>Post</td>
<td>The number of post injection syringe washes with a solvent.</td>
</tr>
<tr>
<td>Pumps</td>
<td>The number of times the syringe draws up sample and evacuates it before acquiring the volume. This is done to eliminate bubbles.</td>
</tr>
<tr>
<td>Mode</td>
<td>The style of injection.</td>
</tr>
<tr>
<td>Fast</td>
<td>Fast speed of the syringe during sample injection. This is used to eliminate discrimination in the needle.</td>
</tr>
<tr>
<td>Normal</td>
<td>Normal speed of the syringe during sample injection.</td>
</tr>
<tr>
<td>Slow</td>
<td>Slow speed of the syringe during sample injection in order to inject directly into a wide-bore capillary column, in hot injection port.</td>
</tr>
</tbody>
</table>
### Instrument-Specific Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background compensation</td>
<td>A routine that automatically subtracts a stored calibrated baseline profile from the signal generated during a GC run.</td>
</tr>
<tr>
<td>Ballistically</td>
<td>Changing the oven temperature as quickly as possible to reach a set point.</td>
</tr>
<tr>
<td>Detector background</td>
<td>The detector output signal when no components are being eluted.</td>
</tr>
<tr>
<td>Equilibration</td>
<td>The delay time after the method set points have been reached before the system becomes READY.</td>
</tr>
<tr>
<td>Flameout</td>
<td>PPC version only. Detects if the flame is on to prevent injection into a nonfunctioning system and subsequent loss of sample.</td>
</tr>
<tr>
<td>Isothermal method</td>
<td>A method in which the oven temperature remains constant throughout a GC run.</td>
</tr>
<tr>
<td>Method</td>
<td>A collection of parameters that control the GC.</td>
</tr>
<tr>
<td>Negative-time event</td>
<td>A timed event that you set to occur before the instrument becomes READY.</td>
</tr>
<tr>
<td>Parameter</td>
<td>An independent variable used to specify a condition to be met.</td>
</tr>
<tr>
<td>PPC™</td>
<td>Programmable Pneumatic Control</td>
</tr>
<tr>
<td>Pre-run</td>
<td>The time after equilibration during which negative-time events are executed.</td>
</tr>
<tr>
<td>PreVent™</td>
<td>PPC version only. Sample management system.</td>
</tr>
</tbody>
</table>
## Introduction

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>For a Flame Ionization Detector, range means amplification of the detector output signal.</td>
</tr>
<tr>
<td>Ready</td>
<td>Indicates that all method parameters have reached their set points and that you can start your analysis.</td>
</tr>
<tr>
<td>Run</td>
<td>The time from sample injection to the end of the oven temperature program.</td>
</tr>
<tr>
<td>Sleep mode</td>
<td>The GC can be set to a predefined method for gas savings.</td>
</tr>
<tr>
<td>Temperature program</td>
<td>PPC version only. A program that specifies the rate of oven temperature increase from one plateau to the next, and the time the oven temperature is held constant at a plateau.</td>
</tr>
<tr>
<td>Timed Events</td>
<td>Events that take place before or during a GC run as specified in a timed events table.</td>
</tr>
<tr>
<td>Zone</td>
<td>A heated area in the GC oven, injector, or detector.</td>
</tr>
</tbody>
</table>
Glossary of Chromatographic Terms*

Adsorption – A process that occurs at the surface of a liquid or solid as a result of the attractive forces between the adsorbent and the solute. These forces may be physical or weakly chemical.

Analysis – The complete investigation of a sample by gas chromatographic separation including identification of the sample components and quantitative measurements.

Anode – The negatively charged electrode in any electrical circuit to which charged particles and ions are attracted.

Band Broadening – A process that occurs in the GC whereby the peak width for a component increases the longer the component travels through the column.

Baseline – The detector signal to a recorder or integrator when only the carrier gas is passing through the detector.

Baseline drift – Any regular change occurring in the baseline signal from the detector, usually resulting from column temperature and/or gas flow changes.

Blank run – A run without the sample being injected.

Bleed – The evaporation of the stationary phase from a column.

Capillary column (wall coated open tubular column) – A small-inner-diameter column whose inside wall is coated with a liquid phase.

Carrier gas – The mobile phase of the separation system. An inert gas which transports the sample from the injector through the column to the detector. This gas is usually helium, hydrogen, or nitrogen.

Column conditioning – A process for producing a stable column by heating the column with carrier gas flowing to remove volatile impurities from the stationary phase.

Detectors – Hardware that responds to sample components producing an electrical signal that can be measured to quantitate the amount of each component present.

Flow programming – The stored PPC program is interpreted as real column mass flow settings or capillary column flow settings from which the inlet

pressure is calculated. This is dependent on the capillary control mode and installed pressure or split control option.

**Flow rate** – The mass flow of carrier gas or detector gas in milliliters per minute.

**Ghost peaks** – Peaks that are not due to sample components, for example, peaks produced by carrier gas impurities, septum, or components from previous analyses.

**Injection port** – The hardware through which the sample is introduced to the column by injection.

**Linearity** – Quantitatively all detectors will produce a linear response with respect to solute concentration over a defined range, for example, the Linear Range.

**Liquid phase** – The material in the column that causes the components to separate because of partitioning of the components between the mobile phase (carrier gas) and the stationary phase (liquid phase).

**Lowest limit of detection** – The smallest amount of sample that can be detected by the detector being used. Usually defined as any signal that is as great as two times the noise level. Also referred to as Minimal Detectable Quantity (MDQ).

**Mobile phase** – The gas which carries the solute (sample) along and over the column material. This carrier gas is inert and usually helium, nitrogen, or hydrogen.

**Noise** – Background signal fluctuations arising from a detector response. This response is the result of the column installed, carrier gas purity, electronic components, etc. The response of any detector is defined by the signal-to-noise ratio.

**Partition Coefficient** – The differential solubility of a substance in two different phases. In the case of gas–liquid chromatography, the sample components reach an equilibrium between the gas phase (mobile) and the liquid phase (stationary). Each component has a different partition coefficient thus causing separation in the column.

**Pressure programming** – Pressure control through an independent four-step, three-ramp program for each carrier gas channel.

**Resolution** – The degree of separation between two peaks.

**Retention time** – The time interval from the point of injection to the appearance of the peak maximum, of a component’s signal.
**Septum** – Silicone rubber material placed in the injection port through which the injection is made. When the needle is withdrawn, the silicone rubber reseals, thus not allowing any sample or carrier gas to escape.

**Stationary phase** – The liquid or solid adsorbent portion of the column that retains components passing through the GC column.

**Subambient** – Below ambient temperature. The oven cools down below ambient temperature with the use of either liquid nitrogen or liquid carbon dioxide.

**Syringes** – Precision dispensing devices used to deliver sample to the GC. Liquid and gas syringes are available.

**Tailing** – When a peak is not symmetrical or Gaussian shaped but the back end is broadened, it is said to be tailing.

**Temperature programming** – A technique commonly used to increase the rate of elution of the components. After the sample is injected into the oven at a specific temperature, the temperature program increases the oven temperature to the prescribed temperature at a defined rate (in °C/min).

**Unretained peak** – A component that is not retained by the column. The time taken for an unretained sample to pass through the column is the same time as the time taken for the carrier gas to pass through.

**Velocity programming** – Programmed linear velocity where the PPC controller interprets stored PPC programs as the average capillary column linear velocity settings.
Introduction
Touch Screen Navigation
Touch Screen Navigation
Chapter Overview

You operate the Clarus GC using the touch screen. The touch screen is the interface between you and the instrument, enabling you to control the Clarus GC in order for you to perform your analyses easily and conveniently. The touch screen contains active areas that you touch to perform the required action.

You may find it more convenient to use a stylus or you may like to touch the active areas of the touch screen. Do not use sharp, pointed objects.

A light touch is all that is needed. You do not need to press forcefully on an active area.

Please note that when you touch an active area, various processes are started in the instrument. Some of these processes may take several seconds. Be patient and wait for the process to complete before touching another active area on the touch screen.

This chapter gives a brief overview on touch screen definitions and navigation. For details on using the active method, method editor and tools menu see chapters 3, 4 and 5.
Touch Screen Navigation

**Touch Screen**

The main display area on the touch screen are referred to as screens. You use various screens to set up your Clarus GC to perform the analyses. These screens contain:

- **Entry fields** which allow you to make entries,
- **Buttons** that you touch to start or stop actions or to display a dialog,
- **Option Buttons** that you select drop down menu options from a list,
- **Boxes** that you use to switch functions on or off and
- **Radio Button** that allow you to choose one of two or more options.

The Clarus GC is controlled by a collection of operating parameters called the Active Method. You can prepare and save up to five methods and make any one of them the Active Method. However, the fifth method is reserved for TotalChrom and may be overwritten.

The following Status screen shows the different sections of the user interface.

The Status Screen displays icons that provide quick access to major areas of the system. The injector and detector buttons show graphic representations of the devices for each channel. If a heated auxiliary zone is configured, the Aux button with a thermometer appears active on the bottom of the screen. The Aux zone button with the carrier gas icon indicates the PPC carrier gas zone is active. The icon buttons that represent the heated zones (injectors, detectors, oven, and Aux if configured) include a light to indicate the ready/not ready status. A red blinking light indicates not ready and a steady green light indicates ready status.
Click here to view the Signal. If a method is not running the screen will display a baseline.

The Icon buttons provide quick access to all configured areas of the instrument. An indicator light shows the ready/not ready status of each heated zone.

The status bar displays the overall ready/not ready status as well as text messages and the real time clock/date display.

The bottom bar displays the Tools pop up menu. When the system is running the Stop button also appears.

The Title bar displays the name of the active.

The Run button provides access to the Autosampler and Manual Inject settings.

Channel B appears on top of Channel A to emulate the order on top of the GC.
**Touch Screen Navigation**

**Tabs**

Some of the active method screens include tab to allow you to switch views associated with a specific channel.

![Navigation Bar - A Tabs Active](image1)

![Navigation Bar - B Tabs Active](image2)

**Non-Configured Devices**

If a device is installed but not configured, or configured as None, the graphic and light are grayed out.

![Non-Configured Device](image3)

Touching the button prompts the following dialog box.

The following capture shows the drop down list on the injector configuration screen to set a device as “None.”
Non-installed Devices

If a device is not installed, a grayed out deactivated button with no indicator light appears in the designated position.

Touching the button prompts the following dialog box:
Run Button

The Run icon displays the Manual injection and Autosampler settings if the device is enabled. The bottom bar on these screens includes the Start button. When the system is running, the Start button changes to the Stop button. Since the Start button is only available on the Autosampler and Manual inject screens, you must initiate a run from these screens. However, when the system is running, the Stop button appears on all screens allowing you to Stop the run from anywhere in the application. If the system is Paused, the Resume button appears on all screens.

Autosampler

When an Autosampler is enabled, the Run button defaults to that screen. The following screens shows the enable check box on the configuration screen and the associated Autosampler screen in the Active Method.
When the instrument is ready, touch the **Start** button to begin the run. If you touch Start before the system is ready, the run will start when the system reaches the ready status.

When the Autosampler is disabled, the Run button displays the Manual inject screen. When the instrument is ready, touch the **Start** button to begin the analysis. The countdown enable check box is selected by default. You can stop the countdown if needed.
Touch Screen Navigation

Manual Injection

If no Autosampler is installed or configured, the Run button displays the Manual injection screen. The enable check box is selected by default. Touching the start button initiates the countdown starting from 5 seconds. When the countdown reaches 0, an audible beep prompts you to inject the sample. The GC will then start to program the oven and collect data. If the enable check box is deselected, the timer is disabled and the wording in instruction 3 is modified to exclude the tone. The system starts as soon as the Start Button is pressed and you make an injection contemporaneously.
When the Stop Button is pressed, an abbreviated stop menu appears.

**Signal Button**

The Signal icon displays the graphic signal for the active method. If the system is not running, a baseline appears on the graph.
Touch Screen Navigation

The Signal screen displays the selected detector signal over a fixed time period (2 minutes) with you selecting the scaling factor. The raw signal is unprocessed and can appear slightly larger than the processed signal. The processed signal has gone through an attenuation and offset filters.

The name of the channel appears on the top left of the screen. Detector controls include Ignite and Autozero.

Zero Display controls include scaling and zeroing.

Ignite Button

Pressing the Ignite button starts the ignition sequence for a PPC-enabled FID. During ignition the plot and signal level are active.

For information on setting up manual pneumatics for the different detectors see the various detector sections in chapter 4 “Setting Up the Detectors” and sections in Chapter 3 on “Using the Active Method” and Viewing or Adjusting Carrier Gas Pressure Using Manual Pneumatics.

AutoZero Button

Autozeroes the selected detector.

Signal Plot

The plot graph displays the signal from the selected detector in “real time.” The window is 2 minutes wide. The signal commences at the y-axis and is plotted out to start + 1.75 minutes. The signal then scrolls back so the start is now +1 minute, the last 0.75 minutes are displayed from there, and the signal then scrolls out again.

The signal is plotted continually before, during and after a run.

Signal Display and Scaling

The signal display at the top of the screen displays the signal level of the detector in mV.
The default signal scale is 0-1024mV. The up/down arrows will adjust the display between 1 and 1024mV by halving or doubling the current factor.

**Zero Display Button**

The Zero Display button offsets the current signal level to 5% f.s.d. on the display.

**Heated Zones**

The Status screen displays graphic icons to represent the devices installed in the system.

![Heated Zones Diagram](image)

Each type of injector and detector is represented with a customized graphic as well as a text label. Heated zone buttons display a status light indicator in the lower right corner. The indicator lights for individual zones follow the same convention as the system status light that appears in the Status bar. Steady green indicates that the zone is ready. A red blinking light indicates that the zone is not ready.
Touch Screen Navigation

Injector and Detector Buttons

The screen is organized with Channel B devices above Channel A to reflect the position of the channels on top of the GC. Injector and detector buttons display the active method settings for each device. Touching a device icon displays the selected screen as well as a row of tabs to allow easy access to the injector, oven, detector, and events for that channel. Touching the alternative channel icon on the top navigation bar displays the active screen and associated tabs for the other channel if it is installed and configured. The active method screens include navigation icons on the title bar that allow you to access the same elements available from the Status screen.
**Touch Screen Navigation**

**Oven Button**

The oven button provides access to the oven program settings and graph.

![Oven Button Image]

If both channels are running and the Oven is accessed from the Status screen, it defaults to Channel A. The oven program screen displays the same tabs and navigation icons as the injector and detector active method screens.

**Aux Zone Buttons**

If a heated Aux Zone is configured, pressing the Aux button displays a screen that follows the same format as the injector screens and shows the current temperature.
Navigation Bar

The navigation bar provides icons to allow users to seamlessly toggle between channels as well as access the same main areas of the system available from the status screen.

The following diagram shows the navigation bar with the corresponding icons on the status screen.
Injectors

The injector elements that appear on a particular injector screen depend on the injector type as well as selected configuration options. Some injector types offer a variety of options while others are more limited. The labels in the following screen capture identify the main components of an Active Method injector screen. This example shows a screen for a PSS injector with PPC.

Program Buttons

The program icon appears next to the temperature and Carrier Gas fields for a programmable PSS or POC injector. If the program button associated with a
value is active, the entry field is grayed out. You must go to the program screen to modify the settings.

If the programmable injector is not configured to program the setting, the program button is grayed out. In most cases, fields with a deactivated program button are editable, allowing you to modify the setting directly.

**Display Text**

The text next to the set point entry fields show the current values. If the injector configuration allows you to display the value in other units, such as velocity or flow, the display text shows the actual values for all of the available options.

**PSS**

This section describes the main components of the PSS active method screen and the relationship between program and configuration options.

**Configuration Options**

The following capture shows the configuration drop down menus for the three main areas and how they correspond to the entry fields in the active method.
Temperature Program

The PSS temperature program can be set for Oven or Inlet programming. If Inlet programming is selected, the program button on the active method screen is active.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oven</td>
<td>The oven programmed mode is the default mode of operation. In this mode, the injector setpoint equals the oven setpoint plus 5 °C.</td>
</tr>
<tr>
<td>Inlet</td>
<td>In the inlet programmed mode, the injector is first heated to the injector temperature that is entered in the method. The injector then follows the injector temperature program that you defined.</td>
</tr>
</tbody>
</table>

The temperature field displays the set point value. The label below the field displays the current step. The text to the left of the field displays the actual temperature.
To modify the temperature program during a run, touch the program button. You can modify the temperature, time, or rate. However, if the program currently in that step, the changes will be ignored.
**Isothermal Program**

If the program is isothermal, the program button is grayed out and the top-level field is active. Changes entered in the field take effect immediately.

**Carrier Gas Program**

The Carrier Gas options for PSS include flow, velocity, or pressure. If the option for cap control is selected, you can program the carrier gas according to one of the three values. The corresponding actual values for the other units appear as read-only text on the screen. Touching the program button next to the field displays the associated program for the entry field value.
The Carrier Gas is configured for Pressure. This option appears in the entry field. Touching the program button displays the Carrier Pressure Program.
Touch Screen Navigation

The Carrier Gas is configured for Velocity. This option appears in the entry field. Touching the program button displays the Carrier Velocity Program.

Split Flow
The PPC system adds the split flow offset to the method's split flow rate setpoint to obtain the **Total** split flow rate delivered to the inlet system. The total value is equal to the setpoint flow rate (the flow at the column entrance) plus the offset flow rate. The inlet system flow controller delivers the **Total** flow rate, not the setpoint flow rate.

**Capillary Control Off**

![Image of Capillary Control Off](image)

**PPC**

![Image of PPC](image)
The packed injector has a fixed, non-programmable temperature field. The carrier gas can be programmed by Pressure or Flow as shown in the following captures.
PPC

![PPC Configuration Screen](image-url)
Touch Screen Navigation

Manual

POC

The POC injector can be programmed by Inlet or Oven. The POC injector is configured and controlled according to the same parameters as the PSS injector.
PPC

Manual
Touch Screen Navigation

Capillary (Cap)

PPC

![Image of Touch Screen Navigation]

Manual

![Image of Touch Screen Navigation]

2-30
The Oven Temperature Program provides fields and a graph that reflect the current temperature program as shown in the screen on the left below. Pressing the **Go to** button invokes a dialog box that allows users to raise the temperature to a value associated with another step. The last step of the current program is selected by default. Radio buttons for steps that exceed the number of steps in the current program are deactivated.

In the example below, **step 4** is selected. As soon as the user touches the **OK** button the change is implemented. The graph in the capture on the right shows the immediate temperature rise and the departure from the program.
**Aux Zone**

If the GC is configured with an auxiliary zone, the button appears on the status screen. Touching the Aux button displays a dialog box with the setpoint and actual temperature.
**Detectors**

Detector screens provide fields that allows you to control a number of parameters during a run, such as temperature, range, and attenuation. Other active elements include a Heater Off check box to turn off the detector and an AutoZero check box. Selecting the AutoZero check box prompts the system to zero the signal before the run and also activates the Signal button on the Signal screen. The mV value next to the small signal icon that displays the current signal. The read-only text provides details about configuration settings. The following screen shows the major components that apply to all detector screens. The Gas Flow section is only included with PPC. The subsections that describe each detector type includes details about settings that are unique to that particular detector.
The FID (Flame Ionization Detector) uses a hydrogen and air flame to generate ions from the combustion of an organic compound. The detector collects and measures the concentration of these ions to determine the amount of compound in the sample. The FID active method screen varies depending on whether the detector is configured with manual or programmable pneumatics. This section describes the screen components for each type of configuration.
**PPC**

The Ignite button allows you to light the FID flame.

![PPC screen capture](image)

**Auto-Ignition**

The PPC version of the FID has *flameout* detection and an *auto-ignite* feature. Flameout detection occurs 0.5 minutes into the PRE-RUN time and it measures the user-entered baseline threshold level in mV. If the threshold level is exceeded, the flame is considered lit, otherwise the Clarus GC detects that the flame is out and auto-ignite automatically lights the flame before the start of a run.

With the FID temperature set, the air and hydrogen flows set, and auto-ignition activated by setting a positive mV value for the flame offset, the FID attempts auto-ignition at -0.5 min. before the system becomes ready. At this
Pre-run time the status bar flashes “Flame Ignition” as the air flow is shut off, hydrogen purges the FID for about 10 seconds, and the ignitor energizes for ignition followed by a return of the air flow to the detector to sustain the flame.

After the flame ignites, the FID output level is monitored to confirm ignition before producing a READY signal. If ignition is not confirmed, the ignition process repeats up to two more times if needed. If ignition is not achieved after three attempts, the flame gases are set to off and a dialog box appears displays the following message:

“Flame 1 or 2 failed to ignite.”

Touch the OK button. The status is made NOT READY and “FID 1 or 2 flameout” appears. If auto-ignition is attempted with the FID gases set to zero flow, the message “No ignition. Flame gases are off” appears on the screen. To proceed, go the PPC screen and touch Reset to the Configuration screen and reset the air and hydrogen to their 450 and 45 mL/min flowrates.

**Auto-Ignite**

The auto-ignition process only occurs before the start of each run just prior to the instrument becoming READY. However, the manual flame ignition process, performed by touching the Ignite button, can be initiated at any time.

Auto-ignite proceeds in the following sequence:

1. When auto-ignite begins the Clarus GC equilibrates.

2. Once the two minutes of equilibration expire, PRE-RUN begins and the GC detects that the flame is not lit and indicates this by alternately flashing Flame? and Method 5 in the status bar.

3. After determining that the flame is not lit, the GC switches to a not ready state and attempts to automatically ignite the flame. Flame Ignition 1 appears in the status bar.

4. The air flow is shut-off and hydrogen is purged through the FID for 10 seconds.
5. The ignitor energizes, the flame ignites (indicated by the a pop sound), and air flow is returned to sustain the flame. The FID output level is monitored to confirm that the flame is lit. If a lighted flame is not confirmed, the GC repeats the ignition process up to two more times.

Configuration Settings

The following graphic shows the configuration screen with the settings that appear on the active method screen.
Manual

The manual version of the FID shares several common elements with the PPC version. The only difference is that the gas flow settings do not appear on the screen. The Auto-Ignite feature is not available with manual pneumatics.
TCD

The TCD-Thermal Conductivity Detector is a dual-channel detector that uses makeup and reference gases as well as a bridge current.

PPC
Touch Screen Navigation

Manual

![Touch Screen Navigation Manual Image]
ECD

The ECD, Electron Capture Detector, contains an 63 Ni radioactive foil coating and requires careful handling to ensure that it does not create a safety hazard. In order to prevent a Thermal Runaway risk, the GC shuts down if any heated zone exceeds 470° C. If this occurs, the following message appears:

“Warning

Instrument Shutdown

Thermal Runaway xxxxx zone

Call your PerkinElmer service representative”

Instrument shutdown also occurs if there is a PRT (Platinum Resistance Thermometer) or MPU (Micro Processor Unit) failure. In this case, the following message appears:

Instrument Shutdown

xxxx zone PRT error

Call your PerkinElmer service representative

The ECD works with nitrogen carrier or makeup gas or a carrier or makeup gas mixture of 95% argon/5% methane. When using capillary columns at low flows (5 mL/min or less), helium or hydrogen may be used as the carrier gas provided nitrogen or argon/methane is used as the make-up gas.
Touch Screen Navigation

PPC

![PPC Screen Display]
Manual

The Photoionization Detector uses an ultraviolet light to ionize the effluent from a chromatographic column. It is equipped with a glass-lined inlet and exhaust that permits series operation with another detector, such as the EICD.
Touch Screen Navigation

PPC

[Image of Touch Screen Navigation interface]

2-44
Manual
Touch Screen Navigation

EICD/PID

Manual
NPD
PPC

Manual
Touch Screen Navigation

FPD

PPC

Manual
**Timed Events**

**Events Tab**

The Events tab accesses the timed events table and buttons, valves, and Aux gas controls.

<table>
<thead>
<tr>
<th>Element</th>
<th>Enabling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timed events table</td>
<td>Always</td>
</tr>
<tr>
<td>Aux gas button</td>
<td>PPC configuration</td>
</tr>
<tr>
<td>Relays</td>
<td>Always (see below for details)</td>
</tr>
<tr>
<td>Insert button</td>
<td>Always</td>
</tr>
<tr>
<td>Edit button</td>
<td>Always</td>
</tr>
<tr>
<td>Delete button</td>
<td>Always</td>
</tr>
<tr>
<td>Clear button</td>
<td>Always</td>
</tr>
</tbody>
</table>
**Timed events table**

The timed events table displays the time, name, and value of each event. Timed events may be added and removed while the GC is running. The next event to be executed is automatically selected. Up to 32 events can be specified. The configured hardware determines which events are available. Events that are not applicable should not be available. The following table lists the available events.

The time range is -99 to 999 minutes. Events occurring after the temperature program is complete are ignored.

**Insert**

The insert button displays settings that allows you to specify an event to add to the table.
Error Messages

Edit

Touching this button displays the active method page for editing timed events. If the GC is running, then edited events at times before the run time at which the edited list is accepted do not occur until the next run.
Delete

Touching the Clear button deletes the contents of the entire event table. A dialog box confirms the action.

Pressing Yes clears the table. Touching the No button closes the dialog box and retains the contents of the Events table.

If the table is empty, the following Error message appears:

Clear

Event
Value

The value box function depends on the event. For some events, such as Carrier X, a numeric value is required. For others, such as TCD polarity, a choice between two options is required.

The PreVent/ProTect/MS Vent valves are never operated during a run and are not required in the Timed Events list.

- No timed event should have the same time as another timed event.
- Time resolution is 0.01 minutes.
- Timed Events may be entered and removed in any sequence.
- Pressing the Clear button prompts a dialog box: "This action will clear the entire table. Do you want to continue? "Yes" "No"
- Timed Events are re-ordered chronologically after each entry. The capacity is 32 entries.
Relays

They appear as set in the configuration screen.

User can turn on the initial and/or current settings by touching the check box.

If GC is Ready, changing the initial setting will change the current setting.

The initial settings are stored in the method and are only changed if the user modifies them.

The current settings are changed via Timed Events.

Any settings may be changed during a run.
Aux Zones

Heated Aux Zone
If the GC is configured with an auxiliary zone, the activated button appears on the status screen.

Touching the Aux button displays a dialog box with the setpoint and actual temperature.

To modify the temperature, press the minus or plus button. Touch OK to implement the value and close the dialog box.

Pneumatic Auxiliary Zones
Up to four pneumatic zones can be set for PPC carrier gas control. When one or more of the aux zones is configured, the following button appears on the status screen.

The same button also appears on the Events screen.

Touching the button displays the following screen:
Aux Zones that have been set in PPC configuration display the configured unit type and include a status indicator light. The initial values can be modified via timed events. The current value is shown next to the initial value field.
Using the Active Method 3
Using the Active Method
Overview

The Clarus GC is controlled by a collection of operating parameters called the Active Method. You can prepare and save up to five methods and make any one of them the Active Method. However, the fifth method is reserved for TotalChrom (external computer controlled software) and may be overwritten.

The operating parameters include the an oven temperature program; injector temperature or injector temperature program; detector temperature or detector temperature program; carrier gas pressure set for pressure flow or velocity; valve settings (for example, the operation of a gas sampling valve or split/splitless operation of capillary column); a timed events table, and a variety of parameters for controlling data output.

Active Method parameters are always saved when you turn the Clarus GC off, and automatically reloaded when you turn it back on.
Using the Active Method

**Editing the Active Method**

If you have read and used the chapters in this manual sequentially, as recommended, by now you have probably installed and conditioned one or two columns, and set up one or two detectors. Also, you were probably not aware at the time that you modified certain Active Method parameters. Since the conditions used then were not necessarily those required by the analyses you want to perform, you should now edit the Active Method to set your operating parameters.

Examples of how to perform the tasks listed below are described in the sections which follow. You should, of course, substitute your values for ours.

- Setting up oven temperature programs
- Setting injector temperatures/programs (PSS and POC)
- Setting detector temperatures
- Viewing/setting carrier-gas pressure/programs (PPC)
- Viewing/setting carrier-gas flow/programs (PPC)
- Setting up valves
- Setting FID, PID, NPD, or FPD range
- Setting TCD filament current
- Routing detector output
- Attenuating detector signals
- Autozeroing a detector
- Building a timed events table
Getting Ready to Edit the Active Method

- Close the oven door.

The Status screen icon buttons provide access to the active method parameters.

**NOTE:** When you change an Active Method parameter, the change goes into effect immediately. For example, if the system is READY and you change an injector temperature setpoint, the status screen displays NOT RDY until the new setpoint is reached.
**Setting Up Oven and Inlet Temperature Programs**

The Clarus GC software allows you to set up to four-ramp programs (they are 0 [isothermal], 1, 2, or 3).

1. From the System Status screen touch the oven icon to modify the program.

2. Once the oven program screen appears.

3. Touch each field to select and use the plus and minus buttons to enter a temperature, equilibration time and rate. When the word END appears in the rate field all the fields that follow are deactivated. You must touch END and then touch the plus (+) button to activate the next row. The following figure shows a typical temperature step program.
Before you actually set up an oven temperature program, you should decide on the Equilibration Time you need and change the default value (2 minutes) if necessary (see below).

**Configuring the Equilibration Time**

When you change the oven temperature setpoint, the system heats or cools the oven to the new setpoint, then equilibrates the column(s) for the specified Equilibration Time before the instrument becomes READY.

**NOTE:** A minimum Equilibration Time of 2 minutes is recommended for temperature programs. Longer equilibration times are recommended for initial oven temperatures of < 50°C. An equilibration time of 0.0 minutes can be used for isothermal methods.

**Setting a Coolant Timeout Value**

The purpose of the coolant timeout value is to conserve coolant. If you select a coolant timeout value when you configure the Clarus GC, the coolant solenoid shuts off if a GC run is not started within this time period after the oven becomes "READY" (reaches the initial set temperature). Once the coolant shuts off, the Clarus GC remains not ready and the following message will appear, Coolant Timed Out: Touch OK to Continue.

**NOTE:** The coolant timeout must be greater than the equilibration time.

**NOTE:** When using a POC or PSS injector with the subambient accessory, the injector temperature must not be set below the oven temperature. You can minimize coolant
Using the Active Method

consumption if using the oven subambient with the PSS or POC installed but not being used, by deconfiguring the PSS or POC.

Setting a Coolant Cut-In Temperature

The coolant cut-in temperature is the temperature below which the coolant starts to cool the oven. The default temperature is 60 °C. The allowable cut-in temperature range is 30 °C – 110 °C. We recommend that for every °C above a room temperature of 20 °C, you increase the cut-in temperature by 1 °C.

For example: A room temperature of 20 °C uses a default temperature of 60 °C, whereas a room temperature of 25 °C uses a 65 °C cut-in temperature. Examples for setting up isothermal, 1, and 2 ramp programs follow.

NOTE: Higher cut-in temperatures cause more coolant to be consumed, but can cool the oven to the initial temperature more rapidly.

Setting Up an Isothermal Program

Setting up an isothermal program requires entering the following information in the sequence shown:

- Initial oven temperature (Temp 1)
- The total run time for the initial temperature (Time 1)
- A temperature rate increase of 0 (Rate 1).

To set up an isothermal program:

1. From the oven tab set the initial temperature 1 to 75 ° using the plus minus keys.
2. Enter a setpoint appropriate for your analysis, for example, 100 °C.

**NOTE:** The oven status changes to Not Ready. The changing oven temperature is displayed on the top line as the oven heats up to the new setpoint. When the oven reaches the new setpoint, the system equilibrates for the time specified in configuration and then becomes Ready.

For an isothermal run, TIME 1 is equivalent to the total run time. At the end of the time (TIME 1), the system changes to Not Ready, it equilibrates, and then goes Ready.

**To change the hold time:**

- Go to the oven tab and enter a hold time appropriate for your analysis, for example, 25 min.

**NOTE:** Since a constant oven temperature is maintained for isothermal operation, the rate of temperature increase must be set to 0. If the Active Method you are editing is already isothermal, the RATE parameter will have been properly set at 0 and is indicated on the screen by the word "End".
NOTE: You can set the rate to 0 but whenever a RATE is set to “0,” any subsequent program steps, if present, are deleted from the Active Method.

**Setting Up a One-Ramp Temperature Program**

Setting up a one-ramp program requires entering the following information in the sequence shown:

- Initial oven temperature (Init 1)
- Isothermal time for the initial temperature (Init 1)
- Rate of temperature increase from the initial to the final oven temperature (Init Rate 1)
- Final oven temperature (Init 2)
- Isothermal time for the final temperature (Init 2)
- Temperature increase of 0 °C/min which signifies the end of the RATE 2 step.

The following example shows how to convert an isothermal program into a one-ramp program using the previous isothermal method oven temperature parameter as a starting point.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Temp</td>
<td>50 °C</td>
</tr>
<tr>
<td>Initial Time</td>
<td>5 min</td>
</tr>
<tr>
<td>Initial Rate</td>
<td>2 °C/min</td>
</tr>
<tr>
<td>TEMP 2</td>
<td>70 °C</td>
</tr>
<tr>
<td>TIME 2</td>
<td>10 min</td>
</tr>
<tr>
<td>RATE 2</td>
<td>End (0 °C/min)</td>
</tr>
</tbody>
</table>

**To set up a one-ramp program:**

1. From the oven tab, for the initial temp enter 50.
2. Enter 5 for initial time.
3. Enter a ramp initial rate 1 of 2 °C/min.
4. For Temp 2, enter a temperature of 70 °C.
5. Enter a time of 10 min.

**Setting Up a Multi-ramp Temperature Program**
The following example shows how to expand the above one-ramp program to a two-ramp program. The parameter values used in the example are shown below:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RATE 2</td>
<td>4 °C/min</td>
</tr>
<tr>
<td>TEMP 3</td>
<td>100 °C</td>
</tr>
<tr>
<td>TIME 3</td>
<td>5 min</td>
</tr>
<tr>
<td>RATE 3</td>
<td>0 °C/min</td>
</tr>
</tbody>
</table>

1. From the oven tab enter a rate of 4.
2. Enter a temperature of 100.
3. Enter a time of 5.

**NOTE:** You can enter RATE 3, TEMP 4, and TIME 4 to set up a third ramp.

**Holding an Oven Temperature**

While running a temperature program, you can hold the oven temperature by setting it to the temperature of the unexecuted steps.

To hold an oven temperature during a temperature program:

1. In the System Status screen touch the Oven icon.
2. After the oven icon has been touched the oven tab screen appears. Touch the **Go to** button to access the Go To Temp (temperature) screen.
3. From this window touch the button for the temperature level that you want to hold. Touch **OK**. Modify the temperature on the oven tab screen using the plus minus buttons. When completed return to the system status screen.

The oven heats ballistically to the temperature value for oven Temp 2 and holds, instead of executing the time associated with oven Temp 2.

![Diagram of Oven Temperature Program for Rate 1.](image)

**Figure 3-2. Oven Temperature Program for Rate 1.**

To hold the oven program at a specific time during or before a run, use an oven HOLD timed event. See the section on Timed Events.
Using the Active Method

Setting Injector Temperatures
Packed, Capillary (Split/Splitless), Programmed On-Column, and Programmed Split/Splitless

The examples in this section were derived by editing the Active Method with a capillary injector installed and configured in position A (front), and a packed injector installed and configured in position B (rear).

This section contains examples of how to:

- Display injector temperature screens
- Change injector temperatures
- Turn injector heaters off
- Turn injector heaters on
- Set oven programming mode
- Set inlet programming mode

Displaying Injector Temperature Screens

1. From the System Status screen touch the injector icon this will bring you to the injector tab page.
In this example touch injector A PSS icon.
Using the Active Method

**Turning Injector Heaters On or Off**

- To turn the heater off touch the check box.

As the injector cools off, the injector temperature is displayed on the above screen.

**Changing Injector Temperatures**

- Touch the Temp field and raise the value to 255 ºC.
**Oven Temperature Programming Mode**

In this mode the POC or PSS injector is configured as Oven. The injector temperature is set to the oven temperature plus 5 °C. This is the default mode and the easiest mode to operate in. For example, if the oven program is as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp 1</td>
<td>50 °C</td>
</tr>
<tr>
<td>Time 1</td>
<td>2 min</td>
</tr>
<tr>
<td>Rate 1</td>
<td>5 °C/min</td>
</tr>
<tr>
<td>Temp 2</td>
<td>240 °C</td>
</tr>
<tr>
<td>Time 2</td>
<td>10 min</td>
</tr>
</tbody>
</table>

The initial injector temperature will be 55 °C. When the GC run begins, the injector will hold this temperature for 2 minutes, then it will ramp up to 245 °C at 5 °C/min and hold for 10 min.

**NOTE:** Opening the oven door turns off the oven and the injector heater. Also, if you reset the oven temperature during the run to the next level, the injector temperature will follow.
**Inlet Temperature Programming Mode**

The inlet temperature programming mode is used when the POC or PSS injector is configured as Inlet. In this mode, the injector follows the injector temperature program that you entered in the method. The initial default values are: Initial Temp 1 is 50 °C, Injection Time is 999 min, and Inj Rate is 0. With nonprogrammed injectors, an entry of 0 turns the heated zone off. With programmed injectors, a temperature of 0 is possible. Therefore, when 0 is entered for the initial injector setpoint, the following screen appears:

1. From the selected injector tab screen make sure that the injector heater is off.
2. Set the initial temperature to 50 °C.

**Setting Up a One-Ramp Injector Program**

To set up a one-ramp injector program, enter the following parameters:

- Initial injector temperature (Initial Temp)
- Isothermal time for the initial temperature (Initial Time)
- Rate of temperature increase from the initial to the final injector temperature (Initial Rate)
- Final injector temperature (Temp 2)
- Isothermal time for the final temperature (Time 2)
- Temperature increase of 0 °C/min, which signifies the end of the Rate 2 step.

The following example shows how to build a one-ramp temperature program for your POC or PSS injector. The parameter values used in the example are shown below:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Temp</td>
<td>60 °C</td>
</tr>
<tr>
<td>Initial Time</td>
<td>0 min</td>
</tr>
<tr>
<td>Initial Rate</td>
<td>100 °C/min</td>
</tr>
<tr>
<td>Inj Temp 2</td>
<td>250 °C</td>
</tr>
<tr>
<td>Inj Time 2</td>
<td>15 min</td>
</tr>
<tr>
<td>Inj Rate 2</td>
<td>End (0°C/min)</td>
</tr>
</tbody>
</table>
To set up a one-ramp injector program:

1. From injector tab screen touch the **temp program** icon.

2. The temp program screen appears for the selected injector. Use the plus minus buttons to program the temperature, time and rate. Refer to the table on the previous page for some examples for values to set up a one ramp injector program.
3. When you have completed setting up the program touch the **system** icon on the navigation bar to return to the System Status screen.

**NOTE:** You can enter Rate 2, Temp 3, and Time 3 to set up a second ramp. An entry of 999 for Rate 1 or 2 will cause the injector to ballistically heat up.

**NOTE:** If the Injector Time is set with the default value of 999, the injector temperature will hold at the current temperature until the end of the oven program. Otherwise, the injector temperature will hold for the time you have entered, or until the run ends.

**NOTE:** If you have the subambient option, the POC and PSS injectors are linked to the oven subambient option; therefore, you cannot operate the injectors below the oven subambient temperature.
Viewing/Setting Carrier Gas Pressure/Flow/Velocity

NOTE: For a description of programmable pressure control (PPC), refer the Hardware Guide, “PPC Fundamentals.”

If your Clarus GC is equipped with PPC, you can select and set the carrier gas Pressure, Flow, or Velocity. In all three modes, you can operate at a constant pressure, flow, or velocity or at a programmed pressure, flow, or velocity. You can also make a pressure pulse, flow pulse, or velocity pulse injection. In this case the initial pressure, flow, or velocity is quite high at the time of injection. This minimizes the expansion in the injector liner as the liquid sample is vaporized and increases the transfer time onto the column. This is recommended for splitless operation of wide boiling point samples. In this case, you would actually program the pressure, flow, or velocity down to the normal column pressure, flow, or velocity for the remainder of the chromatographic run.

The following terms are used in PPC analysis:

**Zero**—removes the flow controller from the GC method and sets the flow to 0.

**Flow**—enables the flow controller in the GC method and sets its initial flow to 30% of the nominal maximum flow rate (according to the installed flow-range element and carrier gas type). The operator has the option to enter a different flow rate and enter a flow program. When in the flow mode, the PPC system also monitors the column inlet pressure. If the inlet pressure falls outside a selectable range, a leak-check fault occurs.

**Pressure**—controls the column inlet pressure and reads the flow rate from the flow sensor in the flow controller. The initial pressure in the method defaults to 5 psig. The operator has the option to enter a different initial pressure and optionally enter a pressure program.

**Carrier Gas Mass-Flow Controller Operation**

Once the carrier gas operation mode has been selected (see the next section “Setting Carrier Gas Pressure in the PPC Version” for information on this), the operator may modify the default setpoints in the active GC method, edit the carrier-gas setpoints in stored methods, or generate a new method and enter carrier-gas setpoints. The following parameters control the carrier gas.
Using the Active Method

Initial Carrier-Gas Setpoint

The carrier gas mass-flow controller receives set points of flow or pressure depending on the configured carrier gas mode. The program calculates the initial set point from the active GC method. The initial set point is established upon setting up a method, ending a run, or resetting the Clarus GC. The flow rate is held constant at the initial value if no additional carrier-flow entries are made in the GC method. The controller receives pressure set points when operating in the pressure control mode.

Carrier-Gas Program

The GC method accommodates up to three additional carrier-gas program steps each consisting of a hold time, ramp rate, and plateau set point. Sequential set points may be greater than or less than the preceding set point. The PPC system programs the carrier-gas controller with a positive or negative ramp as required.

At the end of the GC oven program, the carrier gas resets to the initial set point value in the method even if a carrier-gas program is in progress. The carrier gas also resets if the end of the carrier-gas program occurs before the end of the oven program.

Carrier-Gas Timed Events

You can also use timed events to produce step changes in the set point. Carrier-gas events can occur before or after a run starts. A carrier-gas event supersedes the method set point value at the time the event occurs. However, if the carrier-gas program in the method advances to a new step after a carrier-gas event, the new program step or ramp takes control.

Leak Checking

The Clarus GC monitors the inlet pressure with a carrier gas mass-flow controller in use. After selecting the carrier-gas Flow mode in configuration, you can enter the maximum inlet pressure value. If the inlet pressure drops below or rises above the set limit for more than one minute, a warning message appears.
Setting Carrier Gas Pressure in the PPC Version

To view or set the carrier pressure:

1. From the System Status screen touch the Injector icon for which you want to set the carrier pressure.

The screen for the selected injector appears.

In this example, the Clarus GC is configured with the capillary mode on for pressure. If the option for capillary control has been selected during configuration, the user can program the carrier gas according to one of three values: pressure, velocity, or flow. The carrier gas field on the injector tab screen displays the set point value. The label below the field displays the current step. The actual values for all of the available configuration options is displayed to the left as read only text on the screen.

2. Touch the program button for Carrier Gas.

The Carrier Pressure Program window appears:
3. Touch the field, ranging from the Initial field to the step 4 field, and use the plus minus buttons to enter a pressure, equilibration time and rate.

**NOTE:** The rate for the range is 0 (end) to 99. A rate of 999 is a ballistic setting (maximum).

**CAUTION**  
*The ballistic mode of programming is not recommended. Setting a program rate will be more reproducible.*

4. Touch **Close** to return to the injector screen.
**Viewing or Adjusting Carrier Gas Pressure Using Manual Pneumatics**

To view and/or adjust carrier gas pressure:

1. From the System Status screen touch the Injector icon. The tab page for the selected injector appears.

   ![System Status Screen](Image)

   In the screen above the set point value for Carrier Gas field is editable. The text next to the set point entry field shows the current value.

2. Touch the field for Carrier Gas and use the plus and minus buttons to modify the value.

3. Adjust the pressure to the setpoint with the pressure control knob.
Using the Active Method

![Pressure control knob](image)

Figure 3-4. Pressure control knob.

**NOTE:** Entering a setpoint of "0" disables the ready not/ready mode.
**Setting Carrier Gas Flow in the PPC Version**

To view or set the carrier flow:

1. From the System Status screen touch the Injector icon for which you wish to set the carrier gas flow.

   The tab page for the selected injector appears.

   ![Injector Tab Screen Example](image)

   In this example, the Clarus GC is configured with the capillary mode on for flow. If the option for capillary control has been selected during configuration, the user can program the carrier gas according to one of three values: pressure, velocity, or flow. The carrier gas field on the injector tab screen displays the set point value. The label below the field displays the current step. The actual values for all of the available configuration options is displayed to the left as read only text on the screen.

2. Touch the program button for **Carrier Gas**.

   The Carrier Flow Program window appears:
Using the Active Method

3. Touch each individual field, ranging from the Initial field to the step 4 field, and use the plus minus buttons to enter a flow, equilibration time and rate.

Note: The rate for the range is 0 (end) to 99. A rate of 999 is a ballistic setting.

CAUTION

The ballistic mode of programming is not recommended. Setting a program rate will be more reproducible.

4. Touch Close.

To view the display:

1. From the System Status screen touch the Injector icon.

   The tab page for the selected injector appears.

   ![Carrier Gas Flow Display](image)

   In the screen above the set point value for Carrier Gas is an editable field. The text next to the set point entry field shows the current value.

2. Touch the field for Carrier Gas and use the plus and minus buttons to enter in a new set point value, for example, 25.

3. Adjust the flow to the setpoint with the flow control knob.
Using the Active Method

Figure 3-5. Flow control knob.

NOTE: Entering a setpoint of “0” disables the ready not/ready mode.

**Viewing/Setting Carrier Gas Velocity in the PPC Version**

Viewing/setting carrier gas velocity depends on your version of the Clarus GC. You can set the carrier gas velocity only if you have the PPC version.

To view or set the carrier gas velocity:

1. From the System Status screen touch Injector icon for which you wish to set the carrier gas velocity.

   The tab page for the selected injector appears.
In this example, the Clarus GC is configured with the capillary mode on for velocity. If the option for capillary control has been selected during configuration, the user can program the carrier gas according to one of three values: pressure, velocity, or flow. The carrier gas field on the injector tab screen displays the set point value. The label below the field displays the current step. The actual values for all of the available configuration options is displayed to the left as read only text on the screen.

2. Touch the program button for **Carrier Gas**.

The Carrier Velocity Program window appears:
3. Touch each individual field, ranging from the Initial field to the step 4 field, and use the plus minus buttons to enter a velocity, equilibration time and rate.

**NOTE:** *The rate for the range is 0 (end) to 99. A rate of 999 is a ballistic setting.*

```
CAUTION

The ballistic mode of programming is not recommended. Setting a program rate will be more reproducible.
```

4. Touch **Close**.
Setting the Septum Purge Mode and Offset

To set the septum purge and offset:

1. Touch **Tools** button and select Configuration from the drop down menu.

   The Configuration screen appears:

   ![Configuration Screen](image)

2. Touch the button for the injector you want to modify.

   The Configure Injector screen appears:

   ![Configure Injector Screen](image)
3. Touch the Capillary tab.

4. From the Capillary Control drop down menu select Pressure.

Now you can only pressure program your capillary injector. If you wish to program the Capillary control for more than just pressure skip to step 9.

5. Touch the Injector tab.
6. From the **Split Flow Offset Mode** press either the **Auto** or **Fixed** radio button.
Using the Active Method

The **Auto** mode is the preferred mode of operation. If you want to shorten the overall run time at the expense of some area precision, then use the **Fixed** mode. We recommend that if you are operating with a split vent flow of 50 mL/min or less, select the **Auto** mode.

Before each injection in the **Auto** mode, the system briefly closes the split vent and measures the total flow. With the split vent off this flow is the column flow plus the septum purge flow. The septum purge flow is maintained due to a mechanical restrictor and the split vent flow and split ratio are maintained for each injection.

In the **Fixed** mode, you enter an offset value which is equal to the septum purge flow plus the column flow at the time of injection. Since the system controls the total flow (equal to the split vent plus septum purge plus column flow), the septum purge is fixed, and the column flow is controlled, the difference between these two flows and the offset entered will go out the vent flow. This will be consistent for each run.

7. If **Fixed** is selected use the plus and minus buttons to enter an offset value in mL/min.

8. Press **OK**.

Skip steps 9-16 if you are only programming the capillary control for pressure.

9. If you wish to program the Capillary Control for more than just pressure check the **Capillary Control** check box from the **Injector** tab.
The **Capillary** tab now displays the following options:
Using the Active Method

10. From the Carrier Control drop-down menu select from the following options: Off, Pressure, Flow, Velocity, Oven Track.

After selecting either Pressure, Flow, or Velocity, you must enter your column dimensions as described in the following steps. However, if you select the Oven Track mode from the Carrier Control drop-down menu you do not need to enter column dimensions, and you can skip to step 12.

11. Use the plus and minus buttons to enter a Column Length, which is measured in meters.

12. Use the plus and minus buttons to enter an Internal Diameter which is measured in micrometers (not millimeters). Then view the calculated linear gas velocity from selecting Utilities from the Tools menu and selecting the Column Flow Calc.

NOTE: If you incorrectly enter a column length or internal diameter, the resulting flow and pressure may be incorrect. For example, a 0.25 mm column may actually be 0.22 mm. To verify that you have entered the correct values, you can measure the linear gas velocity by injecting methane and calculating the linear gas velocity

\[
\text{Linear Gas Velocity} = \frac{\text{column length (cm)}}{\text{Retention Time of Methane (sec)}}
\]

13. From the Split Mode drop-down menu select either Flow or Ratio.

If you select Flow, you will enter a split flow in your method. The software controls and calculates the split ratio.

If you select Ratio, you enter the split ratio in your method. The software controls the ratio and calculates the split flow.

14. Touch the Injector tab.
15. From the Split Flow Offset Mode press either the Auto or the Fixed radio button.

In the **Auto Ready** mode, the system performs a PreRun for one minute before it becomes READY, the split vent is closed, and the system measures the septum purge flow plus the column flow. This is referred to as the “offset.” The septum purge flow is controlled but not user selectable; it is factory set to 3 mL/min. The split vent flow is restored to the value set in the method and the system stabilizes for 30 seconds. This entire procedure takes one minute.

In the **Fixed** mode, enter the “offset” value. This value should be equal to the septum purge flow plus the column flow. If the wrong value is entered, then the difference is added to or subtracted from the split vent flow, so your actual split vent flow may be slightly higher or lower than the value entered in the method.

In both cases the split ratio is maintained for every injection. If you want to save time from run to run, select **Fixed** mode. The **Auto** mode is recommended to improve area precision and is required for vent flows less than 50 mL/min.
Using the Active Method

16. If **Auto** is selected, the **Leak Check** screen appears. Enter a value slightly higher than your operating flow. If the system detects flows higher than this value, it considers it a leak.

OR

If **Fixed** is selected use the plus and minus buttons to enter an offset value in mL/min.

17. Press **OK**.

**NOTE:** *The Clarus PPC split pneumatics adds the septum purge offset to the split vent setpoint to obtain the total split system flow rate. See Chapter 7 for more details.*
Setting Up Valves

The Clarus GC operates six internal solenoid valves. You can initially configure valves from the Configuration screen by selecting the Relays button. To change valve settings for your current method use the Timed Events screen and touch the Relays button.

Setting the Split Mode Using PPC

To set the split mode:

1. Press Tools menu button and select Configuration.

   The Configuration screen appears.

2. Touch the Injector icon for which you which to configure the split mode.

   The Configure Injector screen appears.

3. Touch the Capillary Control check box.

   The following screen appears:
4. From the **Split mode** drop-down menu select either **Flow** or **Ratio**.

5. Touch **OK**.

   The Configuration screen appears.

6. Touch **Close**.

7. On the **System Status** screen, touch the Injector icon.

   The active method screen appear.
The screen above displays the Split mode configured for **Ratio**.

8. Touch the r **ratio** field to modify the value.
OR
If you configured the split mode for **Flow**, the following screen appears:
Using the Active Method

The **Total Flow** (split vent + septum purge + column) is displayed as a non-editable text field. The septum purge flow is factory preset to ~3.0 mL/min. It is not user adjustable. If you set the split flow to zero, the flow display shows column flow plus septum purge. Common places for leaks would be the septum cap, the O-ring seal, column connector, etc. See the Clarus Hardware Guide, Chapter 8 for further information.

**NOTE:** It should be noted that if the displayed value is much greater than the total flow (split flow and septum purge + column flow), this indicates a leak in the pneumatics.

**Setting the Split Mode Using Manual Pneumatics**

**Set the Solenoid Valve for Split Operation**

1. From the System Status screen touch the **Injector** icon for which you which to set the solenoid valve for split operation.

   The active method appears:
2. Touch the **Events** tab.

3. Touch the **Relays** button.
   The Relays screen appears:
Using the Active Method

4. Open the split valve by touching the Initial check box for the Split field. This leaves the split vent open.

NOTE: If you are using the Clarus GC for the first time, valves 1 and 2 will be OFF. Valves that are off are shown as unchecked.

NOTE: Modifications to the valve settings become part of the Active Method and are automatically saved.

Measure and Adjust the Split Vent Flow

To measure and adjust the split vent flow:

1. Open the detector cover.

Figure 3-6 Detector cover.

2. Locate the split vent.
3. Attach a flowmeter to the split vent.

4. Turn the outer knob of the split-flow knob fully counterclockwise (see below).

5. Measure the flow.

6. Remove the cap from the split flow knob, thereby exposing the split-flow needle valve.

---

**Figure 3-7**  Split vent.

---

**Figure 3-8**  Split-flow knob and needle valve.
Using the Active Method

7. Repeatedly measure the flow, adjusting the needle valve with a small screwdriver to achieve the desired flow.

NOTE: A suggested starting point is 100 mL/min.

8. Remove the flowmeter.

9. Replace the cap on the split-flow knob.

10. Set up the detector to be used with this column.

NOTE: If the inlet pressure is changed, the split flow will also change.

NOTE: Recheck the inlet pressure with the vent open when using high vent flows. The inlet pressure may have dropped slightly.
Set up the Splitless Mode for a CAP or PSS Injector

The Splitless Mode is used for trace analyses. Most of the sample is transferred onto the column, then the split vent is opened, thereby venting any sample remaining in the injector liner. This step describes how to set the split mode for PPC and manual pneumatics modules. Refer to the procedure that describes your Clarus GC controls, PPC or manual pneumatics.

Step I1: Setting the Splitless Mode Using PPC Modules.


NOTE: In the Splitless Mode, the split vent must be opened after the sample has transferred to the head of the column (i.e., 0.5 - 2.0 minutes after the run has started). The procedure which follows assumes that the carrier gas pressure has been set (see Step C in this chapter).

NOTE: The injector is shipped with a wide-bore injector liner. You may want to install a narrow-bore liner. Both liners must be packed with quartz wool before running your analysis. Refer to Step B, Connect the Column to the Injector in this chapter, for procedural details.

Setting the Splitless Mode Using PPC Modules

Splitless Injection with Pressure Pulse (Flow Pulse, Velocity Pulse) Technique

Pressure (flow or velocity) pulse injection is recommended for splitless operation, especially when analyzing wide boiling-point mixtures and/or large volume injections. This technique increases the pressure (flow, velocity) in the system at the time of injection to minimize the gas expansion in the injector liner and maximize the gas sample transfer onto the column. Therefore, you should use the highest pressure that your application will allow. This provides better peak shapes, better recovery, and no discrimination for both low boiling and high boiling compounds. This technique can be incorporated in your Clarus GC method. The initial pressure (flow, velocity) is high (for example, 70 psig) and held at this high pressure for enough time (for example, 0.25 to 2.0 min) to transfer your sample onto the column. This time needs to be experimentally determined for your sample, injector temperature, and injector liner used. You want a time that will allow most of your sample to transfer onto the
Using the Active Method

column as well as maintain good solvent and analyte peak shape. If the time is too short, you will lose sample; if the time is too long, the solvent will tail and possibly obscure or affect peak shape of early analytes. The split vent is off at injection (Split Flow = zero). The pressure (flow, velocity) is then programmed at a controlled rate, down to the normal column operating pressure (flow, velocity). At the same time, the split vent is set back to normal flow to clean out any remaining sample in the liner and to release the pressure in the injector. It is important not to program the pressure (flow, velocity) down too quickly or ballistically, since this can cause backflush of the column. This means that the sample can flow back into the injector and either be lost out the split vent or cause peak broadening.

Creating a Pressure, Flow, or Velocity Pulse Method

1. From the System Status screen touch the Injector icon for which you wish to create a pressure, flow, or velocity pulse method.

   The status screen, similar to the one below, for the selected injector appears.

   ![Status Screen]

   2. Touch the Events tab.

   3. Touch Add.
The Add Timed Event screen appears:

4. Touch the **Time** dialog box and use the plus and minus buttons to enter a time of .25 minutes.

5. Touch the **Value** dialog box and enter a flow value.

**NOTE:** *Values of 20 mL/min and higher provide greater accuracy than values below 20 mL/min.*

6. Touch **OK**.

You have now created a timed event set to turn on the split flow at 0.25 min.

7. Touch the Injector tab.

The Injector status screen appears.
8. Touch the **Program** button for the **Carrier Gas** field.

The Carrier Gas Pressure Program screen appears:
9. Touch the **Initial pressure** dialog box and use the plus and minus buttons to enter a pressure value (for example 70).

10. Touch the **Initial time** dialog box and use the plus and minus buttons to enter an initial time.

11. Touch the **Initial rate** dialog box and use the plus and minus buttons to enter an initial rate value that decreases the pressure down to the operating pressure in psi/min.

12. Touch the step 2 dialog box for **pressure** and use the plus and minus buttons to enter the column operating pressure.

**NOTE:** *If you selected flow or velocity, you should still follow the above procedure. Just enter the appropriate flow or velocity values for your analysis.*

**NOTE:** *If you are in the capillary mode, and you set up the pressure mode first, you can enter 70 psi and/or 10 psi, then read the appropriate flow or velocity values respectively. This helps determine the values to use.*

This technique is also recommended for the TurboMass Gold detector. With mass spectrometers, you must be careful not to overload the vacuum chamber. In order to avoid this, the setup procedure is slightly different than the above procedure. You would not want the initial pressure when using the TurboMass Gold to be too high, because at the end of the GC run all parameters are set back to their initial values, and the higher pressure could cause damage to the vacuum system.

For TurboMass Gold the initial value is set to the normal operating pressure (flow or velocity) and a negative timed event with a high pressure (flow or velocity) will be added to the method. This causes the pressure (flow or velocity) to increase prior to Ready (for example, prior to the injection). At injection, the GC method holds this pressure (flow or velocity) for the time necessary to transfer the sample onto the column. The experimentally determined pressure (flow or velocity) is then programmed at a controlled rate down to the initial (or normal) column operating pressure (flow or velocity).

If you are using the autosampler, at the end of the last sample in the sequence, the TurboMass Gold will go “Not Ready,” thereby sending a signal to the Clarus GC keeping it from coming Ready. (The External Ready must be connected.)
Using the Active Method

See the Clarus 500/580 GC Installation Guide, 09936590.) This keeps the GC from executing the negative timed event and holds the pressure at the lower setting.

**Setting the Split Flow for Splitless Injection**
To make a splitless injection, initially turn Off the appropriate split flow that is associated with your injector with a timed event. Then with another timed event, turn it On from 0.25 to 2 minutes into the GC run and leave it on. When the GC run is complete, the Clarus GC returns the split flow to its initial setting.

To set up for splitless operation:

- From the Injector status screen touch the dialog box for Split flow and use the plus and minus buttons to enter a split flow in mL/min.

![Setting the Timed Events](image)

**Setting the Timed Events**

1. Touch the Events tab.
2. Touch Add.

The Add Timed Event screen appears.

3. From the Event drop down menu select Split A (if the injector is installed in position A) or Split B (if the injector is installed in position B).

4. Touch the Time dialog box and use the plus and minus buttons to enter a negative Time (for example, −1.00 min) for the event to occur prior to the Clarus GC coming ready. Then press [Enter]. The cursor moves to Event.

5. Touch the Value dialog box and use the plus and minus buttons to enter a value of 0.
6. Touch **OK**.

   The split flow will now turn off before the Clarus GC becomes ready so that at the time of injection the split flow is off.

7. Touch **Add**.

   The Add Timed Events screen appears.

8. From the **Event** drop down menu select **Split A** (if you have the injector configured for position A) or **Split B** (if you have the injector configured for position B).

9. Touch the **Time** dialog box and use the plus and minus buttons to enter a positive time for the event (for example, 2.00).

**NOTE:** *The "Time" refers to the time (in minutes) into the GC run that you want to automatically turn the valve on. The time depends on your sample, solvent, column, etc. Typical time values are between 0.25 and 2.0 minutes. An optimum "Time" is the time that provides maximum area counts (indicated by your data handling device) with minimum solvent effect (tailing).*
10. Touch the **Value** dialog box and use the plus and minus buttons to enter a value of 50 mL/min.

At the end of a run, the split flow resets to the original setting. Setting a Value of 50 mL/min minimizes contamination by keeping the splitter on during cool-down.

**NOTE:** *If you wish to conserve carrier gas, set the initial flow to 0.*

**CAUTION**

*If you are using pressure pulse injection, you must set the split flow on just prior to when the inlet pressure begins to drop to the operating setpoint. For example, if the inlet pressure is programmed to start decreasing one minute after injection, use a split flow event time of 0.98 minutes.*

**Setting the Splitless Mode Using Manual Pneumatics**

To make a splitless injection, initially turn Off the split flow for your injector with a negative timed event. Then from 0.5 to 2 minutes into the GC run, turn the flow On with a positive timed event. When the GC run is complete, the Clarus GC returns the solenoid valve to its initial setting.
Using the Active Method

**Set up a Timed Event to Close the Valve Prior to Injection**

A timed event is required to close the valve before the run starts.

1. From the System Status screen touch the **Injector** icon for which you wish to set up a timed event to close the valve prior to injection.

The status screen for the selected injector appears.

![Status Screen](image)

Touch the **Events** tab.
2. Touch **Add**.

   The Add Timed Event screen appears.

3. From the **Event** drop down menu select **Split A** (if the injector is installed in position A) or **Split B** (if the injector is installed in position B).

4. Touch the **Time** dialog box and use the plus and minus buttons to enter a negative **Time** (for example, −1.00 min) for the event to occur prior to the Clarus GC coming ready.

5. Touch the **Value** dialog box and use the plus and minus buttons to set the value to **Off**.
Using the Active Method

6. Touch OK.

The split flow will now turn off before the Clarus GC becomes ready so that at the time of injection the split flow is off.

**Set up a Timed Event to Open the Valve After Injection**

1. From the Timed Events screen touch **Add**

   The Add Timed Events screen appears.

2. From the **Event** drop down menu select **Split A** (if you have the injector configured for position A) or **Split B** (if you have the injector configured for position B).

3. Touch the **Time** dialog box and use the plus and minus buttons to enter a positive time for the event (for example, 2.00).

**NOTE:** The "Time" refers to the time (in minutes) into the GC run that you want to automatically turn the valve on. The time depends on your sample, solvent, column, etc. Typical time values are between 0.25 and 2.0 minutes. An optimum "Time" is the time that provides maximum area counts (indicated by your data handling device) with minimum solvent effect (tailing).
4. Touch the **Value** dialog box and use the plus and minus buttons to set the value to **On**.

At the end of a run, the split flow resets to the original setting. Setting a Value of 50 mL/min minimizes contamination by keeping the splitter on during cooldown.

**NOTE:** The timed event that you set up, or valve settings that you make, become part of the method. The timed event is automatically saved if you are editing the Active Method.

**NOTE:** When operating in the splitless mode, the recommended measured flow out of the vent is 30 - 50 mL/min. when the split vent is ON.
Controlling the Autosampler

NOTE: The autosampler will not respond to commands if the autosampler door is opened. Only sample vials and syringes distributed by PerkinElmer should be used with the Clarus GC. Plungers are not interchangeable from syringe to syringe.

The autosampler contains three basic parts: a syringe tower, a carousel, and a sample tray (see the following two figures). The syringe tower can contain either a 0.5-, 5.0-, or 50.0-µL syringe.

Figure 3-9. View of the Clarus GC with autosampler syringe tower.

Autosampler Trays and Carousel

The Clarus 500 GC can use only the 82-vial standard tray or the 82-vial tall tray. The Clarus 580 GC is designed to use the large capacity 108-vial tray for standard vials or the 108-vial tray for tall vials. There is also an 82-vial Thermostatting Tray Kit available for use with the Clarus 500 GC and Clarus 580 GC.

The Standard vials are recommended and supplied by PerkinElmer. The Tall vials refer to those vials not purchased from PerkinElmer which are slightly taller than the Standard vials.
Figure 3-10. Sample Tray and Carousel.

82-Vial Standard Tray 108-Vial Standard Tray 108-Vial Tall Tray and Carousel (for non-PerkinElmer vials)
Using the Active Method

<table>
<thead>
<tr>
<th>Clarus GC Model</th>
<th>Tray Capacity of 2 mL Sample Vials</th>
<th>Vial Height</th>
<th>Number of 4 mL Wash Vials</th>
<th>Number of 4 mL Waste Vials</th>
<th>Number of 2 mL Priority Vials</th>
</tr>
</thead>
<tbody>
<tr>
<td>580 only</td>
<td>108</td>
<td>Standard</td>
<td>4</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>580 only</td>
<td>108</td>
<td>Tall</td>
<td>4</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>500 only</td>
<td>82</td>
<td>Standard</td>
<td>4</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>500 only</td>
<td>82</td>
<td>Tall</td>
<td>4</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>With the Tray Thermostatting Accessory Kit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500/580</td>
<td>82</td>
<td>Standard</td>
<td>4</td>
<td>4</td>
<td>1</td>
</tr>
</tbody>
</table>

**Autosampler Touch Screen**

1. You can access the Autosampler by selecting the Run icon from the System Status Screen. See screens below.
2. In the next screen touch the **Autosampler** button next to the **Run Type** heading.

![Autosampler Screen Image](image)

3. If the Autosampler is enabled, touching the Run button displays the following screen.

![Autosampler Screen Image](image)

The Autosampler screen includes three tabs. The first two tabs display identical screens for setting Program 1 and 2, allowing you to sequence two methods. The Tasks tab displays buttons to perform tasks such as Park, Clean, and specify a priority injection. All of the screens provide status information.
Using the Active Method

The method field allows the user to run the GC under the control of a method other than the current active method.

**Start Button**

Touch the Start button to start a run. The Start button is active whether or not the system is ready. Issuing the start command before the system is ready gives users the flexibility to set up and run a method without having to wait for the system to attain ready status. As soon as you touch **OK**, the Start button changes to **Stop** whether or not the system is ready. This enables you to cancel the run before it starts.

- If the system is under external control (e.g. from TotalChrom) and a method has not yet been set up, the Start Button is inactive.
- In all other instances, even though the GC is not Ready, the Start Button will start a run.
- When the GC oven starts to program, the Start Out signal will be asserted for 1 second.
- The Ready Out signal will be asserted only when the GC is fully equilibrated and the GC has reached full Ready status.

**Stop Button**

As soon as the **Start** button is touched, the **Stop** button appears on all top level screens.

Touching the Stop button before the system is running prompts the following dialog box:

Touch **OK** to cancel the run.
The status bar reflects that the system is running and the Start button changes to Stop.

Touching the Stop button displays the following start menu dialog box:

Stop Immediately – The Autosampler stops and the stop buttons turns to Start.
Using the Active Method

Stop at the end of this run – The user can allow the current run to complete and then stop the Autosampler sequence.

Pause after this run - The system may be paused to stop any further injections until resumed by the user. When the system is paused, the Stop button turns to Resume on all top level screens.

Go to a temp, program step – Displays radio buttons that allow the user to ballistically raise the oven temperature to the value specified for a particular step. The last step in the current program is selected by default. The buttons for steps beyond the current program are deactivated. To change the temperature touch the radio button and press OK. Touching cancel retains the current setting and closes the dialog box.
### Autosampler Buttons

Run options include selecting the run type, method, autosampler parameters, and run start/stop/program controls. The various controls, contents and enabling are configuration and mode dependent.

**Multi-Program Mode** – In this mode, the autosampler runs two programs consecutively. Each program specifies: the method to be used (each program can use a different method if desired), which injector to use, the size of the injection, the number of injections per vial, and the starting and ending vial numbers. As each program is run, the system sets up the specified method as the Active Method. While running in this mode, the autosampler attempts at least one injection from each vial in the specified ranges.

**NOTE:** *The autosampler tray is keyed to fit correctly only in one direction. When installed properly, the tray is recessed slightly around the entire Clarus GC top. If installed 180° out of position, the tray will be angled (not lying flat) across the top of the instrument and will not allow the tower to pass over it.*

---

<table>
<thead>
<tr>
<th>Element</th>
<th>Enabling by mode</th>
<th>Enabling by state</th>
</tr>
</thead>
<tbody>
<tr>
<td>A./S Program tabs</td>
<td>Multi mode</td>
<td>Always</td>
</tr>
<tr>
<td>Method</td>
<td>Always</td>
<td>Not running (auto or GC)</td>
</tr>
<tr>
<td>Start vial</td>
<td>Multi</td>
<td>Not running auto</td>
</tr>
<tr>
<td>Stop vial</td>
<td>Multi</td>
<td>Always</td>
</tr>
<tr>
<td>Injection Size</td>
<td>Multi</td>
<td>Not running auto</td>
</tr>
<tr>
<td>Injector</td>
<td>Multi</td>
<td>Not running auto</td>
</tr>
<tr>
<td>Repeats</td>
<td>Multi</td>
<td>Not running auto</td>
</tr>
<tr>
<td>Priority button</td>
<td>Multi</td>
<td>Running auto</td>
</tr>
<tr>
<td>User instructions</td>
<td>Manual only</td>
<td>Always</td>
</tr>
<tr>
<td>Countdown timer</td>
<td>Manual only</td>
<td>Enabled by default</td>
</tr>
</tbody>
</table>
Using the Active Method

Program 1 and Program 2 Tabs

1. These two tabs allow for multi-program mode.

2. Select the method from the drop down menu.

3. Highlight the **Vials**, **Vol** and **Injections/Vail** fields and use the plus minus buttons to input the correct amount.

4. Select either Injector A or B.

5. Touch Start when you are ready to begin the autosampler run.
Autosampler Tasks Tab

The Autosampler Tasks tab includes buttons to execute tasks such as Park and Clean.

Touch the Park button to park the autosampler tower.

**NOTE:** *If the syringe is directly over the injector, you should move it by selecting Park.*

Touch the Clean button to clean the syringe plunger with the solvent wash.

**NOTE:** *The Clean option is only available when the autosampler has stopped.*

**Cleaning the 5-µL and 50-µL Syringe Plungers**

The 5-µL and 50-µL syringe plungers should be cleaned regularly, since insolubles can build up and cause friction.

To clean the syringe plunger:

1. Remove the syringe using the procedure in the preceding section.
2. Remove the plunger from the syringe barrel.
Using the Active Method

3. Wipe the plunger with a tissue soaked in an appropriate solvent. Replace the plunger.
4. Pull and expel the same solvent through the barrel several times.
5. Replace the syringe using the procedure in the preceding section.

**NOTE:** *Only syringes distributed by PerkinElmer should be used with the Clarus GC. Plungers are not interchangeable from syringe to syringe.*

**Configuration Button**
From the Tasks tab touch the **Config** button.

The **Config** button provides a quick link to the configuration settings.

**Running Viscous Samples**
The Clarus GC allows you to vary the length of time the plunger pauses at the top-of-stroke when acquiring samples. In addition, the plunger speed also slows down during injection. The more viscous the sample, the higher you should set this value. To optimize reproducibility you should experiment with different values.

The plunger speed during sample acquisition and injection will vary with the viscosity of the sample. To find the optimum setting for the sample being analyzed, you should experiment with various syringe settings.
Highlighting the **Viscosity Control** Field use the plus minus buttons to enter a value between 1 and 15. This value is the number of seconds the plunger pauses at the top-of-stroke during sample acquisition.

**NOTE:** *You can obtain improved precision with viscous samples by using the 0.5-mL syringe and septa in the waste/wash vials in place of the diffusion caps.*

**Using Solvent Pre-Washes**

Pre-washes refers to the number of solvent washes you want the system to perform prior to the pre-injection sample washes. Highlight the **Solvent Pre-Wash** field and type in a value. Acceptable values are 0, 1 or 2. Pre-washes occur only at the beginning of an autosampler program.

**Auto Resume**

Check off the Auto Resume which allows for the autosampler program to automatically resume where it left off should a power failure occur.

**NOTE:** *Auto Resume should not be used if you have an FID or FPD configured with PPC, since the flame will have been extinguished during a power failure.*

**Priority Button**

Press the **Priority** button to inject a priority sample during a run.

1. Touch the Priority Button in the Tasks tab.
2. In the Number of priority injection field use the plus minus buttons to input the number of priority injections. Touch Start.

This option instructs the autosampler to interrupt the vial injection sequence and inject a "Priority" vial that has been placed in the "Priority" position of the turntable. The priority vial will be injected after completion of the current run.

After the priority vial has been injected (in accordance with the current program parameters), and the priority run completed, the program continues with the next injection in sequence.

**NOTE:** *Priority can only be selected when with the above screen is visible.*
Using the Active Method

**About Waste and Wash Vials**

The Autosampler software has been optimized to use waste vials and solvent wash vials to minimize contamination of the syringe needle.

Septa are available for the waste vials and solvent wash vials by ordering P/N N9302780. We recommend using these septa in place of the diffuser caps when you are using:

- Very viscous samples (to wipe the sample off the outside of the syringe needle).
- Toxic solvents and samples.
- Very volatile solvents.

**Multi-Program Mode**

**Waste Vials**

When operating in the Multi-Program Mode, the sample pre-washes are emptied into waste vial #1 for program 1 and waste vial #3 for program 2. The solvent post-washes are emptied into waste vial #2 for program 1 and #4 for program 2.

**Wash vials**

Program 1 splits between solvent wash vials #1 and #2. For example, if four washes are required, two will be taken from vial #1, and two will be taken from vial #2.

Program 2 splits between solvent wash vials #3 and #4. For example, if five washes are required, three will be taken from vial #3, and two will be taken from vial #4.

**About sample vials**

Use 2-mL vials with the autosampler (P/N N9301385, 144 per box). These are crimp-top vials. The vials and crimp caps with septa (P/N 00092205, 1000 per box) are available through PerkinElmer’s Consumables and Supplies catalog (in the U.S., call: 1-800-762-4000) or online at [www.perkinelmer.com](http://www.perkinelmer.com).

The minimum volume of sample required in the 2-mL vial is 0.35 mL or 350 µL. You should fill the vial when running multiple injections per vial.

A mini-vial insert is available for laboratories with small sample volume requirements. This insert fits into the standard 2-mL vial and requires a minimum volume of 5 µL of
sample. These inserts are available through the Consumables and Supplies catalog or visit us on-line at www.perkinelmer.com.

**NOTE:** When using mini-vials, it is not recommended to use pumps to acquire samples. This assures that the sample will not be diluted by residual solvent in the syringe. Only PerkinElmer vials should be used with the Clarus GC.

Adjust the crimper so that it does not deform the vial cap and septum, but crimps the vial cap tight enough so that you cannot turn the cap. An improper adjusted crimper can cause the autosampler to malfunction.

### Using a TCD with the Autosampler

When using a TCD at high sensitivity with a GSV or the autosampler, a minor baseline upset may occur at the time of injection.

If the signal goes below zero, incorporate a timed event Autozero to bring the signal back to zero before the peaks of interest elute.

Observe the initial chromatogram to determine the proper time for the timed event.

### Available syringes

The following syringes are available for the Clarus GC:

<table>
<thead>
<tr>
<th>Syringe</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>5-µL (0.63 mm O.D.) Teflon-tipped plunger (Std)</td>
<td>N6101390</td>
</tr>
<tr>
<td>0.5-µL (0.63 mm O.D.)</td>
<td>N6101252</td>
</tr>
<tr>
<td>0.5-µL (0.47 mm O.D.)</td>
<td>N6101253</td>
</tr>
<tr>
<td>5-µL (0.63 mm O.D.)</td>
<td>N6101251</td>
</tr>
<tr>
<td>5-µL (0.47 mm O.D.)</td>
<td>N6101380</td>
</tr>
<tr>
<td>50-µL (0.63 mm O.D.)</td>
<td>N6101760</td>
</tr>
</tbody>
</table>

**NOTE:** A 0.47-mm needle is required for use with the POC injector and 530-µm columns in the on-column injection mode only. You can achieve better precision in the on-column injection mode when you use sample volumes of 1.0 µL or greater.
Using the Active Method
Setting Up the Detectors
Setting Up the Detectors
Overview

This section contains procedures for setting up the following detectors:

<table>
<thead>
<tr>
<th>Detector Type</th>
<th>Gas Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>FID (flame ionization)</td>
<td>PID and ElCD in Series</td>
</tr>
<tr>
<td>ECD (electron capture)</td>
<td>NPD (nitrogen phosphorus)</td>
</tr>
<tr>
<td>TCD (thermal conductivity)</td>
<td>FPD (flame photometric)</td>
</tr>
<tr>
<td>PID (photoionization)</td>
<td></td>
</tr>
</tbody>
</table>

The instructions provided in this chapter describe how to set detector gases that are controlled by PPC modules as well as how to set detector gases that are controlled by needle valves and pressure regulators (also known as manual pneumatics).

**CAUTION**

*In a Clarus GC equipped with PPC modules, the modules are calibrated at the factory with the corresponding gas; however, there are exceptions. The PPC module that controls the:*

- **ECD** is calibrated with nitrogen.
- **TCD** is calibrated with helium.
- **PID** is calibrated with helium.

*If you intend to use a gas that is different from the gas used to calibrate the PPC module, you must recalibrate the PPC module with the gas.*

The instructional procedures in this chapter are written with the assumption that:

- You know how to measure gas flows using a flowmeter with the Clarus GC’s built-in stopwatch. If not, prior to continuing, please read "Using the Built-in Stopwatch" in Chapter 4, "Before You Install a Column."
  - All heaters are turned **OFF** and cool to the touch.
Setting Up the Detectors

**WARNING**

The instant the Clarus GC is turned on, the oven, injector(s), and detector(s) begin to heat up rapidly. To avoid injury, turn off all heaters and allow their respective zones to become cool to the touch before you touch detectors, injectors, and their corresponding fittings. Detailed procedures for turning heaters off and on are in the Hardware Guide, "Before you Install a Column." If you have not read this chapter, please do so before proceeding.

- A column has been installed, carrier gas flow or pressure has been set, and all connections have been leak tested.

- If you are using PPC modules, they have been calibrated at the factory.
**FID Overview**

Flame Ionization Detectors (FID) are mass sensitive and used for the destructive analysis of organic compounds.

As the sample enters the detector, it is mixed with hydrogen and then burned in air, thereby generating ions. The ions are collected and measured by the detector, with their concentration proportional to the amount of compound present. Ion collection is enhanced by a polarized electric field that is created by applying a negative voltage (~200 V) to the jet tip. The detector sensitivity is affected primarily by the hydrogen flow.

The FID has **flameout** detection and an **auto-ignite** feature. Flameout detection occurs 0.5 minutes into the PRE-RUN time and it measures the user-entered baseline threshold level in mV. If the threshold level is exceeded, the flame is considered lit, otherwise the Clarus GC detects that the flame is out and auto-ignite automatically lights the flame before the start of a run. You can also manually light the flame at any time by pressing the Ignite button.

A cross section view of a FID is shown below.
Figure 4-1 Flame Ionization Detector (FID).

**Setting Up a PPC FID**

To set up a FID that uses PPC modules, first read the FID setup summary, then follow these procedures.

**FID Setup Summary**

To set up the PPC version of the FID:

- Set the air and hydrogen flows.
- Automatically ignite the flame.
- Manually ignite the flame.
Set the Air and Hydrogen Flows

The FID pneumatics utilize two PPC modules: one to control the air and the other to control the hydrogen. You set the PPC controlled air and hydrogen flow from the Clarus GC touch screen. Each PPC module is calibrated at the factory with the gas (air and hydrogen) that it controls; therefore, to set the gas flow, simply follow this procedure. Turn on the air at the source and adjust the line pressure to 70 - 90 psig.

1. Turn on the hydrogen at the source and adjust the line pressure to 60 - 90 psig.)

2. Press the Tools button and select Configuration.

   The Configuration screen, similar to the one below, appears:

   ![Configuration Screen]

3. Touch the button labeled as an FID detector.

   The configuration screen for the FID detector appears:
NOTE: The screen above shows that an FID is installed on Channel A.

4. Select a filter value from the Filter drop-down menu.
The default setting is 200 milliseconds. To improve the signal-to-noise, change the setting to 800 milliseconds. This improves the noise but broadens the peak shapes. If you want a faster detector response, change the setting to 50 milliseconds; however, the noise level may increase.

5. Touch the **Set Point** dialog box for the FID **Flameout**; and then use the 
   and 
   buttons to enter a flameout detection level in mV (for example 0.3 mV).
NOTE: You must set a Flameout value in millivolts (mV) for the FID auto-ignition feature to work. For example, 0.3 mV.

Flameout detection occurs 0.5 minutes into the PRE-RUN time and measures the user-entered baseline threshold level in mV. In this example 0.3 mV are used. If the 0.3 mV threshold level is exceeded, the flame is considered lit; otherwise, the auto-ignite sequence begins to automatically ignite the flame.

6. Touch the **Set Point** dialog box for the **Air** flow and use the plus and minus buttons to set the FID Air flow to **450 mL/min**.
7. Touch the **Set Point** dialog box for the **H2** flow and use the plus and minus buttons to set the Hydrogen flow to **45 mL/min**.
8. Press **OK**.

**Automatically Ignite the Flame**

*How Auto-Ignition Works*

<table>
<thead>
<tr>
<th>CAUTION</th>
<th>To ensure proper auto-ignite FID operation, make sure your column is positioned in the FID 2.75 inches (70 mm) from the back of the column nut.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>The flame may not auto-ignite if your carrier gas flow is 60mL/min or higher.</em></td>
</tr>
</tbody>
</table>

The PPC version of the FID has *flameout* detection and an *auto-ignite* feature. Flameout detection occurs 0.5 minutes into the PRE-RUN time and it measures the user-entered baseline threshold level in mV. If the threshold level is exceeded, the flame is considered lit, otherwise the Clarus GC detects that the
flame is out and auto-ignite automatically lights the flame before the start of a run.

With the FID temperature set, the air and hydrogen flows set, and auto-ignition activated by setting a positive mV value for the flame offset, the FID attempts auto-ignition at -0.5 min. before the system becomes ready. At this Pre-run time the status bar flashes “Flame Ignition” as the air flow is shut off, hydrogen purges the FID for about 10 seconds, and the ignitor energizes for ignition followed by a return of the air flow to the detector to sustain the flame.

After the flame ignites, the FID output level is monitored to confirm ignition before producing a READY signal. If ignition is not confirmed, the ignition process repeats up to two more times if needed. If ignition is not achieved after three attempts, the flame gases are set to off and a dialog box appears displays the following message:

“Flame 1 or 2 failed to ignite.”

Touch the OK button. The status is made NOT READY and “FID 1 or 2 flameout” appears. If auto-ignition is attempted with the FID gases set to zero flow, the message “No ignition. Flame gases are off” appears on the screen. To proceed, go to the Configuration screen and reset the air and hydrogen to their 450 and 45 mL/min flowrates.

To Auto-Ignite

The auto-ignition process only occurs before the start of each run just prior to the instrument becoming READY. However, the manual flame ignition process can be initiated at any time by touching the Ignite button.

1. When auto-ignite begins the Clarus GC equilibrates.

2. Once the two minutes of equilibration expire, Pre-run begins and the GC detects that the flame is not lit and indicates this by alternately flashing Flame and the method name in the status bar.

3. After determining that the flame is not lit, the GC switches to a not ready state and attempts to automatically ignite the flame. Flame Ignition 1 appears in the status bar.

4. The air flow is shut-off and hydrogen is purged through the FID for 10 seconds.
5. The ignitor energizes, the flame ignites (indicated by the POP), and air flow is returned to sustain the flame. The FID output level is monitored to confirm that the flame is lit. If a lighted flame is not confirmed, the Clarus GC repeats the ignition process up to two more times.

**Manually Ignite the Flame**

You can manually ignite the flame at any time by following this procedure. Before trying to ignite the flame, make sure that you have sufficient combustion gases and they are turned on at the source, and make sure that the flows are set as described earlier in this section.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>To ensure proper auto-ignite FID operation, make sure your column is positioned in the FID 2.75 inches (70 mm) from the back of the column nut.</td>
</tr>
<tr>
<td>Flame ignition may not occur if your carrier gas flow is 60 mL/min or higher.</td>
</tr>
</tbody>
</table>

1. Touch the **FID** icon from the System Status screen.

   The FID tab page appears:
Note: For proper ignition to occur, the FID must be heated to at least 100 °C.

2. Touch the temp field and use the plus and minus buttons to enter a setpoint of at least 100 °C, or enter a value 50 °C higher than the highest temperature of your oven program.

3. Wait for the FID temperature to become READY. When the temperature is ready a green light appears next to the temperature display.

4. Touch the Ignite button.

(Note the signal level in mV before the flame ignites.)
5. Upon pressing the Ignite button, the air flow turns off for 15 seconds, Flame Ignition 1 appears in the status bar, and the glow plug begins to glow.

![Glow Plug Ignitor](image)

**Figure 4-2 Location of the FID glow plug ignitor.**

6. When you hear a "POP," observe the Signal level in mV as it increases on the screen and remains greater than the previously noted value. After the flame is lit, a screen will appear that shows the signal level at the range that you set. So if you have set a range of 20, the signal will be 20 times smaller.

You can also confirm that the flame is lit by holding a shiny object (such as a mirror or small wrench) over the FID outlet. Condensation forms on the object if flame ignition has occurred.
If the Flame Goes Out During a Run
If the flame goes out during a run, the run continues until completion however the data collected is invalid. When the Clarus GC prepares for the next run, it checks for a flame by running the Flameout test. If the GC detects that the flame is out, it will automatically attempt to ignite it!
If you have the manual pneumatics version you must then manually ignite the flame.

NOTE: To prevent condensation from forming on the FID, always turn off the flame (by turning off both the hydrogen and air gases) before cooling the detector or turning off the Clarus GC.

Setting Up a Manual Pneumatics FID
To set up the manual pneumatics version of the FID, read the FID Setup Summary and follow the steps.

FID Setup Summary
To set up the manual pneumatics version of the FID:

- Connect a flowmeter to the FID outlet.
- Adjust the hydrogen flow.
- Adjust the air flow.
- Ignite the flame

Connect a Flowmeter to the FID Collector

1. Open the detector cover shown in the following figure.

This exposes the detector outlets. Figure 4-4 shows a top view of the FID
Setting Up the Detectors

outlet.

2. Insert the end of the flowmeter tubing into the FID adapter (P/N N6103119, supplied in the shipping kit). Then insert the adapter into the FID collector.

Figure 4-3. Location of the detector cover.
See the following figure.

Figure 4-4. Connecting the flowmeter to the FID collector.
Setting Up the Detectors

Adjust the Hydrogen Flow

To adjust the combustion gases, the manual pneumatics consist of an on/off needle valve for air and on/off regulator for hydrogen mounted on the pneumatics control panel.

NOTE: Do not overtighten the inner flow adjustment screw in the on/off needle valve or the on/off regulator. Overtightening damages the mechanical device.

Figure 4-5. Combustion gas control valves for a manual pneumatics FID.

Each pneumatic control consists of an outer knob (which is used to turn the hydrogen or air completely on or off), a cap, and an inner gas flow adjustment screw.

Removing the cap exposes the gas flow adjustment screw. To set the air, flow use a small thin screwdriver (P/N 09907273, supplied in the shipping kit) to turn the adjustment screw. Turn the screwdriver counterclockwise to increase the flow or clockwise to decrease the flow. To set the hydrogen, use a hex wrench (P/N 09907235, supplied in the shipping kit) to turn the adjustment screw. Turn the hex wrench clockwise to increase the flow or counterclockwise to decrease the flow.
To adjust the hydrogen flow:

1. Turn the air off by turning the outer ring of the air control valve completely clockwise.

2. Turn on the hydrogen at the tank. Adjust the line pressure to 30 psig.

3. Start the hydrogen flowing by turning the outer ring of the hydrogen pressure regulator completely counterclockwise (see the previous figure).

   **NOTE:** The outer knob is the on/off knob and it must be turned fully on for complete flow. In the case of the pressure regulator, if this knob is only partially opened, the flow will be less than the setting made when the knob was fully opened.

4. To access the adjustment screw, remove the protective cap from the hydrogen pressure regulator.

5. Insert the hex wrench (P/N 09907235) in the adjustment screw and turn it clockwise a few turns.

   For safety reasons, the hydrogen pressure regulator is set to a very low flow before it is shipped from the factory.

6. From the System Status window touch **Tools**. From the Tools drop down menu touch **Utilities**.
Setting Up the Detectors

7. Touch **Stopwatch** icon from the Utilities screen.

8. Measure the flow rate. For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.

![Stopwatch](image)

**NOTE:** All gases exit through the top of the FID. If you use a flowmeter to measure the air and hydrogen gas flows with a column connected to the FID and the carrier gas flowing, remember to subtract the carrier gas flow from the total measured flow.

9. Repeatedly adjust the hydrogen flow and measure the flow until you obtain a flow rate of about 45 mL/min.

**NOTE:** Both the carrier gas and hydrogen gas exit through the FID. For satisfactory operation of the FID, a flow rate of 45 mL/min of hydrogen is required. If a column is connected to the FID, and the carrier gas is set and flowing, you should add the carrier gas flow rate to the required hydrogen flow. For example, if the carrier gas flow is 30 mL/min, adjust the hydrogen flow until the measured total flow rate (combined carrier gas and hydrogen) is about 75 mL/min (45 mL/min of hydrogen plus 30 mL/min of carrier gas).
10. **Turn off the hydrogen** flow by turning the outer ring of the hydrogen control valve completely clockwise.

11. Replace the protective cap on the hydrogen pressure regulator.

**Adjust the Air Flow**

1. Turn on the air at the source. Adjust the line pressure to 30 psig.
2. Make certain that the flowmeter is still attached to the FID collector.
3. Start the air flowing by turning the outer ring of the air control valve (see Figure 8-6) fully counterclockwise.
4. Remove the protective cap from the air control valve.

   The stopwatch screen should still be displayed.

5. Measure the flow rate.

   For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.

6. Repeatedly adjust the air flow by turning the needle valve with a small screwdriver (P/N 09907273) and measure the flow until you achieve a flow rate of about 450 mL/min.

   **NOTE:** Both the carrier gas and air exit through the FID. For satisfactory operation of the FID, a flow rate of 450 mL/min of air is required. If a column is being used with the FID, and the carrier gas has been set and is flowing, the carrier gas flow rate should be added to the required air flow. For example, if the carrier gas flow is 30 mL/min, adjust the air flow until the measured total flow rate (combined carrier gas and air) is about 480 mL/min.

7. **Turn off the air** flow by turning the outer ring of the air control valve completely clockwise.

8. Replace the air control valve protective cap, remove the flowmeter, and replace the FID cap.

9. From the Stopwatch screen touch **OK** when this procedure is complete.

**NOTE:** If at any time the line pressure is changed from 30 psig, you must re-measure and adjust the air flows.
Setting Up the Detectors

**Ignite the Flame**

1. Touch the **FID** icon from the System Status screen.
   
   **NOTE:** *For proper ignition to occur, the FID must be heated to at least 100 °C*

2. From the FID tab page touch the temp field and use the plus minus buttons to enter a setpoint of at least 100 °C, or enter a value 50 °C higher than the highest temperature of your oven program.

3. Close the oven door. Wait for the FID temperature to become READY. This is indicated by a green light next to the temperature display.

4. Turn on the hydrogen by turning the outer knob of the hydrogen pressure regulator valve fully counterclockwise.

   **NOTE:** *The outer knob is the on/off knob and it must be turned fully on for complete flow. In the case of the pressure regulator, if this knob is only partially opened, the flow will be less than the setting made when the knob was fully opened.*

5. After purging the FID with hydrogen for a minimum of 60 seconds observe the signal icon directly below the Heater Off button.

   **NOTE:** *The signal level in mV before the flame ignites.*

6. Pressing the Ignite button.

7. Quickly turn the air on by turning the outer knob of the air control valve fully counterclockwise.
8. When you hear a “pop” sound, observe the Signal level in mV (as 0.52 mV) as it increases on the screen and remains greater than the previously noted amount.

You can also confirm that the flame is lit by holding a shiny object (such as a mirror or small wrench) over the FID outlet. Condensation will appear on the object if ignition has occurred.

**WARNING**

**The FID outlet is hot!** To prevent injury, never place your hand over the FID outlet.

---

**If the Flame Goes Out During a Run**

If the flame goes out during a run, the run continues until completion however the data collected is invalid. When Clarus GC prepares for the next run it, checks
Setting Up the Detectors

for a flame by running the Flameout test. If the Clarus GC detects that the flame is out, a screen will appear that will indicate that the flame is out.
You must then manually ignite the flame.

NOTE: To prevent condensation from forming on the FID, always turn off the flame (both hydrogen and air gases) before cooling the detector or turning off the Clarus GC.

Using the FID in Corrosive Environments
If you are analyzing samples (such as chloroform, methylene chloride, etc.), that produce corrosive by-products, we recommend installing the piece of vent tubing (P/N 02506490) supplied in the Clarus GC Shipping Kit (P/N N6100348) and setting the FID temperature greater than 250° C to minimize condensation from forming. Since these corrosive by-products attack the top of the FID collector assembly, including the ignitor, we strongly recommend venting the FID into a vent hood.

NOTE: The flame will not ignite with this vent tubing installed. To ignite the flame, you must first remove the vent tubing, ignite the flame, and then replace the vent tubing.
To install the vent tubing:
1. Ignite the FID flame.

2. Lift-open the detector cover.
3. Cut the piece of tubing (P/N 02506490) to a length of 4-inches and firmly insert one end of the tubing into the top of the FID.
4. Route the end of the tubing through the hole in the detector cover as you close the detector cover.
5. Connect one end of a length of vent tubing to this piece of tubing and place the other end in a vent hood.

The FID outlet is hot! To prevent injury, never place your hand over the FID outlet.
Setting up an ECD

To assure that removable radioactive contamination on the external parts of the ECD remain at a safe level, the United States Nuclear Regulatory Commission requires that:

- the ECD is Wipe Tested at least once every six months and
- a record of the results are maintained for NRC inspection.

Please refer to the Hardware Guide, Maintenance chapter, for the Wipe Test procedure.

NOTE: THERMAL RUNAWAY PROTECTION: The Clarus GC software shuts down the GC if any heated zone exceeds 470 °C. Should this occur, the following error message is displayed:

INSTRUMENT SHUTDOWN
xxxxx THERM RUNAWAY

....where xxxxx is the heated zone.

Call your PerkinElmer Representative.

Instrument shutdown also occurs if there is a PRT (Platinum Resistance Thermometer) or MPU (Micro Processor Unit) failure. In these cases the following error message is displayed:

INSTRUMENT SHUTDOWN
xxxxx PRT ERROR

....where xxxxx is the failed zone.

Call your PerkinElmer Representative

NOTE: The detector gas modules have been set to OFF at the factory for both manual and PPC pneumatics.


**United States Government Regulations for ECDs**

**NOTE:** Repairing an Electron Capture Detector cell requires a specific license by the U.S. Nuclear Regulatory Commission (NRC) and/or in some states by the equivalent state agency. For further information on obtaining a license, contact PerkinElmer, Shelton, Connecticut Customer Service department or the NRC Material Branch Office of Nuclear Materials, Safety and Safeguards, Washington, DC 20555.

**Special Instructions for ECD Cell Purchasers**
(Who are not Specifically Licensed to Handle Radioactive Materials)

The PerkinElmer Electron Capture Detector (P/N N6100063, 120 V or N6100134, 230 V) contains 15 mCi of Nickel-63 (Ni 63), a radioactive material. Your possession and use of this detector is governed by 10 C.F.R. Section 31.5, which is reproduced in Appendix I. Under the provisions of that regulation you are deemed a "General Licensee."

Your possession and use of the Detector Cell may also be regulated by the state where you are located. The requirements of state regulatory agencies are substantially similar to those contained in NRC regulation 10 C.F.R. Section 31.5, but they may differ in some respects. It is suggested that you procure a copy of the regulations of your particular state. (Supplement 2 in Appendix I contains a list of the "Agreement States" which have been granted authority by the U.S. Nuclear Regulatory Commission to regulate the possession and use of radioactive material.)

It is required that you are familiar with regulation 10 C.F.R. Section 31.5 (Supplement 1). Following are summaries of its requirements.

**Labels**

Do not remove any of the labels attached to the ECD cell or any of the labels attached to your AutoSystem GC that refer to the ECD cell. Follow all instructions and abide by all precautions provided by the labels and in user instruction manuals referred to by the labels.
Setting Up the Detectors

**Leak Testing**

You are obligated under federal and state regulations to make certain that the ECD cell is wipe tested for leakage of radioactive materials at intervals of no longer than six months, and that the analysis of these wipe tests is conducted by a person specifically licensed to do so, either by the U.S. Nuclear Regulatory Commission or by an Agreement State. The analyses can be performed by the firm listed below:

<table>
<thead>
<tr>
<th>National Leak Test Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>P.O. Box 486</td>
</tr>
<tr>
<td>North Tonawanda, New York 14120</td>
</tr>
</tbody>
</table>

**Cell Failure or Damage**

If a leak test detects more than 0.005 mCi of removable radioactive material on the surface of an ECD cell, or if the cell itself is damaged in such a way as to indicate that it may no longer adequately shield the radioactive material inside, you must immediately suspend operation of your chromatograph until the cell has been repaired or disposed of by a person specifically licensed to do so. Any such incident must be reported by you to the Regional Office, Inspection and Enforcement, U.S. Nuclear Regulatory Commission.

**Reporting Radiation Incidents, Theft or Loss**

Please read NRC Regulation 10 C.F.R. Section 20.402 and 20.403 (Appendix I). These describe your duties should the radioactive material (Ni 63) in the ECD cell be lost, stolen, or released, or should any person be exposed to radiation.

**Other Requirements**

Regulation 10 C.F.R. Section 31.5 (see Appendix I) does not permit you to abandon the ECD cell or export it. It may not be transferred except to a person specifically licensed to receive it. Within thirty days of such a transfer, you must report to the Director of Nuclear Material Safety and Safeguards, U.S. Nuclear Regulatory Commission, Washington, D.C. 20555, the name and address of the transferee. However, no report is needed to transfer a used or defective ECD cell to PerkinElmer in order to obtain a replacement. You may transfer the ECD cell
to another general licensee, like yourself, only when it remains at the same location to which it was shipped by PerkinElmer. Give the transferee a copy of these instructions and the regulations in Appendix I, and report to the commission as required in Regulation C.F.R. Section 31.5.

![WARNING]

The ECD cell may only be removed for repair from the chromatograph if a specific license has been obtained, THE CELL SHOULD NEVER BE DISMANTLED.

United Kingdom Regulations

In the U.K., registration is required under the Radioactive Substances Act of 1960, for anyone keeping or using radioactive materials. Application should be made to any one of the following governing bodies:

**ENGLAND**
Department of the Environment Queen Anne's Chambers
Tothill Street
London, SW1H 9J4

**SCOTLAND**
Scottish Development Department
21 Hill Street
Edinburgh, EH2 3J4

**WALES**
Welsh Office
Cathay's Park
Cardiff, CF1 3NG

**NORTHERN IRELAND**
Ministry of Development
Parliament Building
Storemont
Belfast, Northern Ireland
**ECD Overview**

The Electron Capture Detector (ECD) is the most sensitive detector available for the analysis of electrophilic compounds such as chlorinated hydrocarbons and pesticide residues. It is concentration-sensitive and nondestructive.

The ECD cell contains a foil in a cylinder through which the carrier gas flows. The coating of the foil's inner surface contains the radioactive isotope Nickel-63 and has a nominal sensitivity of 15 mCi. To optimize detector response, make-up gas is combined with column effluent.

Beta particles emitted from the isotope ionize the carrier gas. The resultant ions and electrons travel to the collector anode assembly under the influence of a pulsed polarizing voltage applied between the source and the collector. The pulse frequency is varied to maintain a constant average current. The presence of an electron absorbing species in the detector decreases the current as the absorbed electrons form ions, which travel more slowly than electrons. The pulse frequency of the polarizing supply is automatically controlled to maintain a constant current and is used to form the detector output signal.

The ECD works with nitrogen carrier or makeup gas or a carrier or makeup gas mixture of 95% argon/5% methane. When using capillary columns at low flows (5 mL/min or less), helium or hydrogen may be used as the carrier gas provided nitrogen or argon/methane is used as the make-up gas. A cross section view of an ECD is shown below.
If you are using the ECD with a packed column, check to see whether the optional Flow Readout was calibrated with nitrogen or argon/methane carrier gas. If not, select the appropriate carrier gas.

To function properly, the total carrier gas flow through the detector should be 30 mL/min or more. Where required, the total carrier gas flow is adjusted to this value with make-up gas using the make-up gas control valve located on the pneumatics control panel. The appearance and location of the make-up gas control valve is shown in Figure 4-9.

**NOTE:** If you want to switch between a FID and an ECD, when using the same packed column injector, use nitrogen as the carrier gas for both detectors. Argon/methane is not recommended for use with an FID because it produces a high background, more noise, and a wandering baseline.

**NOTE:** To minimize detector contamination, run the ECD hot, at a temperature of at least 375 °C.
NOTE: You may experience high background readings when working with capillary columns. The high background may be caused by liquid phase bleeding off the detector end of the column (at a typical temperature of 375 °C or higher). In some cases the polyimide coating of the column may also cause a high background reading when using the ECD.

You can correct this situation by installing a glass-lined receiver (P/N N6000968). The glass-lined receiver terminates in a 1/16-inch fitting so that it can accept capillary columns with an i.d. of 530 microns or less.

If you suspect that the background is caused by column liquid phase bleeding, install the glass-lined receiver in the detector base. Then insert the column end just beyond the ferrule and connect it to the receiver.

If you suspect that the background is caused by the polyimide, insert the column through the glass-lined receiver until it is flush with the end of the receiver. Then insert the receiver into the detector base. This shields the column from the make-up gas flow.

**ECD Set Up**

To set up an ECD, read the ECD setup summary, then follow the steps.

**ECD Setup Summary**

To set up an ECD:

- Vent the ECD outlet.
- Adjust the make-up gas flow (PPC and manual pneumatics).

**NOTE:** Because an ECD is extremely sensitive, contamination from any part of the system can add to the background and noise. To help assure a clean system the injector and detector should be baked-out and both packed and capillary columns thoroughly conditioned before use. When conditioning columns for use with an ECD, DO NOT attach the column to the ECD. Clean tubing and pure filtered gases should be used. Whenever a column is disconnected from an ECD, the ECD should first be cooled to avoid oxidation of the Nickel foil.
Vent the ECD Outlet

NOTE: If venting the ECD effluent is required, attach an additional piece of tubing to the tubing that is connected to the ECD outlet. This does not affect the performance of the ECD.

1. Open the detector cover (see the following figure) to expose the top of the ECD.

![Figure 4-7. Top view of an ECD.](image)

2. Remove the two screws that secure the insulating cover to the Clarus GC.

3. Remove the insulating cover and detector cap.
   This exposes the ECD outlet (see the following figure).

4. Attach the outer metal sleeve of the vent tubing (P/N N6100161) to the ECD Outlet.
Figure 4-8. Connecting vent tubing to the ECD outlet.

5. Press down and turn the metal sleeve on the end of the vent tubing to secure it to the ECD.

6. Thread the vent tubing through the detector cap and insulating cover as you position them over the ECD.

7. Secure the insulating cover to the Clarus GC with the two screws previously removed.

8. Thread the tubing through hole in the detector cover then close the detector cover.
   
   This hole is either directly above the ECD or at the rear of the detector cover, depending on the detector configuration.

9. Attach a flowmeter to the vent tubing.

**Adjust the Make-up Gas Flow**

The following procedures describe how to set the make-up gas in the PPC version or manual pneumatics version of the Clarus GC. Select the procedure that applies to your version.
CAUTION

The ECD flow module for make-up gas is calibrated with nitrogen gas at the factory. You must recalibrate the ECD flow module if you are using a make-up gas other than nitrogen.

Set the Make-Up Gas in the PPC Version

With PPC pneumatics, the make-up gas is set from the Clarus GC keyboard.

The PPC modules are calibrated at the factory; therefore, to set the flows for an analysis, simply follow this procedure.

To set the make-up gas:
1. Set the make-up line pressure to 60 - 90 psig.
2. In the System Status screen touch the ECD icon.

3. In the ECD Tab you will see the Make Up field to change the setting touch Tools and touch Configuration from the drop down menu.
4. In this Configuration screen use the plus minus buttons to set the make-up gas flow. Touch Close when finished.
The default setting is 200 milliseconds. If you want to improve the signal-to-noise, change the setting to 800 milliseconds; however, the noise improves but the peak shapes broaden. If you want a faster detector response, change the setting to 50 milliseconds; however, the noise level may increase.

**Adjust the Make-Up Gas in the Manual Pneumatics Version**

To adjust the make-up gas in the manual pneumatics version, use the on/off needle valve mounted on the pneumatics control panel.

**CAUTION**

*Do not overtighten the inner flow adjustment screw in the on/off needle valve or the on/off regulator. Overtightening damages the mechanical device.*
Setting Up the Detectors

Figure 4-9. The ECD make-up gas control valve for a manual pneumatics ECD.

The make-up gas control valve consists of an outer ring (used to turn the make-up gas completely off or on), a protective cap, and an inner needle valve (used to adjust the flow of make-up gas). Removing the cap exposes the needle valve adjustment screw. To set flow, use a small thin screwdriver (P/N 09907273), supplied in the shipping kit) to turn the adjustment screw. Turn the screwdriver counterclockwise to increase the flow or clockwise to decrease the flow.

You should only adjust make-up gas flow after a column has been installed and the carrier gas flow or pressure has been set to the value required for the analysis.

Make-up gas need not be added when using packed columns, where the carrier gas flow is 30 mL/min or higher.

To adjust the make-up gas:

1. Turn the outer ring of the make-up valve fully clockwise.

2. From the System Status window touch Tools. From the Tools drop down menu touch Utilities.
3. In the Utilities screen touch **Stopwatch** icon.

4. Measure the flow rate. For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.
Setting Up the Detectors

5. Turn the outer ring of the make-up valve fully counterclockwise.

6. Remove the protective cap from the make-up valve.

7. Repeatedly adjust the make-up gas (turn the needle valve using the screwdriver (P/N 09907273) counterclockwise to increase the flow, clockwise to decrease the flow). Adjust the total flow until it equals 30 mL/min or higher.

   **NOTE:** *The lower the total flow, the better the sensitivity, provided that peak shape is maintained.*

8. Replace the cap on the make-up gas valve and disconnect the flowmeter.
Setting up a TCD

NOTE: The detector gas modules have been set to OFF at the factory for both manual and PPC pneumatics.

TCD Overview

The Thermal Conductivity Detector (TCD) is a dual-channel detector which measures the difference in thermal conductivity between carrier gas flowing through a reference channel and carrier gas plus sample flowing through an analytical channel (see the following figure).

Four tungsten-rhenium filaments are connected in a bridge circuit, two in each channel. The TCD is set up with the same amount of carrier gas flowing through both channels. The presence of a sample component in the carrier gas flowing through the analytical channel changes the resistance of the filaments in that channel. This unbalances the bridge and produces a signal proportional to the amount of sample.

Figure 4-10. Thermal Conductivity Detector (TCD).
**TCD Setup**

Setting up a TCD requires that you equalize carrier gas flows through both channels, followed by balancing the current through the two filaments. The TCD is nondestructive and can be used in series with other detectors. The TCD is a universal detector that is concentration sensitive. The TCD sensitivity depends on the filament current, component concentrations, and the difference in thermal conductivity between the carrier gas and the component.

**NOTE:** To prevent TCD filament damage, shut off the filament current before disconnecting columns or turning off gas flows.

To set up a TCD, read the TCD setup summary, then follow the steps.

**TCD Setup Summary**

To set up a TCD:

- Turn on the oven and detector heaters.
- Equalize the makeup and reference gas flows.
- Enter the TCD bridge current.
- Balance the bridge

**Turn on the Oven and Detector Heaters**

1. Close the oven door. This turns on the oven heater.

2. From the System Status screen touch the TCD icon.
2. In the TCD tab page touch the temp field and use the plus minus buttons to add a TCD temperature appropriate for the analysis to be run.

3. If you require the heater on for your analysis just touch the heater button and it will toggle to heater on.
Setting Up the Detectors

Equalize the Makeup and Reference Gas Flows

The following procedures describe how to adjust the makeup and reference gas in a PPC version and manual pneumatics version of the Clarus GC. Follow the procedure that corresponds to your instrument.

**CAUTION**

*The TCD flow module for reference gas is calibrated with helium gas at the factory. You must recalibrate the TCD flow module if you are using a reference gas other than helium.*

For optimum performance, apply a minimum flow of 5 mL/min to each of the two detector channels.

Set the Makeup and Reference Gas in the PPC Version

With PPC pneumatics the reference gas is set from the Clarus GC touch screen. Also, PPC pneumatics provide the user with TCD filament protection by monitoring the carrier gas leak tests or monitoring the gas through the alarm feature and shutting down the TCD current if a gas leak or no gas at all is detected.

The PPC modules are calibrated at the factory; therefore, to set the flows for an analysis, simply follow this procedure.
1. To set the make-up and reference gases touch the **Tools** button in TCD tab screen and touch **Configuration** from the drop down menu. This will bring you to the TCD Configuration screen page (see screens above).

2. In the TCD Configuration screen set the make-up gas and reference gas line pressures to a range of **60 - 90** psig by using the plus minus buttons.

3. As shown in the example above use the plus minus buttons set the filter to **200** and the Output to **5**. When all the settings are appropriate for your analysis touch **OK**. The TCD tab screen will be now visible and the changes you made in the configuration screen will be shown.
Setting Up the Detectors

The default setting for the filter is 200 milliseconds. If you want to improve the signal-to-noise, change the setting to 800 milliseconds; however, the noise improves but the peak shapes broaden. If you want a faster detector response, change the setting to 50 milliseconds; however, the noise level may increase.

NOTE: To protect the TCD filaments from errors associated with the sample and reference gas channels, you must select the necessary detector gas sources. As shipped from the factory, the sample channel is Carrier 2 and the reference gas channel is the detector Reference Gas. In some cases, with Arnel configurations, for example, the TCD could be sourced with both a Carrier gas as well as an Aux gas (in GSV applications half the run could look at the Carrier and half could look at an Aux source). In other cases, the reference gas could be replaced by a second channel of carrier gas (in a dual column TCD setup).

Adjust the Reference Gas in the Manual Pneumatics Version

To adjust the reference gas in the manual pneumatics version, use the regulator mounted on the pneumatics control panel.

1. Open the detector cover to expose the reference and analytical gas outlets and the balance potentiometer.
Figure 4-11. Top view of a TCD.

2. Attach the tubing from the flowmeter to the end of the TCD analytical outlet.

3. From the System Status window touch **Tools**. From the Tools drop down menu touch **Utilities**.

![Stopwatch icon](image)

4. In the Utilities screen touch **Stopwatch** icon.

5. Measure the flow rate. For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.
6. Measure the column flow rate.

7. Disconnect the flowmeter from the analytical outlet and connect it to the reference outlet.

8. Measure the flow through the reference channel.

9. Repeatedly adjust (using the TCD reference flow knob) and measure the flow through the reference channel until it is within ±20% of the flow through the analytical channel. Turn the knob clockwise to decrease the flow, counterclockwise to increase the flow.
Figure 4-12. Reference flow knob for a manual pneumatics TCD.

10. Remove the flowmeter.


**Enter the TCD Bridge Current Range**

1. Select a bridge current range using the criteria in the following table.

*NOTE: Operating at too high a temperature can have an adverse effect on filament life.*
Setting Up the Detectors

Table 4-1. Bridge Current Range vs. Max. Detector Operating Temperature

<table>
<thead>
<tr>
<th>Bridge Current Range</th>
<th>Recommended Operating Temperatures for the Following Detectors</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>He or H₂</td>
</tr>
<tr>
<td>± 4</td>
<td>Up to 100 °C</td>
</tr>
<tr>
<td>± 3</td>
<td>Up to 300 °C</td>
</tr>
<tr>
<td>± 2</td>
<td>Up to 350 °C</td>
</tr>
<tr>
<td>± 1</td>
<td>Up to 350 °C</td>
</tr>
</tbody>
</table>

The correlation between bridge current and range is in Table 4-2:

Table 4-2. Correlation Between Bridge Current and Range

<table>
<thead>
<tr>
<th>Bridge Current (mA)</th>
<th>Range Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>±0</td>
</tr>
<tr>
<td>40</td>
<td>±1</td>
</tr>
<tr>
<td>80</td>
<td>±2</td>
</tr>
<tr>
<td>120</td>
<td>±3</td>
</tr>
<tr>
<td>160</td>
<td>±4</td>
</tr>
</tbody>
</table>

**NOTE:** Entering a negative number reverses the detector polarity. For examples of reversing the polarity, see the Clarus GC Hardware Guide, Maintenance Chapter, section “Practical Hints.”

**Balance the Bridge**

1. In the System Status Screen touch the **Signal** icon to get to the Signal screen. This will allow you to observe the signal as you adjust the potentiometer.
2. Allow the system to stabilize for about 20 min, then open the detector cover.

3. Locate the TCD Balancing Potentiometer (see Figure 4-11). Adjust the potentiometer until the Autozero display reads between 0.0 and 20.0 mV.

4. Wait for drifting to stop as indicated by a constant reading on the display.

5. Reset the potentiometer to produce a reading between 0.0 and 20.0 mV.

**Using a TCD with the Autosampler or GSV**

When using a TCD with the autosampler or a GSV (Gas Sampling Valve) at high sensitivity, a minor baseline upset may occur at the time of injection.

If the signal goes below zero, create an Autozero timed event to bring the signal back before peaks of interest elute. Initiate a test run to determine the timed event setting.
Setting up a PID

**NOTE:** The detector gas modules have been set to OFF at the factory for both manual and PPC pneumatics.

**PID Overview**

The PerkinElmer Photoionization Detector (PID) is designed to allow the effluent from a chromatographic column to be ionized by ultraviolet light (provided the ionization potential of the effluent is less than that of the UV source). The current produced by the ion flow is measured by the detector and is proportional to the concentration of the ionized material.

A cross section view of a PID is shown in the following figure. Figure 4-14 is an illustration of an installed PID.

**NOTE:** The optimum operating temperature for a photoionization detector is 250 °C. PIDs may be operated at 350 °C for short periods of time with a subsequent loss in lamp life.

The PID is equipped with a glass-lined inlet and exhaust that permits series operation with another detector.
Figure 4-13. Cross section view of a PID.
Figure 4-14. PID installed in the Detector 2 position.

**PID Setup**

To set up a PID, read the PID setup summary, then follow the steps.

**PID Setup Summary**

To set up a PID:

- Turn on the oven and the detector heaters.
- Adjust the make-up gas.
  
  Adjust the make-up gas flow if using a capillary column at flows of ≤10 mL/min.
- Turn on the UV lamp.
- Optimize the lamp intensity.
Turn on the Oven and the Detector Heaters

**NOTE:** *A PID can only be installed in the Detector 2 position (rear).*

1. Close the oven door. This turns on the oven heater.

2. From the System Status screen touch the PID icon.

3. In the PID tab page touch the temp field and use the plus minus buttons to add a PID temperature appropriate for the analysis to be run.

4. If you require the heater on for your analysis just touch the **heater** button and it will toggle to heater on.
Adjust the Make-up Gas

Make-up gas is required when using capillary columns at low flows (10 mL/min or less). Since a PID is concentration sensitive, make-up gas flow should be kept to a minimum to obtain the best peak shapes and sensitivity.

**NOTE:** Use make-up gas only if you are using a capillary column at flows of \(\leq 10\) mL/min.

The following procedures describe how to adjust the make-up gas in a PPC and manual pneumatics version of the Clarus GC.
Set the Make-Up Gas in the PPC Version

**CAUTION**

*The PID flow module for reference gas is calibrated with helium gas at the factory. You must recalibrate the PID flow module if you are using a reference gas other than helium.*

With PPC pneumatics the make-up gas is set from the Clarus GC touch screen.

The PPC modules are calibrated at the factory: therefore, to set the flows for an analysis, simply follow this procedure.

4. To set the make-up and reference gases touch the **Tools** button in PID tab screen and touch **Configuration** from the drop down menu.
Setting Up the Detectors

4-60

This will bring you to the PID Configuration screen page (see screens above).

5. In the PID Configuration screen set the make-up gas and reference gas line pressures to 60 - 90 psig by using the plus minus buttons.

6. As shown in the example above use the plus minus buttons set the filter to 200 and the output to 5. When all the settings are appropriate for your analysis touch OK. The TCD tab screen will be now visible and the changes you made in the configuration screen will be shown.

The default setting for the filter is 200 milliseconds. If you want to improve the signal-to-noise, change the setting to 800 milliseconds; however, the noise improves but the peak shapes broaden. If you want a faster detector response, change the setting to 50 milliseconds; however, the noise level may increase.

Adjust the Make-Up Gas in the Manual Pneumatics Version

To adjust the make-up gas in the manual pneumatics version use the on/off needle valve mounted on the pneumatics control panel.

NOTE: Do not overtighten the inner flow adjustment screw in the on/off needle valve. Overtightening damages the mechanical device.

The manual pneumatics make-up gas control valve is shown below.
Figure 4-15. Make-up gas control valve for a manual pneumatics PID.

The make-up gas control valve consists of an outer ring (used to turn the make-up gas completely off or on), a protective cap, and an inner needle valve (used to adjust the flow of make-up gas). Removing the cap exposes the needle valve. To adjust the flow, use a small thin screwdriver to turn the needle valve adjustment screw counterclockwise to increase the flow and clockwise to decrease the flow.

Make-up gas flow should be adjusted only after a column has been installed and the carrier gas flow or pressure has been set to the value required for the analysis. Make-up gas need not be added when using packed columns where the carrier gas flow is typically 20 mL/min or higher.

To adjust the PID make-up gas:

1. Attach a flowmeter to the PID exit.
2. Turn off the make-up gas by turning the outer ring of the make-up valve fully clockwise (see Figure 4-15).

3. From the System Status window touch **Tools**. From the Tools drop down menu touch **Utilities**.
4. From the System Status window touch **Tools**. From the Tools drop down menu touch **Utilities**.

5. In the Utilities screen touch **Stopwatch** icon.

6. Measure the flow rate. For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.
7. Turn the make-up gas on by turning the outer ring of the make-up valve fully counterclockwise.

8. Remove the protective cap from the make-up valve, exposing the needle valve (see Figure 4-25).

9. Repeatedly adjust the make-up gas (turning the needle valve counterclockwise to increase the flow, clockwise to decrease the flow) and adjust the total flow until it is >10 mL/min.

The lower the total flow, the better the sensitivity, provided peak shape is maintained.

10. Replace the make-up valve protective cap.

11. Disconnect the flowmeter.

**Turn on the UV lamp**

1. Lift the detector cover to expose the PID (see Figure 4-14).

2. Turn the lamp intensity control knob fully counterclockwise.

3. Turn the UV lamp switch ON.

4. From the PID Tab make sure that Auto Zero box is off. If it is on off touch the field to have the check mark removed (off).
5. Allow the system to stabilize until the background signal is steady.

**Optimize the Lamp Intensity**

1. As shown in the screen above, go to the Atten (Attenuation) field. Touch the downward arrow and select an attenuation value of 32.

2. Make sure the Auto Zero field is checked off.

3. Locate the lamp intensity control knob (see Figure 4-14) and slowly turn it clockwise (increasing the signal) until the background signal on your integrator or recorder (whichever is configured) suddenly decreases.
Setting Up the Detectors

Figure 4-17. A typical intensity signal.

1. Repeat steps 2 through 4 at different attenuations using the highest lamp intensity that corresponds to the lowest background signal.

**NOTE:** If optimizing the lamp intensity cannot be done easily using the above procedure, increase the lamp intensity until the noise is between 1% and 1.5% of full scale at an attenuation of x8.
Setting Up a PID and EICD in Series

NOTE: The detector gas modules have been set to OFF at the factory for both manual and PPC pneumatics

Setting up an EICD

NOTE: The detector gas modules have been set to OFF at the factory for manual pneumatics

EICD Overview

Electrolytic conductivity detectors (EICD), often referred to as Hall detectors, are halogen specific. The GC column effluent is mixed with hydrogen and passed through a heated nickel reactor tube that reduces the halogen and forms an acid (for example, HCl, HBr, HI or HF). This acid is absorbed in n-propanol. The increased conductivity of the acid in n-propanol is measured and the signal is proportional to the amount of converted halogen.

The schematic in the following figure shows the EICD components and the flow direction of the column effluent and solvent.

Figure 4-18. EICD flow diagram.
Setting Up the Detectors

The following figure shows the EICD installed in the detector compartment.

![Diagram showing EICD installation](image)

**Figure 4-19. EICD installed in the Detector 2 position.**

A cross sectional view of the reactor assembly and conductivity cell is shown below.
Figure 4-20. Diagram of the reactor assembly and conductivity cell.

**EICD Control Unit**

The EICD is operated from the control unit shown below.
Setting Up the Detectors

Figure 4-21. Front view of the EICD control unit.

The EICD is controlled by the keys on the front panel and the display at the top of the EICD control unit. Refer to the Model 2000 Hall Detector System Operator’s Manual shipped with the EICD for operating instructions.

**EI CD Setup**

To set up an EI CD, read the EI CD setup summary, then follow the steps below. The setup procedure assumes the following:

- You know how to measure gas flows using a soap bubble flowmeter and the built-in stopwatch. All heaters are OFF.
- A column has been installed.

In addition, with the PPC version, the reactor hydrogen gas is controlled two different ways depending on the type of amplifier board installed.
<table>
<thead>
<tr>
<th>EICD alone or EICD/PID combination</th>
<th>Where to control the hydrogen gas</th>
</tr>
</thead>
<tbody>
<tr>
<td>With the external amplifier board.</td>
<td>EICD H2 screen under Configuration</td>
</tr>
<tr>
<td>Without the external amplifier board.</td>
<td>Aux 4 Gas screen</td>
</tr>
</tbody>
</table>

**EICD Setup Summary**

To set up an EICD:

- Leak test.
- Set the hydrogen flow.
- Bake out the reactor.
- Connect the reactor to the conductivity cell.
- Adjust the solvent flow.
- Set a timed event to vent the sample solvent.

**Leak Test**

1. Cap the outlet of the reactor assembly with a 1/16-inch compression fitting.

2. Test all fittings for leaks using a 50/50 mixture of isopropanol/H₂O, or an electronic leak detector. Tighten all leaking connections.

   **CAUTION**

   To avoid contaminating the system, DO NOT use a soap solution for leak testing.

3. Remove the cap from the outlet of the reactor assembly and reattach the flowmeter.
Setting Up the Detectors

**Set the Hydrogen Flow**

The following procedures describe how to adjust the hydrogen reactor gas flow in the PPC version and manual pneumatics version of the Clarus GC.


You can adjust the flow of hydrogen to the reactor assembly by using the on/off regulator that is mounted on the pneumatics control panel.

**NOTE:** *Do not overtighten the inner flow adjustment screw in the on/off regulator. Overtightening damages the mechanical device.*

![Diagram](attachment:image.png)

**On/Off Regulator Operation**

1. **Turn outer knob for On/Off.**
2. **Remove cap from regulator valve knob.**
3. **With hex wrench, adjust inner control for flow.**

Figure 4-22. Reactor gas control valve for a manual pneumatics E1CD.

The on/off pressure regulator consists of an outer ring (which is used to turn the hydrogen completely on or off), a cap, and an inner adjustment screw.

Removing the cap exposes the adjustment screw which controls the gas flow. Using a hex wrench, turn the adjustment screw clockwise to increase the flow, and counterclockwise to decrease the flow.

To adjust the hydrogen reactor gas:
1. Disconnect the reactor assembly from the conductivity cell by removing the tubing from the modified union.

2. Attach a flowmeter to the outlet of the reactor assembly.

3. Turn on the hydrogen at the tank and adjust the line pressure to 30 psig.

4. Start the hydrogen flowing by turning the outer knob of the hydrogen pressure regulator fully counterclockwise.

**NOTE:** The outer knob is the on/off knob and it must be turned fully on for complete flow. In the case of the pressure regulator, if this knob is only partially opened, the flow will be less than the setting made when the knob was fully opened.

5. To expose the adjustment screw, remove the protective cap from the hydrogen pressure regulator. Then turn the adjustment screw clockwise a few turns.

**NOTE:** For safety reasons, the hydrogen pressure regulator is set to a very low flow before it is shipped from the factory.

6. From the System Status window touch **Tools**. From the Tools drop down menu touch **Utilities**.
7. In the Utilities screen touch **Stopwatch** icon.
8. Measure the flow rate. For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.

9. Repeatedly adjust the hydrogen flow and measure the flow until you obtain a flow rate of about 25 mL/min not including the flow of carrier gas. Replace the protective cap on the hydrogen pressure regulator.

10. Disconnect the flowmeter before proceeding to the next step.

**Bake Out the Reactor**

1. Turn the ElCD control unit ON.

2. Set the Oven, Injector, and Detector temperatures to values appropriate for the column you are using and the material you are analyzing.

3. Turn the Reactor Temp switch ON.

4. Set the Reactor Temp control to 800 °C.

5. Display the reactor temperature.
6. Allow the system to bake out for 2 – 4 hours.

7. Turn the Reactor Temp control Off and allow the system to cool to ambient before proceeding further.

**Connect the Reactor to the Conductivity Cell**

Referring to Figure 4-20, reconnect the effluent transfer line (a 3.5-inch piece of Teflon tubing) from the reactor assembly to the input of the conductivity cell using the 1/16-inch to 1/16-inch compression union and Vespel ferrules supplied.

**Adjust the Solvent Flow**

1. Place the drain tubing from the bottom of the conductivity cell into a 10-mL graduated cylinder.

2. Turn the Solvent Flow On.

3. Measure the flow into the graduated cylinder and adjust it to about 0.6 mL/min.

4. Discard the first 50 - 100 mL of solvent collected.

5. Place the drain tubing from the bottom of the conductivity cell back into the solvent reservoir.

**NOTE:** To prevent damage caused by solvent flowing back into the reactor, ALWAYS turn off the solvent flow before you turn off the carrier flow or disconnect the column.

**Set a Timed Event to Vent the Sample Solvent**

**NOTE:** GC samples are normally dissolved in a large excess of a volatile solvent that usually exits the column before the sample. If not vented prior to entering the reactor, carbonized solvent will build up on the surface of the reaction tube destroying its catalytic action. To prevent this from occurring, the solvent should be vented prior to entering the detector. The vent is shown in the following figure. If desired, the flow can be measured by attaching a flowmeter to the vent.
Figure 4-23. Location of the solenoid vent.

In the following procedure you set the initial Valve 4 setting to ON. You then enter a timed event to turn the valve off during the run.

1. In the ElCD tabbed screen touch the Events tab and touch the Add Event button. The following screen will appear.
2. Using the plus minus buttons put into the **Time** field a number greater than the solvent retention time, for example, **1.00**.

3. Using the plus minus buttons put a number into the **Value** field **1.00**.

4. Touch **OK** when you have entered the proper parameters for your analysis. You will now return to the Events tab and touch the **Add Valve** button.

5. In the valve screen touch **Valve 4** to select.

**NOTE:** *Run the detector for about 24 hours to stabilize the system to obtain optimum results.*
Setting Up the Detectors

Figure 4-24. Signal vs. Time.

**PID/EICD Series Overview**

**NOTE:** The optimum operating temperature for a photoionization detector is 250 °C. PIDs connected in series to other detectors may be operated at 350 °C for short periods of time with a loss in lamp life.

A PID and EICD may be set up in series so that the effluent from the PID (a nondestructive detector) enters the EICD. This arrangement is particularly useful for analyzing environmental samples. For example, with a single sample injection the PID can be used for the analysis of aromatic compounds followed immediately by the determination of halogenated compounds with the EICD.

A PID and EICD connected in series is shown in the following figure.
Figure 4-25. PID/ElCD connected in series.

The effluent from the PID is transferred into the ElCD via a series line connected inside the Clarus GC oven. This connection should have been made at the time of installation. Please refer to the *Clarus 500/580 GC Installation Guide*.

**Setting Up a PID/ElCD in Series**

To set up a PID and an ElCD in series, perform the following steps:

1. Install a column using the appropriate procedures in the *Clarus 500/580 GC Hardware Guide* in either Chapter 5 (Installing a Packed Column) or Chapter 6 (Installing a Capillary Column).

2. Set up carrier gas and make-up gas (where applicable) in accordance with the appropriate column installation procedures.

3. Set up the PID (see section earlier in this chapter).

4. Set up the ElCD (see section earlier in this chapter).
Setting Up a NPD

**WARNING**

To avoid injury, Do Not turn on the hydrogen gas unless a column is connected to the NPD and all fitting connections have been leak tested.

Nitrogen Phosphorus Detectors (NPD) use hydrogen gas. Before you turn on the hydrogen gas to the NPD, ensure that a column is connected to the NPD fitting inside the oven. Turning on the hydrogen gas without first connecting a column to the NPD could create the possibility of an explosion in the oven.

**WARNING**

Turn off the hydrogen gas before disconnecting a column from the NPD.

When two NPDs are installed, but only one NPD has a column connected to it, plug the inlet of the NPD without a column with a 1/8-inch stainless steel plug (P/N N9300061) to prevent hydrogen from back-diffusing into the oven.

Since in the manual pneumatics version, the hydrogen pressure regulator and the air needle valve have been turned off prior to shipment, first set the hydrogen and air inlet pressures to 30 psig. Then measure and set the gas flows as described in this chapter.

**NOTE:** The detector gas modules have been set to OFF at the factory for both manual and PPC pneumatics.

**NPD Overview**

The nitrogen phosphorus detector (NPD) is a highly specific thermionic detector for organically bound nitrogen and phosphorus.

**NOTE:** When using capillary columns with the NPD, Hydrogen is NOT a recommended carrier gas. The additive effect of the hydrogen carrier gas and the hydrogen detector gas affects the sensitivity and selectivity because it produces an overall...
higher hydrogen gas flow. If you are temperature programming, column flow changes may produce a negative baseline drift.

The detector operates by electrically heating a glass bead, that contains an alkali metal, to the point where it emits electrons. A mixture of hydrogen gas and air flows around the bead to produce a hydrogen plasma. Stable intermediates are formed in the hydrogen plasma which then capture the electrons emitted from the bead to produce ions. A polarizing field directs these ions to the collector electrode, thereby creating a current which is amplified. Sensitivity is affected primarily by the air flow, and selectivity is affected primarily by the hydrogen flow.

A cross-sectional view of a NPD is shown in the following figure.

NOTE: **CHLORINATED SOLVENTS MUST NOT BE USED WITH THIS DETECTOR.** The life and performance of the alkali bead will be severely impaired by contact with chlorinated compounds. In general, any halogenated compounds will degrade bead performance; therefore, avoid using stationary phases containing these compounds whenever possible. The use of solvents such as water, methanol or ethanol will also reduce bead performance and life. Although these solvents may still be used, they should be avoided whenever possible.

![Figure 4-26. Nitrogen Phosphorus Detector (NPD).](image)


Setting Up a PPC NPD

To set up a NPD using PPC modules, set the hydrogen and air flow as described below, then condition the bead.

Set the Hydrogen Flow and Air Flow for PPC

The pneumatics consist of PPC modules where the plasma gases are adjusted and set from the Clarus GC keyboard.

The PPC modules are calibrated at the factory; therefore, to set the flows for an analysis, simply follow this procedure.

1. Turn on the hydrogen at the tank and adjust the line pressure to 60 - 90 psig.
2. Turn on the air at the source and adjust the pressure to 70 - 90 psig.
3. In the System Status Screen touch the NPD icon. The following screen appears.

![Screen capture of Aliphatics System Status Screen with settings: 80°C temp, 16° Attenuation, 20° Range, 450 Air, 45 H2, 1.09 mV Heater, 200 mS Filter, 2:17 min Running, with Tools button available.}
4. To set the make-up and reference gases touch the **Tools** button in NPD tab screen and touch **Configuration** from the drop down menu. This will bring you to the NPD Configuration screen page.

![NPD Configuration Screen](image)

5. In the NPD Configuration screen set the make-up gas and reference gas line pressures to 60 - 90 psig by using the plus minus buttons.

6. Set the filter to 200. When all the settings are appropriate for your analysis touch **OK**. The NPD tab screen will be now visible and the changes you made in the configuration screen will be shown.
The default setting for the filter is 200 milliseconds. If you want to improve the signal-to-noise, change the setting to 800 milliseconds; however, the noise improves but the peak shapes broaden. If you want a faster detector response, change the setting to 50 milliseconds; however, the noise level may increase.
Setting Up a Manual Pneumatics NPD

To set up the manual pneumatics version of the NPD, follow the steps outlined in the NPD Setup Summary, then condition the NPD bead.

The gas flow is controlled by a needle valve and on/off regulator on the pneumatics control panel. The needle valve controls the amount of air and the on/off regulator controls the hydrogen flow.

**NOTE:** Do not overtighten the inner flow adjustment screw in the needle valve or the on/off regulator. Overtightening damages the mechanical device.

Each pneumatic control consists of an outer knob (which is used to turn the hydrogen or air completely on or off), a cap, and an inner gas flow adjustment screw.
Removing the cap exposes the adjustment screw, which is used to control the gas flow. To set the air, use a small thin screwdriver to turn the needle valve adjusting screw counterclockwise to increase the flow and clockwise to decrease the flow. To set the hydrogen, use a hex wrench to turn the adjustment screw clockwise to increase the flow and counterclockwise to decrease the flow. The on/off regulator has an internal restrictor to allow low flows (3 mL/min or less) with an inlet of 30 psig. Turn the on/off regulator knob clockwise to increase the flow and counterclockwise to decrease the flow.

**NPD Setup Summary**

To set up an NPD:

- Disconnect the hydrogen and air lines at the NPD bulkhead.
- Adjust the hydrogen flow.
- Adjust the air flow.
- Reconnect the hydrogen and air lines.

**Disconnect the Hydrogen and Air Lines at the NPD Bulkhead**

1. Open the detector cover.
Figure 4-28. Location of the detector cover.

This exposes the NPD bulkhead fittings shown in the following figure.
Setting Up the Detectors

Figure 4-29. The NPD bulkhead fittings.

NOTE: The hydrogen line is marked with a red sticker. The air line is unmarked.

2. Disconnect the hydrogen line by loosening the nut that connects the hydrogen line to the bulkhead fitting with a 7/16-inch wrench.

Adjust the Hydrogen Flow

NOTE: For safety reasons, the hydrogen pressure regulator is set in the off position (turned completely clockwise) before it is shipped from the factory.

1. Turn on the hydrogen gas at the tank and adjust the line pressure to 30 psig.

2. Connect the tubing from a flow meter to the end of the hydrogen line at the NPD. It is marked with a red sticker.
3. Turn the hydrogen pressure regulator outer knob fully counterclockwise to open it.

**NOTE:** *The outer knob is the on/off knob and it must be turned fully on for complete flow. In the case of the pressure regulator, if this knob is only partially opened, the flow will be less than the setting made when the knob was fully opened.*

4. To expose the adjustment screw, remove the protective cap from the hydrogen pressure regulator.

5. Insert the hex wrench in the adjustment screw and turn it clockwise to increase the flow.

6. From the System Status window touch **Tools**. From the Tools drop down menu touch **Utilities**.

7. In the Utilities screen touch **Stopwatch** icon.

8. Measure the flow rate. For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.
9. Repeatedly adjust the hydrogen flow and measure the flow until you obtain a flow rate of about 1.5 and 2 mL/min not including the flow of carrier gas. Replace the protective cap on the hydrogen pressure regulator.

10. Disconnect the flowmeter before proceeding to the next step.

**Adjust the Air Flow**

**NOTE:** For safety reasons, the hydrogen pressure regulator is set in the off position (turned completely clockwise) before it is shipped from the factory.

1. Turn on the air at the source and adjust the line pressure to 30 psig.

2. Connect the flowmeter to the end of the air line that is near the NPD.

3. Start the air flowing by turning the outer ring of the air control valve fully counterclockwise (see Figure 4-27).

4. Remove the protective cap from the air control valve.

The stopwatch screen should still be displayed.
5. Measure the flow rate.

For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.

6. Adjust the air flow by turning the needle valve with the screwdriver.

Continue to measure and adjust the air flow until you obtain a flow rate of about $100 \pm 5$ mL/min.

**Reconnect the Air and Hydrogen Lines**

1. Disconnect the flowmeter and reconnect the air line to the detector bulkhead.

Make sure the air line is connected to the unmarked bulkhead fitting.

2. Connect the hydrogen line (red sticker) to the detector bulkhead.

Make sure the hydrogen line is connected to the bulkhead fitting marked with a red sticker.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>When reconnecting the air and hydrogen lines to the bulkhead, insert the tubing into the bulkhead fitting until it bottoms. Then pull the tubing back slightly and tighten the nut to make a leak-free connection. <strong>Do not overtighten the nut!</strong></td>
</tr>
</tbody>
</table>

**NOTE:** Any time the line pressure is changed from 30 psig, you must re-measure and adjust the air flows.

**NOTE:** The flows listed in the above procedures for hydrogen and air are optimum for both capillary and packed column flow rates. The optimum flow provides the best sensitivity (signal to noise), selectivity, and bead life. Any changes to these flows will affect all of these parameters. Also when using capillary columns, makeup gas is not required.
NPD Bead Activation Procedure

**Packed Column Setup:**
Disconnect column and cap the oven end of the detector. The recommended Detector Cap Nut is in the 1/8-in. Plug Kit (P/N N9300061).

**Capillary Column Setup:**
With a capillary column connected, adjust Carrier flow to 0.5 mL/min or less (but not 0 ), or (preferred) disconnect the column and cap the oven end of the detector.

**Reactivating a Used NPD Bead**

**Preparing to Activate the NPD Bead**

To activate a NPD bead:

**NOTE:** Never activate a NPD bead with a column connected to the detector fitting. To properly activate the NPD bead, the column must be removed from the detector fitting and the detector fitting must be capped.

1. Obtain a stopwatch or use the stopwatch function in the GC Utilities screen.
2. Open the oven door and allow the oven to cool.
3. Using a 7/16-inch wrench, loosen and remove the column nut from the detector fitting. Remove the column from the detector fitting.
4. Install a 1/8-inch Swagelok plug (P/N N9300061) on the detector fitting. Provide a leak-free seal by tightening the plug with a 7/16-inch wrench.
5. Close the oven door. Maintain a carrier gas flow through the column.
6. Install the bead in the conventional manner according to the installation procedure in the GC Hardware Guide. Make sure that the bead does not contact any other surfaces.
7. Set the following conditions in the following order:
- Set the Detector temperature to 150 deg. C. or greater. Wait for the detector temperature to stabilize.

**WARNING:** If a capillary column is used and is not disconnected from the detector, a high detector temperature can cause bleed at the detector junction with the column. Make certain the detector temperature is lower than the maximum temperature recommended for the capillary column of your application.

- Set the hydrogen and air flow as follows:
  - Air to 100 mL/min
  - Hydrogen to 2.0 mL/min

**NOTE:** Hydrogen flow accuracy is critical to proper NPD bead activation. Make certain that the H2 flow is within 0.5 mL/min, or closer, to the H2 set point of 2.0 mL/min. Check with a calibrated flow meter at the detector bulkhead that the flow is accurate if activation problems occur.

**NOTE:** Ensure that the hydrogen line is well purged of entrained air before you make the final setting of hydrogen flow. Failure to purge the gas line from the hydrogen supply (tank or generator) will result in an incorrect flow setting for operation and can lead to poor operating performance and reduce bead life.

3. Set the detector range to x1.

4. From the system status screen touch the signal icon to display the detector background.

   When the bead is off, the background value should be 0 ±0.25 mV. Write down the background value that occurs with the bead off.

5. Open the detector cover (see Figure 4-28) and locate the bead potentiometer dial see (the following figure).

   If the NPD is detector 1 (front position), the potentiometer is located on the left side of the panel. If the NPD is detector 2 (rear position) the potentiometer is located on the right side of the panel.
Figure 4-30. Location of the Potentiometer Dial.
**Activating the NPD Bead**

The bead requires an activation step prior to use. **Do not inject a sample during Activation.**

To Activate the bead, carefully follow this procedure in sequential steps below:

1. Turn the bead potentiometer dial clockwise to apply current to the bead.
2. Slowly increase the NPD control voltage potentiometer to a setting of 700.

**Note:** The bead will gradually acquire an orange glow at this point.

3. Wait for 5 minutes then increase the potentiometer to 750.
4. After 1 minute move the potentiometer to 800.
5. After 1 minute move the potentiometer to 850.
6. After 1 minute move the potentiometer to 900.
7. After 1 minute reduce the potentiometer to 850.
8. After 1 minute reduce the potentiometer to 800.
9. After 1 minute reduce the potentiometer to 750.
10. After 1 minute reduce the potentiometer down to 700

11. **For Capillary columns:** Wait 10 minutes, go to the NPD detector screen, then adjust the potentiometer so that the NPD baseline response reads around 0.5 mV on Range 1. Then set the desired column flow for the application to be run.

12. Allow the baseline to stabilize for 30 minutes.

13. Using the potentiometer, adjust the baseline between 0.4 and 0.6 mV at Range 1 and the bead ready to use.

14. After conditioning the bead remove the Swagelok plug from the detector fitting and reconnect the column.
15. Make sure the column flow is properly set. Touch the signal icon to display the detector background produced by carrier gas flow. The bead background will be less due to cooling effects.

16. Turn the bead potentiometer dial clockwise until you achieve a reading of 0.25 mV above the "off" reading with the detector range set to x1.

17. Once the system has stabilized, it is ready for operation.

If you are unable to achieve adequate sensitivity for your standard, increase the background of the NPD. Increasing intervals of 0.25 mV are recommended.

Adjust the background setting to achieve the sensitivity required for your samples. For example, if you have a concentrated sample, such as drugs, it can be analyzed with a background of 0.25 – 0.50 mV. If you have a low-level sample, such as pesticides, it may require a setting as high as 1 – 2 mV. To get the maximum life from your NPD bead, operate at the lowest setting to achieve your required sensitivity.
NOTE: (1) The bead will be stable after operating for several hours, but it will drift in time. At the start of each day, adjust the background reading to the setting you are using and allow a few minutes for it to stabilize.

(2) Due to the loss of alkali metal with use, the nature of the bead is to drift over time. We strongly recommend using an internal standard for quantitative analysis.

(3) The bead can operate at higher background settings. The higher the setting, the greater the signal and noise. Therefore, the signal to noise ratio will not increase dramatically. Operate at the lowest possible setting to achieve the required sensitivity; this will also prolong the life of the bead.

NOTE: The bead should be turned off by turning the bead potentiometer dial fully counterclockwise before you turn off the Clarus GC. Remember that the bead has a finite life. You can extend the bead life by turning the bead off when it is not in use for long periods of time (for example, over the weekend).

**Reactivate a Used NPD Bead**

To increase the bead life, turn off the bead if the NPD is not continually in use. When you turn off the bead, keep the detector temperature, hydrogen flow, and air flow set to operating conditions. If the column remains connected to the injector and detector in the oven, make sure the carrier gas is flowing through the column. If the column is disconnected from the detector, make sure the Swagelok cap is installed on the NPD fitting.

Prior to using the NPD, adjust the bead background to the same millivolt setting that you were using. Run your standards to determine if the NPD bead is responding at a level of sensitivity equal to the previous run. If not, then reactivate the NPD bead.

To reactivate a NPD bead follow the activation procedure above.

**Operating Notes**

The bead is operated as a conventional NPD bead; following these instructions will increase the bead lifetime.

**Baseline:** Set the baseline to a level of between 0.4 – 0.5. A lower baseline will help to extend bead lifetime. Studies have shown that the signal-to-noise will not be adversely affected by the lower baseline.
Setting Up the Detectors

**Column bleed:** Material from the column can effect bead lifetime. Keep the maximum oven temperature as low as possible for each application.

**Between run operation:** If the NPD bead is not in use for a few days it is best to simply lower the potentiometer setting to 600 and maintain the detector temperature at 200 deg. C. or greater. If the NPD detector will not be in use for an extended period, simply turn the potentiometer to zero. To reuse the bead follow the activation procedure.

**Loss in sensitivity** – the NPD bead is a consumable and will experience a loss in sensitivity over time. Often, adequate sensitivity can be restored by repeating the activation process.
Setting up a FPD

**WARNING**

Flame Photometric Detectors (FPD) use hydrogen as fuel. If the hydrogen is turned on without a column attached to the detector fittings inside the oven, hydrogen could diffuse into the oven creating the possibility of an explosion. To avoid possible injury, DO NOT TURN ON THE HYDROGEN unless a column is attached to the detector fittings inside the oven and all fittings have been leak tested.

Before disconnecting a column, make certain that the HYDROGEN HAS BEEN TURNED OFF.

If two FPDs are installed and only one FPD has a column connected to it, make certain that you plug the unused detector inlet fitting with a 1/8-inch stainless steel plug (P/N N9300061).

**NOTE:** To prevent potential damage to the FPD in the manual pneumatics version, the hydrogen needle valve has been factory-set to a very low setting. Set both the hydrogen and air inlet pressures to 30 psig, then measure and set the flows as stated in this chapter.

**NOTE:** The detector gas modules have been set to OFF at the factory for both manual and PPC pneumatics.

**FPD Overview**

In the Flame Photometric Detector (FPD), the column effluent is mixed with hydrogen and then burned in air. Light emitted from the flame passes through a lens, a filter, and to a photomultiplier tube, which generates an electrical signal.

The Flame Photometric Detector is used for detecting sulfur, phosphorus, or tin compounds, which produce chemiluminescent reactions with emissions at wavelengths characteristic of the $\text{S}_2$, Sn, and HPO species.

A filter that isolates sulfur emissions (P/N N6000637) is supplied with the detector. A filter that isolates phosphorus emissions (P/N N6000981) and a filter
Setting Up the Detectors

that isolates tin emissions (P/N L4145472) are available from www.perkinelmer.com.

A cross section view of an FPD is shown below.

![Flame Photometric Detector (FPD)](image)

Figure 4-31. Flame Photometric Detector (FPD).
Setting Up a PPC FPD

To set up a FPD using PPC modules, follow the steps below.

FPD Setup Summary

To set up a FPD:
- Configure the linearizer and signal filter.
- Set the FPD temperature.
- Set the hydrogen flow and air flow for PPC
- Turn on the photomultiplier tube.
- Ignite the flame

Configure the Linearizer and Signal Filter

The signal for sulfur is a function of the square of the sample quantity injected. That is, if twice as much sample is injected, the response is quadrupled. When the linearizer is turned on, the software calculates the square root of the signal and sends that value to the integrator or recorder.

NOTE: If Linearization is set to "ON," the Autozero function must be checked off on the FPD tab screen.

NOTE: If Linearization is set to "ON," set the Clarus GC integrator attenuation to x64. If Linearization is set to "OFF," set the Clarus GC integrator attenuation to x8.

1. From the System Status screen touch the FPD icon.
2. The FPD tab page is now visible.
3. For Linearizer the default value is "Off." To change the value to “ON” touch the Tools button in FPD tab screen and touch Configuration from the drop down menu. This will bring you to the FPD Configuration screen page.
4. In this screen touch the Linearizer field and touch “On” from the drop down menu.

5. Set the filter to 200. When all the settings are appropriate for your analysis touch **OK**. The FPD tab screen will be now visible and the changes you made in the configuration screen will be shown.

The default setting is 200 msec. If you want to improve the signal-to-noise, change the setting to 800 msec. Then run your standard and observe that the signal remains the same and the noise improves.

**Set the FPD Temperature**

**NOTE:** When using the FPD with Turbochrom Version 3.1 or earlier, OMEGA, or the Model 1020/1022 (software Version 7.10 for the SX or Version 6.5 for GC Plus), the FPD temperature values must be entered between 250 °C and 450 °C only. Do not enter any value less than 250 °C.

1. From the system status screen touch the **FPD** icon.

2. The FPD tab page is now visible.
NOTE: For proper ignition to occur, the FPD must be heated to at least 250 °C.

3. Use the plus minus buttons to enter a setpoint of at least 250 °C (this is the minimum entry for a FPD) in the temp field, or enter a temperature that is 50 °C higher than the highest temperature of your oven program.

Set the Hydrogen Flow and Air Flow for PPC

The PPC pneumatics consists of PPC modules where the hydrogen and air gases are set from the Clarus GC touch screen.

The PPC modules are calibrated at the factory, therefore to set the flows for an analysis, simply follow this procedure.

1. Turn on the air at the source and adjust the pressure to 70 - 90 psig.
2. Turn on the hydrogen at the source and adjust the pressure to 60 - 90 psig.
3. From the System Status screen touch the FPD icon.
4. The FPD tab page is now visible.
5. To change the gas flow values touch the **Tools** button in FPD tab screen and touch **Configuration** from the drop down menu. This will bring you to the FPD Configuration screen page.
6. Touch the **Hydrogen** field and use the plus minus buttons to change the value to 75 (to 75 mL/min). Touch **OK** when completed.

7. Touch the **Air** field and use the plus minus buttons to change the value to 90 mL/min. Touch **OK** when completed.

8. To change the filter value touch the **Filter** field and use the arrow buttons to get the value appropriate for your analysis. Touch **OK** when completed.

The default setting is 200 milliseconds. If you want to improve the signal-to-noise, change the setting to 800 milliseconds; however, the noise improves but the peak shapes broaden. If you want a faster detector response, change the setting to 50 milliseconds; however, the noise level may increase.

**Turn On the Photomultiplier Tube**

1. From the System Status screen touch the FPD icon.

2. The FPD tab page is now visible.
3. To turn on the photomultiplier tube touch the Tools button in FPD tab screen and touch Configuration from the drop down menu. This will bring you to the Configuration screen page.

4. On this page touch the FPD icon to get to the FPD Configuration page.
5. In the PMT Voltage field set the percentage (see note below) by using the plus minus buttons. This will turn on the photomultiplier tube.

**NOTE:** *The voltage to the photomultiplier tube has been set in the factory to approximately 70%. You can change this setting from the Clarus GC touch screen. You may want to change this setting as the photomultiplier tube ages and the signal diminishes. The signal-to-noise ratio may vary with each photomultiplier tube; therefore, increasing the voltage may not increase the signal-to-noise ratio. After installing a replacement photomultiplier tube, the noise should be about 2% when the Clarus GC integrator output is set to attenuation 8 (x8) and the linearizer off. See the Clarus GC Hardware Guide “Maintenance” chapter, for this procedure.*

**NOTE:** *The photomultiplier tube can be damaged if it is exposed to light while voltage is ON. Never remove the detector cap or Photomultiplier tube WITH the voltage on.*

**Ignite the Flame**

1. Open the electronics cover to access the ignitor assembly.
2. From the system status screen touch the **FPD** icon.

3. The FPD tab page is now visible.

**NOTE:** For proper ignition to occur, the FPD must be heated to at least 250 °C.

4. Use the plus minus buttons to enter a setpoint of at least 100 °C (this is the minimum entry for a FPD) in the temp field, or enter a temperature that is 50 °C higher than the highest temperature of your oven program.

5. Close the oven door. Wait for the FPD 1 temperature to become READY.

6. Position the ignitor assembly on the FPD outlet (see the following figure).
7. You may hear a slight "POP." This indicates that the flame is lit.

**NOTE:** If you find it difficult to light the flame, rotate the FPD cap so that the FPD outlet faces the front or left side of the instrument.

![Ignitor assembly positioned on the FPD outlet.](Figure 4-33)

8. Remove the ignitor assembly from the FPD outlet.

   If the flame is lit, the signal on the Autozero screen should increase and remain greater than the noted amount.

   Confirm that the flame is lit by holding a shiny object (such as a mirror or small wrench) over the FPD outlet. Condensation will appear on the object if ignition has occurred.
WARNING

The FPD outlet is hot!  To prevent injury, never place your hand over the FPD outlet.

NOTE:  To prevent condensation on the FPD, always turn off the flame (hydrogen and air gases) before cooling the detector or turning off the Clarus GC.

**Setting Up a Manual Pneumatics FPD**

To set up a manual pneumatics version of the FPD, perform the following steps:

**FPD Setup Summary**

- Configure the linearizer and signal filter.
- Set the FPD temperature.
- Attach a flowmeter to the FPD outlet.
- Adjust the hydrogen flow.
- Adjust the air flow.
- Turn on the photomultiplier tube.
- Ignite the flame.

**Configure the Linearizer and Signal Filter**

The signal for sulfur is a function of the square of the sample quantity injected. That is, if twice as much sample is injected, the response is quadrupled. When the linearizer is turned on, the software calculates the square root of the signal and sends that value to the integrator or recorder.

NOTE: If Linearization is set to "ON," the Autozero function must be set checked off in the FPD tab screen.
NOTE: If Linearization is set to "ON," set the Clarus GC integrator attenuation to x64. If Linearization is set to "OFF," set the Clarus GC integrator attenuation to x8.

1. From the System Status screen touch the FPD icon.

2. The FPD tab page is now visible.

3. For Linearizer the default value is "Off." To change the value to “ON” touch the Tools button in FPD tab screen and touch Configuration from
the drop down menu. This will bring you to the FPD Configuration screen page.

4. In this screen touch the Linearizer field and touch “On” from the drop down menu.

5. Set the filter to 200. When all the settings are appropriate for your analysis touch OK. The FPD tab screen will now be visible and the changes you made in the configuration screen will be shown.

   The default setting is 200 msec. If you want to improve the signal-to-noise, change the setting to 800 msec. Then run your standard and observe that the signal remains the same and the noise improves.

   If you using a capillary column and have early eluting peaks, 800 msec may be too slow, thereby producing a smaller response to your peak of interest. Before using this setting, test it with your standard.

**Set the FPD Temperature**

**NOTE:** When using the FPD with Turbochrom Version 3.1 or earlier, OMEGA, or the Model 1020/1022 (software Version 7.10 for the SX or Version 6.5 for GC Plus), the FPD temperature values must be entered between 250 °C and 450 °C only. Do not enter any value less than 250 °C.

1. From the system status screen touch the FPD icon.

2. The FPD tab page is now visible.
NOTE: For proper ignition to occur, the FPD must be heated to at least 250 °C.

4. Use the plus minus buttons to enter a setpoint of at least 250 °C (this is the minimum entry for a FPD) in the temp field, or enter a temperature that is 50 °C higher than the highest temperature of your oven program.

Attach a Flowmeter to the FPD

1. Open the detector cover.
Figure 4-34. Detector cover.

This exposes the detectors. The following figure shows a top view of FPD outlet.

2. Attach the tubing from the flowmeter to the FPD outlet.
Adjust the Hydrogen Flow

Combustion gases are controlled by an on/off regulator and needle valve that are located on the pneumatics control panel. The on/off regulator controls the air flow and the needle valve controls the hydrogen flow.

**NOTE:** Do not overtighten the inner flow adjustment screw in the needle valve or the on/off regulator. Overtightening damages the mechanical device.
Each pneumatic control consists of an outer knob (which is used to turn the hydrogen or air completely on or off), a cap, and an inner gas flow adjustment screw.

Removing the cap exposes the adjustment screw, which is used to control the gas flow. To set the air, use a hex wrench to turn the adjustment screw clockwise to increase the flow and counterclockwise to decrease the flow. To set the hydrogen, use a small thin screwdriver to turn the needle valve adjustment screw counterclockwise to increase the flow, and clockwise to decrease the flow.

To adjust the hydrogen flow:

1. **Turn the air off at the source.**

2. Turn on the hydrogen at the tank. Adjust the hydrogen line pressure to 30 psig.

3. Start the hydrogen flowing by turning the outer ring of the hydrogen control valve fully counterclockwise.
4. Remove the cap from the hydrogen control valve. This exposes the needle valve.

5. Turn the needle valve counterclockwise a few turns.

**NOTE:** For safety reasons, the hydrogen needle valve is set to OFF flow before it is shipped from the factory.

6. From the System Status window touch **Tools**. From the Tools drop down menu touch **Utilities**.

![Utility Screen]

7. In the Utilities screen touch **Stopwatch** icon.

8. Measure the flow rate. For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.
9. Obtain a low rate of about 75 mL/min by repeatedly adjusting the hydrogen flow with the needle valve and measuring the flow.

**NOTE:** Both the carrier gas and combustion gases exit through the FPD. For satisfactory operation of the FPD, a flow rate of 75 mL/min of hydrogen is required. If a column is attached to the FPD, and the carrier gas is flowing, the carrier gas flow rate should be added to the required hydrogen flow. For example, if the carrier gas flow is 30 mL/min, adjust the hydrogen flow until the measured total flow rate (combined carrier gas and hydrogen) is 105 mL/min.

10. Turn off the hydrogen flow by turning the outer ring of the hydrogen control valve completely clockwise.

11. Replace the cap on the hydrogen control valve.

**NOTE:** If at any time the line pressure is changed from 30 psig, you must remeasure and adjust the hydrogen and air flows.
Setting Up the Detectors

Adjust the Air Flow

NOTE: The air flow is critical. If the air flow is adjusted too low, the detector will have poor (diminished) or no response.

1. Turn on the air at the source. Adjust the air line pressure to 30 psig.
2. Verify that the flowmeter is still attached to the FPD outlet.
3. Start the air flowing by turning the outer knob fully counterclockwise.

NOTE: The outer knob is the on/off knob. It must be turned fully on for complete flow. In the case of the pressure regulator, if this knob is only partially opened, the flow will be less than the setting made when the knob was fully opened.

4. To expose the adjustment screw, remove the protective cap from the pressure regulator.
5. Insert the hex wrench in the adjustment screw and turn it clockwise to increase the flow.

NOTE: For safety reasons, the air pressure regulator is set to OFF before it is shipped from the factory.

6. From the System Status window touch Tools. From the Tools drop down menu touch Utilities.
7. In the Utilities screen touch **Stopwatch** icon.

8. Measure the flow rate. For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.
6. Measure the flow rate.

For best accuracy, use a soap bubble flowmeter volume that gives a reading of at least 30 seconds.

7. Obtain a flow rate of about 90 mL/min by repeatedly adjusting the air flow with the pressure regulator and measuring the flow.

**NOTE:** Both the carrier gas and combustion gases (air and hydrogen) exit through the FPD. For satisfactory operation of the FPD, a flow rate of 90 mL/min of air is required. If a column is attached to the FPD, and the carrier gas is flowing, the carrier gas flow rate should be added to the required air flow. For example, if the carrier gas flow is 30 mL/min, adjust the air flow until the measured total flow rate (combined carrier gas and air) is about 120 mL/min.

8. Remove the flowmeter.

9. Touch **OK** once the proper air flow has been achieved.
**Turn On the Photomultiplier Tube**

1. From the System Status screen touch the FPD icon.

2. The FPD tab page is now visible.

3. To turn on the photomultiplier tube touch the **Tools** button in FPD tab screen and touch **Configuration** from the drop down menu. This will bring you to the FPD Configuration screen page.
4. In the PMT Voltage field set the percentage (see note below) by using the plus minus buttons. This will turn on the photomultiplier tube.

**NOTE:** The voltage to the photomultiplier tube has been set in the factory to approximately 70%. You can change this setting from the Clarus GC touchscreen. You may want to change this setting as the photomultiplier tube ages and the signal diminishes. The signal-to-noise ratio may vary with each photomultiplier tube; therefore, increasing the voltage may not increase the signal-to-noise ratio.

After installing a replacement photomultiplier tube, the noise should be about 2% when the Clarus GC integrator output is set to attenuation 8 (x8) and the linearizer off. See the *Clarus 500/580 GC Hardware Guide* "Maintenance" chapter, for this procedure.

**NOTE:** The photomultiplier tube can be damaged if exposed to light while voltage is ON. Never remove the detector cap or Photomultiplier tube WITH the voltage on.
**Ignite the Flame**

1. Open the electronics cover to access the ignitor assembly.

![Ignitor assembly](image)

**Figure 4-37. Ignitor assembly.**

2. From the system status screen touch the **FPD** icon.

3. The FPD tab page is now visible.

![Method 5](image)

**NOTE:** *For proper ignition to occur, the FPD must be heated to at least 250 °C.*
Setting Up the Detectors

4. Use the plus minus buttons to enter a setpoint of at least 250 °C (this is the minimum entry for a FPD) in the temp field.

NOTE: If you find it difficult to light the flame, rotate the FPD cap so that the FPD outlet faces the front or left side of the instrument.

5. Verify that the Autozero field is checked off. If it is not, just touch the field to check it off.

6. Turn on the hydrogen by turning the outer knob of the hydrogen control valve fully counterclockwise.

7. Turn on the air by turning the outer knob of the pressure regulator fully counterclockwise.

NOTE: The outer knob is the on/off knob. It must be turned completely on for complete flow. In the case of the pressure regulator, if this knob is only partially opened, the flow will be less than the setting made when the knob was fully opened.

8. Position the hole in the side of the metal part of the ignitor against the FPD outlet on the cap. Hold the ignitor firmly against the FPD outlet to make the proper contact. Proper contact is made when the end of the ignitor glows and ignites the flame, thereby producing a "POP."

NOTE: If you find it difficult to light the flame, rotate the FPD cap so that the FPD outlet faces the front or left side of the instrument.

9. Remove the ignitor assembly from the FPD outlet.

Confirm that the flame is lit by holding a shiny object (such as a mirror or small wrench) over the FPD outlet. Condensation will appear on the object if ignition has occurred. Also, the signal on the Auto Zero display may increase momentarily when the flame first lights, but it will remain basically the same once the flame is lit.
The FPD outlet is HOT! To prevent injury, do not place your hand over the FPD outlet on the cap.

Figure 4-38. Ignitor assembly positioned on the FPD outlet.
**Detector temperatures**

To display or change detector temperatures and turn the detector heaters on or off can all be done from one screen in the Clarus GC. The example shown below assumes that the Clarus 500GC has an ECD detector.

1. In the System Status screen touch the **ECD** icon.

2. In the ECD Tab you will see the Make Up field to change the setting touch **Tools** and touch **Configuration** from the drop down menu.
3. In the ECD tab page touch the temp field and use the plus minus buttons to add an ECD temperature appropriate for the analysis to be run.

4. To turn the heater on or off just touch the Heater button. The message on the button will toggle to either on or off and will be visible on the screen.
Setting Up the Detectors

Setting the Range

Setting the FID, PID, or NPD Range

The *initial* FID, PID, or NPD range is set from the FID, PID, or NPD Range screen.

The example below uses FID but the following procedure can also be used for PID or NPD.

1. From the System Status screen touch the FID button this will bring you to the FID tab screen page.

2. To change the range touch the Range field Use the drop down menu to select a range for the detector. FID, PID, and NPD range options are 1 or 20, where 1 is the most sensitive setting and 20 is 20 times less sensitive.

The value that you enter will always be used unless you change it in the Event tab page. For certain analyses such as those for trace or concentrated components, you may wish to change the Range during a GC run. The following example illustrates this.
Changing the FID, PID, or NPD Range During a Run

To automatically change the range from 1 to 20 after 2 minutes into the run. The example below uses FID but the following procedure can also be used for PID or NPD.

1. Touch the Event tab to change a range during a run

2. Touch the insert button to show the following screen.
3. In the Timed Events screen enter a time by touching the **Time** field and using the plus minus buttons to enter the time required for your analysis. This will change the time for Range 1 as shown in the Event field. When completed touch **OK** to close the screen.

4. If you need to change the Event, touch the down arrow in the Event field to view the other ranges. Select the one you need by touching it.

5. When a run is started, the system uses the initial range of 1 for 2 minutes, then switches to a range of 20 for the duration of the run. When the run is completed, the system switches back to the initial value of 1. When completed touch **OK** to close the screen.
Setting the TCD Current (Filament Current)

**CAUTION**

When the detector is not in use the temperature and current must be off.

1. From the System Status screen touch the TCD icon.

2. In the TCD tab page touch the **Current** field and use drop down menu to change the value. TCD range options are 0 (Off), 1, 2, 3, 4 (maximum sensitivity) and –1, –2, –3, or –4. A negative value reverses the polarity.
The TCD range values corresponding to bridge current are shown below:

**Table 4-3. Correlation Between Bridge Current and Range**

<table>
<thead>
<tr>
<th>Bridge Current (mA)</th>
<th>Range Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>±0</td>
</tr>
<tr>
<td>40</td>
<td>±1</td>
</tr>
<tr>
<td>80</td>
<td>±2</td>
</tr>
<tr>
<td>120</td>
<td>±3</td>
</tr>
<tr>
<td>160</td>
<td>±4</td>
</tr>
</tbody>
</table>

The initial setting is the range that is used at all times unless the polarity is changed with a timed event during a GC run.
Changing TCD Polarity During a Run

TCD Range timed events are restricted to changing TCD polarity. For example, if an initial range is four, then an event can only be entered for +4 or −4. Examples for using polarity changes are given in Clarus GC Hardware Guide, “Maintenance” chapter, Practical Hints section.

To automatically change the range from 2 to −2 after 3 minutes into the run:

1. From the System Status screen touch the TCD icon.

2. In the TCD tab page touch the Events tab. In the Events tab touch the insert button.
3. Using the plus minus buttons enter a time of three minutes into the **Time** field.

4. Using the drop down menu in the **Value** field select a value of -2.

5. When completed touch **OK** to close this screen.

When a run is started, the system uses the initial range of 2 for 3 minutes, then reverses the polarity for the duration of the run. When the run is completed, the system switches back to the initial value, in this case 2.
Routing Detector Output

The Clarus GC contains one analog data output channel for each installed detector amplifier board. You can attach an integrator or recorder to either output channel.

Normally the detector output would go to the device configured for that channel. However, if you are running complex analyses, such as those requiring detector switching, you may wish to route the signal to either channel.

Rerouting Output

Assume that:

- Detector 1 is an FID whose output is going to an integrator (in this example the integrator is output A).

- Detector 2 is a TCD whose output is going to a recorder (in this example the recorder is output).

To reroute the FID output A to the integrator:

1. From the System Status touch the icon for the FID Detector.

2. The FID tab page will appear. Touch the Events tab.
3. In the Events screen touch the **Insert** button. The Timed Events screen will appear. In the drop down menu for Events and touch Output A.

4. Touch the **time** field and use the plus minus buttons to input a time that FID’s output will go to the integrator.

5. Touch the value field and use the drop down to select a negative value (detector A is negative, detector B is positive).

6. Touch **OK** to return to the FID tab page.
7. Once in the FID tab page touch the System icon to return to the System Status screen.

8. In the System Status screen touch the TCD icon. The TCD tab page will appear. Touch the Events tab.

9. In the Events screen touch the Insert button. The Timed Events screen will appear. In the drop down menu for Events and touch Output B.

10. Touch the time field and use the plus minus buttons to input a time that TCD’s output will go to the recorder.

11. Touch the value field and use the drop down to select a positive value (detector 1 is negative, detector 2 is positive).

12. Touch OK to return to the TCD tab page.
13. Once in the TCD tab page touch the System icon to return to the System Status screen.

NOTE: Detector routing remains in effect until changed. If two detectors are installed but only one configured, then the output of the configured detector is sent to both output channels.
**Attenuating Detector Signals Going to a Recorder**

The purpose of attenuation when a recorder is attached and configured is to bring a peak on scale by amplifying a weak signal or reducing an overly strong signal. Attenuation in this case affects only the presentation of the signal.

Acceptable attenuation values are of the 2nd power, for example, 1, 2, 4, 8, 16, etc., up to a maximum of 65,536. The system rounds off values to the next highest power of 2. For example, if you go to the Attenuation field and select a 17 then an attenuation of 32 appears on the screen.

The range of attenuation values that may be used is 1 – 65,536. Raising the attenuation decreases the signal to the recorder. Lowering the attenuation amplifies the signal to the recorder.

To change an attenuation value (an FID detector is used as an example):

1. From the System Status screen touch the FID button this will bring you to the FID tab screen page.
Setting Up the Detectors

2. To change the attenuation touch the **Atten** field. Use the drop down menu to select an attenuation range for the detector that is appropriate for your analysis.

3. After this is done you may continue with another tab page or touch the **System** icon to return to the System Status screen.

A table listing attenuation vs. the maximum detector signal producing 100% deflection on a 1 mV-recorder is provided in the Clarus GC Hardware Guide, Maintenance chapter, section “Practical Hints.”
Optimizing a Detector Signal to an Integrator for Maximum Sample Dynamic Range

The Clarus GC contains improved electronics which significantly reduce amplifier noise. This allows you to amplify the detector signal without getting a large increase in the noise level. Therefore, it provides excellent minimal detection (signal to noise) for all Clarus GC detectors. Amplification is set on the detector tab page in the **Atten** field, the attenuation button, and entering an attenuation value from x1 (most signal) to x64 (least signal). The maximum signal produced by the Clarus GC amplifier is 1 V. To achieve the best sensitivity and widest dynamic range, the sample with the highest concentration must not exceed the 1-V signal.

When using a flame ionization detector (FID), if you operate at range x1 and attenuation x64, and the signal saturates (exceeds 1 V), then use range x20 and determine the appropriate attenuation value (from x64 to x1) that produces a reasonable size peak. When using a nitrogen phosphorus detector (NPD), the same will apply. When using an electron capture detector (ECD), the only range setting is x1. To ensure that the signal does not exceed 1 V, you should run your most concentrated sample at attenuation x64, then change the attenuation to produce a reasonable size peak. When using a thermal conductivity detector (TCD) the range or current setting also affects the output signal. Therefore, start at attenuation x64. As long as the signal does not exceed 1 V, you can amplify the signal by changing the attenuation.
Matching Detector Signals with Your Integrator

The following procedure should be followed if you are operating your detector near the minimal detectable quantity level. This will ensure that the integrator is not filtering the signal coming from the Clarus GC. The purpose of attenuation when an integrator is attached and configured is to assure that the GC output is above the noise level of the integrator.

Normally, attenuation for an integrator need only be performed once. To obtain the most satisfactory results, it is recommended that attenuation be carried out under actual operating conditions prior to running your first sample.

Valid attenuation values when an integrator is configured are 1, 2, 4, 8, 16, 32, and 64. The greater the attenuation, the smaller the degree of detector signal amplification. Attenuation of an integrator can be thought of as a two-step process:

1. Observe the integrator noise at an attenuation of 64:

   ![Figure 4-39. An example of integrator noise.](image1)

2. Gradually decrease the attenuation (for example, to 16 or until the noise level increases):

   ![Figure 4-40. An example of detector noise.](image2)
A table listing attenuation vs. the maximum detector signal producing a 1-V output to an integrator is provided in the Clarus GC Hardware Guide, Maintenance chapter, section “Practical Hints.”

To change an attenuation value:

1. From the System Status screen touch the FPD icon.

2. In the TCD tab page touch the Attenu field and use drop down menu to change the value.

**NOTE:** Attenuation of detector signals may be changed during a GC run with a timed event. At the end of the GC run, the initial attenuation value is automatically restored.
Setting Up the Detectors

Autozeroing a Detector

Each configured detector is equipped with digital autozeroing capability. As long as Autozero is On (checked off), the system will autozero the detector to the offset specified during configuration whenever the system becomes READY or when a run is started.

The example below uses the ECD detector but the following procedure can also all the detectors.

1. In the System Status screen touch the ECD icon.

2. In the ECD Tab you will see the AutoZero field . To turn on the AutoZero touch the field and a check mark will appear.
NOTE: When Autozero is Off, the output signal is never autozeroed.
Using the Method Editor
Using the Method Editor
Method Editor

To access the Method Editor go the System Status Screen:

From this screen press the Tools button (as shown above). When you release this button the options appear.
To access Method Editor, touch Tools menu and press the first option, **Method Editor**.

The Method Editor screens are similar to the Active Method screens. The differences are noted in this section.

You can access and edit the first five methods. The fifth method is reserved for TotalChrom and may be overwritten. If you attempt to overwrite the method, it will retain the name “External” to remind you that this is a possibility.

You cannot access the Default method. This method is used by the system to populate a method with default values when the “New Method” menu option is selected. The default settings are the same as the current (or active) method.
**Method Edit Mode**

When you touch the Method Edit Tools option, a screen similar to the status screen appears.

The icons provide access to the settings associated with the Active Method in method mode. If an Aux temperature is configured, an Aux button appears on the method edit screen.

The Method Edit screens are similar to the Active Method screens with the following differences:

- The run and signal icons on the top navigation bar are deactivated.
- No configuration information appears.
- No ignite button on the FID screen.
- No status bar or current information.
Using the Method Editor

- The Start and Tools menu button in the bottom bar are replaced with the File menu button.

The following screens show the differences between the two modes. The first screen below shows the PSS active method screen. The second screen, that follows, shows the screen in Method Edit mode.
Touching the oven icon displays the oven screen in method edit mode.
Using the Method Editor

The pop up File menu provides options to create, modify, and save methods.

The Method Name field is not active until you select an option from the File menu.
**Overwriting the Active Method**

The name of the currently active method is grayed out in the file name list that appears for Delete, Open, Activate, and Save As. If you enter the same name as the active method, the following message appears:

![Save As dialog box]

**File Menu**

The pop up File menu includes options to create, modify, store, and delete methods. The Exit Editor option closes the Method Edit screen and displays the view that appeared when the user invoked the Method Editor Tools option. During a run, the Activate menu option is grayed out since you cannot activate a different method during a run.

**New Method**

When you need to develop a new method select **New Method** from the pop up File menu.

Touching **New Method** displays the following dialog box:

![Untitled dialog box]
Using the Method Editor

If you select **Yes**, the Save As dialog box appears.

You can either assign a name to the current method and touch the **OK** button to save it, or touch **Cancel** to close the Save As dialog box. When the dialog box closes, the GC is in New Method mode and the fields are populated with default values. The Method Name field is activated and displays the name “untitled.”

After defining the values for the new method, touch the Method Name field to display the Save As dialog box. Assign a name to the new method and save the changes.

**Open Method**

Touching the Open Method option prompts the following warning box indicating that the current method is not saved.

If you touch **Yes**, the Save As.. dialog appears.

When the Open option is selected, the Open dialog appears for you to select a method.
Touch the method name and OK to populate the method edit screens with the values from the selected method.

If you choose Cancel, or touch the OK button without selecting a method, the dialog box will close and the operation will be ignored.

**Save**

The Save command saves the previously opened and optionally modified method under the same name. No dialog box appears if a name appears in the Method Name field.

If the Method Name field is empty, either from generating a New Method or from entry into the Method Editor, the “Save As” dialog box appears.
**Using the Method Editor**

**Save As..**

The Save As command saves the current method under a new or existing name. Touching this option displays the Save As dialog box.

The Name field displays the name of the current method. The list of method names always displays “External” in the last position.

If you do not change the name or select another method from the list, clicking **OK** prompts the dialog box to confirm that the existing method will be overwritten.

Clicking **Yes** overwrites the stored method with the new method with the same name. To assign a new method name, touch the name field to invoke the alpha numeric keypad:
Although a new method name field displays the name “untitled,” the field to enter the new name is blank.

The Method Name field displays each character as it is touched starting from the center of the field. The name can be comprised of any combination of letters and numbers and is limited to 13 characters. Touching OK closes the keypad and displays the Save As dialog box with the name entered in the name field. Touching Cancel closes the keypad and displays the Save As screen. The name field is not modified.

The External method is always the last entry in the list. The External method cannot be renamed but it may be overwritten. Touching OK saves the edited method under the assigned name. The name is added to the list and the Save As box closes. The new name appears in the Method Name field. If you press the OK button before entering a method name, the following error message appears:
Using the Method Editor

Pressing **Continue** returns control to the previous screen. You can select a name or cancel out of the process.

If five methods are already stored, entering a new name will prompt the following dialog box:

If you press **Yes**, the method list appears.

If you press **Yes**, the method list appears.
When you select a method and press **OK**, the Save As screen appears with the new method name in the field. You can now press **OK** to save the method in the available position.

If you press **No**, the Save As… dialog box displays the same fully populated list of methods. The new method name is still in the Name field. You can press **Cancel** to return to Method Edit mode and access the File button, or **OK** to prompt the memory full error again.

**Activate**

This command is deactivated while the system is running. When the command is available, the Activate option applies the currently edited method conditions and name to the active method. The method editor mode retains control. If the method is not named, the Save As dialog box opens for you to select a method from the list.
Using the Method Editor

Delete

Touching the delete option prompts the Delete dialog box.

![Delete dialog box](image)

Select a name from the list. The selected name appears in the Method Name field. Touch the OK button to delete the selected method and close the dialog box.

Exit Editor

The Exit Editor option closes the Method Edit screens and restores the Active Method. Touching Exit Editor invokes the following dialog box:

![Exit Editor dialog box](image)

Pressing the Yes button closes the dialog box and displays the active method screens. Pressing the No button closes the dialog box and retains the Method Editor mode.
Using the Tools Menu
Using the Tools Menu
Tools Menu

The Tools pop up Menu provides options to a number of features and settings, such as Method Editor, Configuration, Maintenance, and Utilities. To display the menu, press the Tools button:

To access the Tools Menu go the System Status Screen:

From this screen press the Tools button (as shown above). When you release this button the options appear.
Using the Tools Menu

**Method Editor**

To access Method Editor, touch **Tools** menu and press the first option, **Method Editor**. For detailed information on the Method Editor see Chapter 4, *Using the Method Editor* in this guide.
**Event Log**

To access Event Log, from the System Status screen, touch **Tools** menu and press the second option **Event Log**.
The Event Log screen includes a selector for either the Automation or current Run log. The list box displays the contents of the selected log. The logs are not editable.
**Maintenance**

To access Maintenance, from the System Status screen, touch **Tools** menu and press **Maintenance**.

The maintenance feature allows users to set up to eight task reminders. For each item, you can enter the name of the task and specifies the condition that prompts the reminder. When the criteria are met, a dialog box displays the message.

The last item accessed is automatically selected. The tasks are listed in the order they were entered. Use the scroll bar to display additional entries.

Each entry includes the name of the task and the count at which it is set to prompt a reminder message. The buttons below the list allow the user to add, edit, and delete tasks. The current count field displays the value and type of interval associated with the selected item.
Using the Tools Menu

To add an entry, touch the **New button**. The Interval Count screen includes a drop down field for users to identify the type of interval to associate with the count. Interval options are: Injections, Hours, and Days:

Selects the interval from the drop down list and then enter a value in the count field using the plus and minus buttons. Touching the text message field raises the alphanumeric keypad. Click **OK** to save the message. If a maintenance task has already been assigned to the selected number, a dialog box will ask if you want to overwrite it. When the count value equals the number assigned to the task, a dialog box displays the reminder. Touch **OK** to close the reminder.
Configuration

To access Configuration, from the System Status screen, touch Tools menu and press Configuration.

Injectors

Deconfiguring and Configuring Injectors

Occasions may arise when you may not be using one of the injectors for an extended period of time. Instead of turning off the injector heater, you may find it more convenient to "deconfigure" the unused injector. When you do this, the injector temperature screen for the deconfigured injector will not appear in the method.

Every Clarus GC purchased has been configured at the factory for the specific injector(s) that have been installed. You can check the injector configuration of your Clarus GC from the Configuration Mode.
Using the Tools Menu

If one of the detectors has been deconfigured, analog data from the remaining detector will be routed to both output channels. Both detectors should not be deconfigured at the same time.

Deconfiguring the detectors also deconfigures the detector’s PPC control. You must reconfigure the PPC control when restoring the detector configuration.

The PSSI injector includes a capillary control option. Select the Injector Type from the drop down list.

Type Options: None, Packed, Cap, GSV, PSSI, POC
None
Using the Tools Menu

**PSS - Programmed Split/Splitless Injector**

![Configure Injector B Interface](image_url)

- **Type**: PSSI
- **Ready**: 0:00
- **Capillary Control**
- **Split Flow Offset Mode**
  - Auto
  - Fixed
  - Offset: 4.0 mL/min
- **Headspace Split Control**
If PSSI or POC is selected, the program mode options include: None, Oven, and Inlet. Oven is the default option. If the injector is configured for oven programmed mode, the injector set point equals the oven set point plus 5 and the program button next to the temperature field on the active method screen is deactivated.
Using the Tools Menu

### Split Mode

- **Split Mode**

If it is set for inlet programming, the injector is first heated to the injector temperature entered in the method and then follows the injector temperature program. The temp field does include a program settings button in this case.

If the capillary control checkbox is selected, the program mode can be configured for pressure, flow, and velocity.

If the Mode is set for flow or velocity, the radio buttons for Program and Oventrack are deactivated.

If the mode is set for pressure and the Oventrack radio button is selected, the column dimension fields are deactivated. In this case, the pressure is entered in the method and the software maintains the column flow based on the initial oven temperature and pressure. When the Oventrack mode is selected you cannot view the flow or velocity.

If the capillary control check box is not selected, the split pneumatics only controls the inlet pressure and split flow. The options in the Mode field include None and Pressure.

The Vacuum Compensation checkbox, Column Length and ID fields, and Split Mode radio buttons are deactivated when capillary control is off.

The split flow offset radio buttons are active with or without capillary control. The options include Auto, which is the default setting, and Fixed. When Auto is selected, enter the value for the Leak Check Maximum. The Fixed option allows you to enter the split flow offset directly. The field label changes from Leak Check Max to Split Flow Offset.

### Carrier Control

- **Carrier Control**

If it is set for inlet programming, the injector is first heated to the injector temperature entered in the method and then follows the injector temperature program. The temp field does include a program settings button in this case.

If the capillary control checkbox is selected, the program mode can be configured for pressure, flow, and velocity.

If the Mode is set for flow or velocity, the radio buttons for Program and Oventrack are deactivated.

If the mode is set for pressure and the Oventrack radio button is selected, the column dimension fields are deactivated. In this case, the pressure is entered in the method and the software maintains the column flow based on the initial oven temperature and pressure. When the Oventrack mode is selected you cannot view the flow or velocity.

If the capillary control check box is not selected, the split pneumatics only controls the inlet pressure and split flow. The options in the Mode field include None and Pressure.
Packed Injector
**Using the Tools Menu**

**POC- Programmable On Column Injector**

![POC- Programmable On Column Injector](image)
Capillary – Split/Splitless Injector
Using the Tools Menu

**GSV – Gas Valve**

![Configure Injector B Window]

- Type: GSV
- Options: None, Pkd, Cap, GSV, PSSI, PSSO
- Initializing... 0:00
- Buttons: OK, Cancel
- Location: 70,14, Ready
Oven

**Single Point Calibration**

When the Single Point Calibration radio button is selected, the Offset field is active and the GC Tune drop down field is inactive. Single Point is the default setting. The default value is 0. The Offset range is -10 to +10 °C. If the GC is not “GC-enabled” then the GC Tune radio button is deactivated.

Enter the offset temperature and allow the oven temperature to equilibrate for at least 30 minutes. The displayed temperature will approach 100.00 °C, or the oven temperature you entered, and the thermometer readout will approach a value close to 100.00 °C.

Below is an example of a detector.
Using the Tools Menu

FID

Type: External
Filter: 200
Heat detector

Gas Flow
SetPoint | Actual
Hydrogen: 0.0 | 0.0 mL/min

Output
Recorder
Integrator
Offset: 5.0 mV

Ready: 13:03:27

[Buttons: - + OK Cancel]
When you touch the OK button, the system launches a status query to the PPC connect module to ascertain whether a PPC flow module has been assigned to the TCD. If no flow module has been assigned, a dialog box appears.
If **No** is selected, the dialog box closes. If **Yes** is selected, the PPC connect screen appears and the user configures an available flow module.
When the flow module is configured, you touch the **OK** button to validate the settings and the TCD detector configuration screen appears.
Using the Tools Menu

**ECD**

- **B - ECD**
  - **Disable**
  - **Filler**: 200
  - **Gas Flow**
    - **SetPoint**
    - **MakeUp**: 0.0
    - **Actual**: 0.0
  - **Output**
    - **Recorder**
    - **Integrator**
    - **Offset**: 5.0
  - **Ready**: 13:06:14

**PID**

- **A - PID**
  - **Disable**
  - **Filler**: 200
  - **Gas Flow**
    - **SetPoint**
    - **MakeUp**: 0.0
    - **Actual**: 0.0
  - **Output**
    - **Recorder**
    - **Integrator**
    - **Offset**: 5.0
  - **Ready**: 13:07:16
Using the Tools Menu

**FPD**

![FPD Setting Menu](image)

- **Disable**: 
  - **Filter**: 200
  - **Linearize**: 

<table>
<thead>
<tr>
<th>Gas Flow</th>
<th>SetPoint</th>
<th>Actual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air</td>
<td>0.0</td>
<td>0.0 mL/min</td>
</tr>
<tr>
<td>Hydrogen</td>
<td>0.0</td>
<td>0.0 mL/min</td>
</tr>
</tbody>
</table>

- **Output**
  - **Recorder**
  - **Integral**
  - **Offset**: 5.0 mV

**Ready**: 13:19:44
Output Configured
Using the Tools Menu

External Configuration

![External Configuration Window]

- **Type**: External
- **Filter**: External
- **Gas Flow**
  - **Hydrogen**
    - SetPoint: 0.0 mL/min
    - Actual: 0.0 mL/min
- **Output**
  - **Recorder**
  - **Offset**: 0.0 %
Run/AutoSampler

Pre wash is number of times the syringe is filled with the sample and emptied to a waste vial before a sample is acquired for injection. The default is 2. Permissible entries are 0 to 15.

Pump is the number of times the syringe is filled with the sample before it is acquired for injection. The default is 6. Permissible entries are 0 to 15.

Post-inject is the number of times the syringe if filled with solvent and emptied to waste after sample injection. The first half of these washes is taken from solvent vial 1 or 3. The second half from solvent vial 2 or 4. The default is 2. Permissible entries are 0 to 15.

Injection Mode

Fast – 30 miliseconds. Not available when a 50.0 syringe is installed.

Normal injection takes about 1 second.
Using the Tools Menu

Slow takes about 7.5 second.

Auto resume provides option for autosamplers program to automatically resume where it left off should a power failure occur.

Autos resume should not be used if you have FID or FPD configured with PPC since flame is extinguished during a power failure.

The Key Clicks check box is selected by default.

The Enable Password check box is deselected by default. If the check box is enabled, the default password is “Clarus.” Touch the Set button to display the password dialog box.
Touch the New field. The alphanumeric keypad appears to enter the password. Passwords are limited to eight characters and are case sensitive.

Enter the password and touch **OK**, or touch the x (close symbol) or **Cancel** to close the keypad and continue setup.
Using the Tools Menu

**Language drop down menu.**

Touch the language option. The list box closes and the selected language is immediately displayed throughout the application.

**Brightness field.**

The field is selected.

Use the plus and minus keys to increment values up or down. Settings takes effect immediately.
**Date/Time Set**

![Date/Time Set Screen](image1)

**Startup**

![Startup Screen](image2)
Using the Tools Menu

**Sleep**

Value range is 6-999.

![Screen Shot of Sleep Menu](image)

**Pneumatics**

The parameter tables show the connection between the values shown on the screen and the underlying parameter interface that communicates to the GC. The dependency column summarizes major issues such as if a parameter is not available or hidden when PPC is not fitted. The Parameter column is primarily of interest to the firmware team unless an entry is blank – this means that the parameter is currently unconnected to the GC.

The logic descriptions cover special case handling performed within the user interface to hide or disable certain options, change units or limit the available ranges for parameters.

The extra status bar at the bottom of each bitmap and status text above the bottom row of buttons should be ignored.
To access the PPC Settings, press the pneumatics icon button on the Configuration screen.

The pneumatic configuration screen appears and displays a number of buttons to represent different types of settings.
Using the Tools Menu

**PPC Configure**

![PPC Configure dialog box](image)

To avoid damaging the PPC system, do not modify the settings unless the hardware configuration has changed.

Do you want to proceed?

- OK
- Cancel

Initializing...
Connecting the PPC Modules

The Clarus GC PPC modules have been properly installed and configured at the factory for your specific combination of injectors and detectors. The configuration information is stored in a reserved area of the battery-backed memory; however, if the memory lost the PPC module connect configuration or if you installed a new PPC module by purchasing an add-on kit, you must follow the procedure(s) listed in this section.

By connecting a PCC module, you actually set the Clarus GC controlling software to recognize a specific PPC module that is installed at a specific location. This is necessary so that the software can control the installed hardware.

The PPC board has 12 sockets to which various injector and detector modules are connected. The socket locations and descriptions are listed below and shown in the following figure:
### Table 6-1. Injector and Detector Socket Descriptions

<table>
<thead>
<tr>
<th>Injector 1</th>
<th>Injector 2</th>
<th>Injectors (Carriers)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (J10)</td>
<td>2 (J11)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detector 1</td>
<td>Detector 1</td>
<td>Detector 1</td>
</tr>
<tr>
<td>Air or TCD Ref</td>
<td>HYD or Make Up</td>
<td></td>
</tr>
<tr>
<td>3 (J12)</td>
<td>4 (J13)</td>
<td></td>
</tr>
<tr>
<td>Detector 2</td>
<td>Detector 2</td>
<td>Detector 2</td>
</tr>
<tr>
<td>Air or TCD Ref</td>
<td>HYD or Make Up</td>
<td></td>
</tr>
<tr>
<td>5 (J14)</td>
<td>6 (J15)</td>
<td></td>
</tr>
<tr>
<td>7 (J16)</td>
<td>8 (J17)</td>
<td>Aux</td>
</tr>
<tr>
<td>9 (J18)</td>
<td>10 (J19)</td>
<td></td>
</tr>
<tr>
<td>11 (J20)</td>
<td>12 (J21)</td>
<td>Split Vent for CAP &amp; PSS injectors or Pressure Readout for PKD &amp; POC injectors</td>
</tr>
</tbody>
</table>

A flow or pressure module can be connected to positions 1 – 8. Split vent modules or pressure modules can only connect to positions 9 – 12.

The PPC modules for injectors 1 and 2 carrier gas connections are connected to sockets 1 (J10) and 2 (J11), respectively, on the PPC board.

The PPC modules for the split/splitless capillary (Cap) injector or PSS injector split vent connections that correspond to injectors 1 and 2, or the pressure readout that corresponds to a packed column injector (Pkd) or POC injector installed in socket 1 and 2 are connected to sockets 11 (J20) and 12 (J21), respectively, on the PPC board.

The PPC modules for detectors 1 and 2 are connected to sockets 3 (J12) through 6 (J15) on the board. Detector 1 uses sockets 3 and 4.
Using the Tools Menu

Figure 6-1: The PPC board installed in the Clarus GC.

Your Clarus GC has been properly configured (connected) at the factory. However, you can check the configuration to become familiar with the procedure in the event that you need to reconfigure (reconnect).

For example, if a capillary injector is installed (split/splitless (CAP) or programmed split/splitless (PSS)), then Split is configured to notify the Clarus GC software that a capillary PPC module is installed.

If a packed injector (Pkd) or programmed on-column (POC) injector is installed, Flow is configured to notify the software that a PPC flow module is installed.
PPC Connect

Press the PPC Connect button. The following message appears to caution users that modifying the settings can have a negative impact on the operation of the PPC system.

Press **OK** and the Main Connect PPC Devices screen appears.
The screen includes icon buttons to show the logical PPC devices. The carrier icons are taken from the currently configured injector for the corresponding channel. The detector icons are taken from the currently configured detectors. In the above screen Carrier A and B buttons show the packed column injector and the unconfigured injector icon respectively, while the Detector A and B buttons show FID and TCD icons respectively.

Pressing a Carrier, Detector or Aux icon button displays a dialog that allows this device to be defined.
The Carrier A icon invokes the following dialog box:
Using the Tools Menu

Since the PPC has yet to be configured the primary module is undefined and the secondary module entry is disabled.

The primary entry is expected to be the module function. The following screen shows the full potential range available for the primary module function.
The available range of functions is calculated by combining the set of potential functions from each of the uncommitted positions with the valid set of functions for this logical position. This is explained in more detail in a later section. For a Carrier a Detector flow module is invalid and is not offered.

Note that at this point the only available position for the primary module is 0, the undefined state.

Once a function is selected for the primary module, in this case Carrier flow, the position list is updated to offer only those positions consistent with choice and not already assigned to another logical position. In this case only position 1 is valid and the screen appears as shown below.
The secondary module is now enabled. This will only be the case if the primary module is set to Carrier flow or Split control. The following screen shows that the second module can be configured as either Pressure readout or Split control under these conditions.
In this case the secondary module is left unconfigured. Touch **OK** to close the dialog box and implement the settings.

Touch the **Carrier B** button on the Connect PPC Device screen to display the associated settings.
Using the Tools Menu

Note that Carrier flow is no longer an option.

Select Split control. The secondary module for Carrier B is now enabled but inspection shows that there are no suitable modules available for assignment.
Press **OK** to close the dialog box and implement the changes. The Connect PPC Device screen appears.

**Dialog: Define Detector**

If Detector A is pressed on the Connect PPC Device the dialog shown below pops up. Since the PPC has yet to be configured the primary module is undefined and the secondary module entry is disabled.
Using the Tools Menu

Note that the dialog title bar contains the detector name and that the primary and secondary function boxes are now labeled with the default gases for this type of detector. For a detector that only requires a single gas – ECD, PID, ElCD and External - the secondary module line is hidden.

The only valid option for a detector is a Detector flow module. The following screen shows that once Detector flow has been selected the position combo box is recalculated and offers positions 3 to 6 as possible options.
Once 3 is assigned to the primary module, however, this location is no longer available for use with the secondary module.
Using the Tools Menu

Press **OK** to implement the changes and return to the connect screen.

In the example shown in the following screen, press **Detector B** and connect Detector flow modules for the TCD module. Note the changes to the window title bar and the labels on the left hand combo boxes.
Press **OK** to apply these changes.

**Define Aux**

Touch Aux 1 to display the dialog box. In the example shown, in the following screen capture on the left, since all of the available modules have been assigned no options are available.

If the simulator is re-started, all of the configuration added in the previous two sections will be lost. If Aux 1 is pressed before setting up the carriers and detectors, a more complete list is offered as shown in the screen on the right.
For each function, position pair the same basic calculation is used to identify what modules are available and what locations are available once the module type has been selected.

To identify the types of module available, first identify the set of available locations that contain one of the acceptable set of modules for this logical position.

For a carrier this means scanning through all of the locations looking for ones that the hardware test has shown to contain CARF or PRES modules and that have not been assigned to another logical location.
Reference Settings

Manual Pneumatics

Relays

The Relays settings are accessed on the Tools Menu System option screen. Use the drop down screen to set the type of valve.

Zeroing and Calibrating the PPC Modules

The Clarus GC gas modules have been calibrated at the factory and are ready to use. For good laboratory practices and your own internal validation protocol, you may wish to recalibrate at installation with your own flow measuring device.

All carrier gas modules have been calibrated at the factory with helium. If you are using a different gas, you must enter the appropriate gas and recalibrate. Detector gas modules must be recalibrated if you are using a different gas in your laboratory. In the factory, the TCD reference gas and the PID make-up gas have been calibrated with helium and the ECD make-up gas with nitrogen.

Zeroing and calibrating PPC modules consists of the following steps:
Using the Tools Menu

- Zeroing the PPC gas modules (Gas turned off)
- Setting the reference temperature and pressure
- Calibrating the PPC carrier gas modules and/or PPC detector gas modules (Gas turned on)

The calibration information is stored in a reserved area of the battery-backed memory.

**Zeroing the PPC Gas Modules**

Before zeroing the PPC gas modules:

- Make sure that the Clarus GC has been properly installed and all gases are connected.
- Turn on the Clarus GC power and allow the GC to warm up for approximately 15 minutes before calibrating any gas.

**Table 6-2. Injector/Detector and Corresponding PPC Module Gas Function**

<table>
<thead>
<tr>
<th>Injector/Detector</th>
<th>PPC Module Gas Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Packed Column and POC Injector</td>
<td>Carrier Gas</td>
</tr>
<tr>
<td>Capillary and PSS Injector</td>
<td>Carrier Gas and split flow</td>
</tr>
<tr>
<td>FID, NPD, FPD</td>
<td>Both air and hydrogen gases</td>
</tr>
<tr>
<td>ECD</td>
<td>Makeup Gas</td>
</tr>
<tr>
<td>TCD</td>
<td>Reference Gas</td>
</tr>
<tr>
<td>EI/CD</td>
<td>Hydrogen Reaction Gas</td>
</tr>
<tr>
<td>PID</td>
<td>Makeup Gas</td>
</tr>
</tbody>
</table>

- Make sure that the gas supply to the Clarus GC is turned off at this time.
- Ensure that the pressure in the lines has completely bled down by loosening the restrictor on the rear of the PPC module that you are calibrating (see the following) with a 1/2-inch socket wrench or open-end wrench. Refer to above table for a listing of the injectors and detectors with the corresponding PPC gas module functions.
To zero the carrier and detector gases:

1. From the PPC screen touch the **PPC Configure** button. Touch **OK** on the Caution message.
Using the Tools Menu

2. Select the channel you need (in this example Channel A tab is selected). Touch the **Zero** button. Select any of the other tabs to Zero another Channel, carrier gas, detector or Aux.

![Configure PPC Devices](image)

**CAUTION**

If the value shown on the top line of the display is outside the range of ±3 psi, first verify that the supply gas pressure has bled to 0. If the supply gas pressure has bled to 0 and the value is still outside the range of ±3 psi, contact your local PerkinElmer Service Engineer.
The module identifier 1A is defined as follows: The number (1 – 12) indicates the specific PPC module. The letter A or B indicates the pressure transducer within that module. The flow controller has two pressure transducers per module, whereas the other modules only have one. In the carrier flow module, pressure transducer A reads the differential pressure across the flow-measuring device (restrictor) and transducer B reads the input line pressure.

3. Retighten all septum caps and restrictors on the rear of the instrument.

4. Turn on the gases connected to the Clarus GC.

Turn on the carrier gas and allow at least one minute for the line pressure to stabilize and purge the lines before selecting Calibrate from the display.

Setting the Reference Temperature and Pressure

The reference temperature and pressure values are set at the factory. *We recommend leaving these parameters set to the factory (default) values (Temp = 25 °C and Press = 14.7 psi).* If you wish to use your own flow measuring device and know the temperature and pressure at which your flow-measuring device was calibrated, then enter the values as described in this procedure.

To set the reference temperature and pressure:

1. From the main PPC screen touch the **Reference Settings** button. Touch **OK** on the Caution message.
2. In **PPC Reference Conditions** screen add the reference temperature and pressure using the plus minus buttons. Touch **OK** when completed.
Calibrating the Carrier Gas Modules

**CAUTION**
If you are performing this calibration procedure and you do not have a column connected to the detector, you must plug the detector fitting in the oven with an Swagelok 1/8-inch cap before proceeding. This will ensure that all the gas flows up through the detector and not into the oven.

If you are using a packed injector or programmed on-column injector, you can disconnect the column and measure the flow at the exit of the injector.

If you are using a capillary injector or programmed split/splitless injector, you must remove the column. Cap the injector exit in the oven and measure flows at the split vent exit.

To cap the injector exit in the oven, locate the Capillary Column Shipping Kit (P/N N610-0160) and insert the solid ferrule (P/N 0992-0511) into the 1/16-inch nut (P/N 0990-3392) and connect the nut to the exit of the injector.

**CAUTION**
To obtain the correct results, before you begin to calibrate you must first Zero the Gas Modules.

1. From the PPC screen touch the **PPC Configure** button. Touch **OK** on the Caution message.
2. Select the channel you need (in this example Channel A tab is selected). Touch the **Calibrate** button. Select **OK**.
3. In the Calibrate screen use drop down menu to select the proper carrier gas and use the plus minus buttons to input the other values needed.

In this example, the injector is a capillary split/splitless and the restrictor installed is a number 6. The restrictor/frit number has been entered in the software at the factory. Do not change this number unless you have replaced the restrictor with a different one. The number is stamped into the restrictor.

**CAUTION**

*If you are performing this calibration procedure and you do not have a column connected to the detector, you must plug the detector fitting in the oven with an Swagelok 1/8-inch cap before proceeding. This will ensure that all the gas flows up through the detector and not into the oven.*

*CAUTION*

*All carrier gas modules are calibrated with helium gas at the factory. If you are using a gas other than helium, you must select the correct gas for your application. We also recommend recalibrating the carrier gas module.*

The **Set** value displayed on the screen is 60% of the flow range available at the current gas supply pressure. The value displayed is from a lookup table based on the restrictor installed, the type of carrier gas, the ambient temperature, and the gas supply pressure. The measured flow will be different from this value. The **Actual** measured flow should be within ±20% of the setpoint value without calibration. If the inlet gas pressure from the tank is less than 60 psig or if the restrictor installed is not the same as the restrictor number entered, then the actual measured flow will not match ±20% of the setpoint value. This indicates that there is a problem.

The number displayed next to **Hi** on the screen is the value that the software interprets as the actual flow. This number will always equal the setpoint if control is possible. If you set the flow higher than what is possible for a particular restrictor/frit, then the numbers will not agree.

4. Touch **OK** to complete.
Calibrating the Detector Gas Modules

Before you begin to calibrate, you must first Zero the Gas.

CAUTION

This calibration procedure is specific to the gas used. If you change the gas, you should recalibrate.

CAUTION

The TCD and PID flow module for reference gas is calibrated with helium at the factory. You must recalibrate the TCD and PID flow module if you are using a reference gas other than helium.

CAUTION

The ECD flow module for make-up gas is calibrated with nitrogen at the factory. You must recalibrate the ECD flow module if you are using a make-up gas other than nitrogen.

CAUTION

To calibrate a detector gas module:
1. Ensure that the gases connected to the Clarus GC have been turned on and stabilized for at least 15 minutes before you begin calibration. **Ensure that no detector flame is lit before calibrating!**

2. To eliminate the column flow from the detector gas calibration, disconnect the column from the detector and cap the detector fitting. This is very important when you are using packed columns at high flow rates.

3. From the PPC screen touch the **PPC Configure** button. Touch **OK** on the Caution message.

4. Select **Detector** tab. Touch the **Calibrate** button. Select **OK**.

5. In the Calibrate screen use drop down menu to select the proper carrier gas and use the plus minus buttons to input the other values needed. Remember only touch the fields that need to be changed. If you do not touch the field the original value will remain and not change.

6. Enter Zero (0) for the detector gas setpoints. If you are using a FID, NPD, or FPD, enter “0” for both air and hydrogen detector gas setpoint.
7. When you have added all the appropriate values touch **OK**.

If you have an ionization detector (for example, FID, NPD, or FPD), you must repeat this process for the hydrogen gas also. The other detector types that have only one detector gas (for example, TCD, ECD, PID, and EICD) will be complete at this time.
Calibrating the Flow Readout Using Manual Pneumatics

It is only necessary to recalibrate the optional flow readout using manual pneumatics if you have replaced the 0 to 100 mL/min flow element. If you are using a carrier gas other than helium, you do not have to recalibrate. However, you must define the carrier gas on the screen. If you do wish to recalibrate, use the procedure which follows.

The optional flow readout comes with a 0 to 100 mL/min flow element. If the optional flow readout has been installed, it will have been calibrated at the factory using helium as the carrier gas. Perform the following procedure if you have installed the 0 to 20 mL/min flow element.

**Note:** The flow controller is calibrated at 9- psig inlet.

**Note:** At the moment the Clarus GC is turned on, the oven, injector(s), and detector(s) begin to heat up rapidly. To avoid injury while installing a column, all heaters should be turned off and their respective zones allowed to cool before touching the injector septum caps or any of the fittings inside the oven.

Before proceeding, determine whether the packed column is in position 1 or 2 using the procedure previously described.

1. Open the oven door.
2. Turn on the Clarus GC, if it is not already on, and wait for the System Status Screen.
3. Notice that as the oven cools down, the actual temperature is continuously updated on the bottom line.
4. Wait for the oven fan to turn off.

The oven fan automatically turns off when the oven temperature drops to 40 °C.
5. Connect a soap bubble flowmeter to the packed injector fitting inside the oven.

To minimize the possibility of melting the tubing, we recommended using Tygon tubing to make the connection.

![Figure 6-3. A packed injector fitting.](image)

6. Turn on the carrier gas at the tank and adjust the line pressure to 90 psig. (Adjust the inlet pressure to 45 psig if you are using hydrogen as the carrier gas.)

**Note:** The flow of carrier gas through a packed injector is controlled by the flow control knob on the pneumatics control panel (see the following figure).

7. Turn the flow control knob fully clockwise until it is completely closed.
Figure 6-4. Packed Injector and POC controls.

8. From the System Status window touch **Tools**. From the Tools drop down menu touch **Utilities**.
Using the Tools Menu

9. In the Utilities screen touch **Stopwatch** icon.

   Ideally, the flow should be zero, but some flow controllers may produce a small flow when turned off.

10. Touch Time field to and make sure the time is set to 0.00. Use the plus minus keys to make any adjustments. Touch **OK** when completed and close the screen.

   ![Stopwatch Screen]

   11. For the channels that you are using select **Flow** from the **Carrier Device** drop down menu.
12. From the Gas drop down menu select the gas you are using.

13. Touch the Calibrate button.

   The following screen appears:
14. Touch the **Low Flow** dialog box and use the plus and minus buttons to enter the flow value measured in Step 9.

15. Touch **OK**.

The following screen appears:
16. Turn the flow control knob counter clockwise to start the carrier gas flowing.

17. Measure and adjust the flow to one of the following:

   If a 0 to 100 mL/min flow element is installed: $100 \pm 10 \text{ mL/min}$

   If a 0 to 20 mL/min flow element is installed: $20 \pm 2 \text{ mL/min}$

18. Repeat steps 11 through 18.

19. Touch the dialog box for **High Flow** and use the plus and minus buttons to enter the flow you just measured.
Calibrating the Oven Temperature

The Clarus GC oven temperature is controlled by a sophisticated software routine that permits adjustment of the actual oven temperature inside the oven up or down within a ±10 °C window. This calibration utility is intended for applications which require precisely matching oven temperatures across several Clarus GCs, such as the determination of retention indices. The calibration information is stored in a reserved area of the battery-backed memory.

**Required Equipment:** A calibrated precision platinum resistance thermometer with 0.01 °C readout and a probe capable of insertion into the GC oven.

The following steps summarize how to calibrate the oven temperature:

1. Calibrate the reference thermometer
2. Place the thermometer probe in the oven
3. Equilibrate the oven temperature
4. Enter the required offset value
5. Remove the thermometer probe

**Calibrate the Reference Thermometer**

Calibrate your reference thermometer according to its instructions. If the thermometer has been calibrated by an outside service, there is no reason to recalibrate it yourself.
**Place the Thermometer Probe in the Oven**

**CAUTION**  
*The thermometer probe must be placed as close as possible to the same position in each GC oven to be calibrated. Access to the oven is provided on the left-side oven wall.*

1. Turn off the power and allow the oven to cool.

2. Remove the left-side instrument cover.

   Note the location of three approximately 1-inch diameter holes that correspond to the holes on the left side of the oven. One or more of these holes may be occupied by gas sampling valves.

3. Insert the temperature probe through the exposed white insulation covering one of the holes so that the probe tip is positioned in the center of the oven cavity.

---

**Figure 6-5**  
Left panel removed to reveal left side of the oven exterior.
Using the Tools Menu

Note which hole you used and measure the length of the probe that protrudes into the oven. Use the same position for subsequent oven calibrations.

Figure 6-6 Holes on the left side of the oven exterior.

Equilibrate the Oven Temperature

1. Close the oven door, then turn the GC and thermometer on. From the System Status screen press the oven icon.
2. From the next screen select **Tools** and press on **Configuration** in the drop down menu.
3. In the oven configuration screen press on the **Oven** icon.
4. From the window, shown below, set the oven temperature of 100 °C or use another temperature if desired by using the plus and minus buttons.
5. Single Point is the default setting. When the Single Point Calibration radio button is selected, the Offset field is active and the GC Tune drop down field is inactive. (GC Tune is only available if it is downloaded. A successful tune must be performed in order for GC tune to be enabled. Only those channels for which a valid tune exists will be available on the drop down list. The selection will be made from the external GC Tune software, but the user may override this.)

The actual temperature under the single point radio button is the time-averaged actual oven temperature.

6. Allow the oven temperature to equilibrate for at least 30 minutes by setting the time in the **Equilibrate** field. Press **OK**. The displayed temperature will approach 100.00 °C (or the oven temperature you entered in step 4), and the thermometer readout will approach a value close to 100.00 °C.
Enter the Required Offset Value

1. After the temperature has stabilized, subtract the thermometer reading from the actual oven temperature shown on the previous screen.

2. Using the plus and minus keys enter a value into the above screen, then press OK. For example, if the thermometer reads 101.55 °C, and the oven temperature reads 100.10 °C, type a value of -1.45 °C.

Remove the Thermometer Probe

After temperature calibration is satisfactory:

1. Open the oven door and allow the oven to cool until the fan stops.

2. Remove the temperature probe.

3. Fill in any hole left by the probe in the oven insulation.

4. Replace the left-side instrument cover.
1. To reach the Utilities screen of the Tools Menu go to the System Status screen and select Utilities from the tools menu.

2. Touch the following icon on the Utilities screen to access the Column Flow Calculator, the Column Length Calculator, the Background Compensation or the Stopwatch.
**Column Flow Calculator**

The capillary column gas flow rate “calculator” allows you to automatically calculate the correct gas flow rate.

1. Touch the **Column Flow Calc** icon.

2. The following screen appears.
3. Input the column length, column diameter, column temperature, carrier gas name and outlet pressure.

4. One of the following is selected: inlet pressure, flow rate and velocity/\( t_0 \). A value is entered into the selected field and results are calculated and inserted into the two unselected fields. For example the example in the above screen will allow you to enter an inlet pressure and calculate the flow rate and velocity from this and the other entries. Use the plus minus buttons to add the flow rates.

5. Press the **Split** button and the next screen appears. This screen allows you to calculate the split flow settings may. The Close button on this second screen brings you back to the above screen.
Column Flow Calc Main Screen

Length

This field is normally entered in meters (1 to 1000 in 1m increments). The calculator should also support techniques such as PreVent and heart-cutting etc. and so shorter columns/tubes should be supported. If the value scrolls below 1m, then the units should change to mm (1 to 1000 in 1mm increments).

The default value will be 30m.

For the calculation this value should be converted to cm.

Diameter

Column diameter should be entered in µm (1 to 1000µm in 1µm increments).
The default will be 320µm.
Value converted to cm for calculations.
Using the Tools Menu

Temp

Normal GC oven temperature range in °C (-99 to 450°C in 1°C increments). The default will be 50°C. Value converted to °K for calculations.

Name

The name of the carrier gas is selected in order to apply the correct viscosity coefficients and suggested column carrier gas velocities as shown in the Table.

<table>
<thead>
<tr>
<th>Gas</th>
<th>Screen Name</th>
<th>( \eta_{ref}, \text{Pa.s} )</th>
<th>x</th>
<th>Suggested Velocity, cm/s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helium</td>
<td>He</td>
<td>0.0000018662</td>
<td>0.646</td>
<td>20 to 40</td>
</tr>
<tr>
<td>Hydrogen</td>
<td>H2</td>
<td>0.000008399</td>
<td>0.725</td>
<td>30 to 55</td>
</tr>
<tr>
<td>Nitrogen</td>
<td>N2</td>
<td>0.000016736</td>
<td>0.680</td>
<td>8 to 16</td>
</tr>
</tbody>
</table>

The default will be “He”.

Outlet Press

The column outlet pressure is set to Ambient or Vacuum (0) or to a user entered Other value. Units will be in absolute units (psi abs or kPa abs) and will be set according to the units chosen in the Configuration screens for the rest of the user interaction. The range for this field will be 0 to 100 psi abs in 0.1psi increments or 0 to 689 kPa abs in 1kPa increments. The default will be Ambient (14.7psi abs or 101kPa abs).

Suggested Velocity

A display-only field that shows the recommended carrier gas velocity range from the selected carrier gas name.

Inlet Press

This is a selectable field (this is the default selection) and, if selected, the Flow and Velocity/t0 fields are deselected and are display only. The carrier gas input pressure is in units of psig (1 to 100psig in 0.1psi increments) or kPa (1to 689kPa in 1kPa increments).
The default is 5.0psig or 34kPa.

**Flow Rate**
This is a selectable field and, if selected, the Inlet Press and Velocity/t0 fields are deselected and are display only.
The carrier gas flow rate is in units of mL/min (1 to 100mL/min in 0.1mL/min increments).
There is no default as this field will be already filled by a previous calculation result.

**Velocity**
This is a selectable field and, if selected, the t0 field is also enabled for input. The Inlet Press and Flow fields are deselected and are display only.
The carrier gas flow rate is in units of cm/s (1 to 500cm/s in 0.1 cm/s increments).
There is no default as this field will be already filled by a previous calculation result.

**Split Flow Calculations Screen**

**Column flow rate**
This field will take its initial value from the Main Screen Flow field. The same range and units will apply.
If the value is changed in this field, the entry in the Main Screen will also be updated and the input pressure, velocity and t0 will be recalculated.

**Split flow rate**
This field will use mL/min units (0 to 500mL/min range in 1ml/min increments).
The default will be 50mL/min.

**Column i.d.**
This field will take its initial value from the Main Screen Diameter field. The same range and units will apply.
If the value is changed in this field, the entry in the Main Screen will also be updated and the active input pressure, flow or velocity and t0 will be recalculated.

**Liner i.d.**
This is the internal diameter of the injector liner. The input range will be 0.1 to 6.0mm in 0.1mm increments.
Using the Tools Menu

Split flow ratio
Calculated using Equation 9. Value displayed to nearest integer. Dimensionless units

Split velocity ratio
Calculated using equation 10. Note that the split dynamics occur at an elevated pressure, \( p_I \) and elevated temperature (injector temperature). The flow rates, \( F_a \) and \( F_s \), used in Equation 10 are at ambient pressure and temperature. The same factors would be applied to each to convert these flows to the true values inside the injecor and so they would be cancelled out in this equation.

Column Length Calculator

The capillary column gas flow rate “calculator” allows you to automatically calculate the correct gas flow rate.

1. Touch the Column Length Calc icon.

2. The following screen appears.
Background Compensation

Background compensation is a routine that automatically subtracts a stored baseline profile from the signal generated during a GC run.

1. Touch the **Background Compensation** icon.

2. The following screen appears.
Background compensation is a routine that automatically subtracts a stored baseline profile from the signal generated during a GC run.

The Background/Bakeout tool is always enabled.

Detector A and Detector B need to be labeled with the installed detector names.

The Calibration checkboxes are enabled if a detector is installed in that position.

Type, Method, and Start are always enabled, so that a bakeout can be performed with a mass spec or other system with zero detectors.

Before background compensation can be applied to a detector output signal, the baseline profile must be calibrated. The background function controls both calibration and compensation. Calibration involves running a blank using the temperature program. Once run, the background profile is stored. This profile is overwritten if calibration is rerun, thus only the most recent profile is used for compensation.
One background profile is stored for each detector. Calibration and compensation can be applied independently to each detector output signal.

Note: Calibration run time must be greater than 2 minutes.

**Calibration Menu Options**

*Once* – The background profile will be calibrated once and stored. This profile is applied automatically to all manual or autosampler runs when you subsequently turn the background compensation On.

*Multi* – The system runs the calibration method over and over again until you turn off calibration in the Calibration Menu. You may wish to use this option, for example, to condition a column overnight.

*Off* – Select this option to turn calibration off.

**Stopwatch**

The Stopwatch computes the flow rate that corresponds to the entered volume flowing during the timed interval. The start button resets the timer to zero and starts timing. While timing, the start button caption changes to Stop.

1. Touch the **Stopwatch** icon.

2. The following screen appears.
Using the Tools Menu
Release...

To access Release, from the System Status screen, touch **Tools** menu and press the **Release**. The following screen will appear select either **Yes** or **No**. If you select **Yes** the instrument will be released from its external control. If you select **No** the screen will close.

![Release Screen](image-url)
Reset......

To access Reset, from the System Status screen, touch Tools menu and press the Reset. The following screen will appear select either Yes or No. If you select Yes the instrument will be reset and data will be lost. If you select No the screen will close.
Logout...

To access Logout, from the System Status screen, touch **Tools** menu and press the **Logout**.
Touching Logout displays the splash screen.
Using the Tools Menu

**About**

To access About, from the System Status screen, touch **Tools** menu and press the **About**. Touch **About** to display version information.
Setting up a Typical Analysis
Setting up a Typical Analysis
This chapter gives you a brief overview on how to run your Clarus GC for a typical analysis. For more detailed information on the different screens and parameters discussed in this chapter see the earlier chapters in this guide on the Active Method, Method Editor and Tools Menu.

The Clarus GC can have many configurations. For the purpose of this chapter we are assuming the following configuration:

- Injector B is packed (Pkd)
- Injector A is programmed split/splitless capillary injector (PSS)
- One detector is a thermal conductivity detector (TCD)
- The other detector is a flame ionization detector (FID)
- An autosampler is used
1. In the System Status screen touch the oven icon.

2. The oven tab is now visible. To program the oven temperatures touch the temperature field and it will go black. Then use the plus minus keys to get to the required temperature for your application. Repeat the same procedure for the time and rate. As shown in the example below this analysis has been set to have an initial temperature of 75 °C and it is held at this temperature for 1 minute then going up 10 degrees.
3. After the oven tab has been set go the Injector B pkd tab. Touch the temp-init field. The field will go black. Use the plus minus buttons to enter the proper initial temperature for your application.

4. Touch the flow-init field for the carrier gas. The field will go black. Use the plus minus buttons to enter the proper carrier gas flow for your application.

5. To turner the heater on or off touch the Heater button. The button reflects if the heater is on or off. If you see that the button says heater off that means that the heater is turned on. If you touch the button it will toggle to heater on and the heater will turn on.
1. For injector A touch the PSSI icon on the System Status screen.
2. Once you touch the PSSI icon the following screen appears. Touch the **Carrier Gas init pressure** field. This field will go black. Use the plus minus buttons to set the carrier gas pressure to the required pressure for your application.
3. To program the injector touch the **Program** icon.
4. To program the injector temperature program touch the **init temp** field for the injector. To program the injector temperatures touch the **Temperature field** and it will go black. Then use the plus minus keys to get to the required temperature for your application. Repeat the same procedure for the time and rate. As shown in the example below this analysis has been set to have an initial temperature of 275 ºC and it is held at this temperature for 60 minutes then going up 2 degrees.

5. Touch **Close** when you have entered all the parameters.
Setting up a Typical Analysis

**Detector**

**FID**

1. For the FID detector touch the FID icon to get to the FID tab.

2. To program the temperature in the FID tab touch the Temperature field and it will go black. Then use the plus minus keys to get to the required temperature for your application. Repeat the same procedure for the Attenu (attenuation) and Range. As shown in the example below, this analysis has the heater off.

3. If you require the heater on for your analysis just touch the heater button and it will toggle to heater on.
4. To have the detector autozero the baseline to a fixed amount touch the AutoZero field for the check off to appear (in this example AutoZero will not be used, it is not checked off).

![Gas flow, output, offset, filter, and flameout settings](image)

5. The gas flows, output, offset, filter and flameout are shown above as reference fields and they cannot be changed in this screen.

6. If the gas flows, output, offset, filter and flameout have to be changed touch the Tools button and touch Configuration from the drop down menu.
7. As shown in the screens below the Configuration screen will allow you to modify the filter, flameout, gas flows and output fields as your application requires. Once you have modified the Configuration screen touch **OK** and the new values will now be visible on the FID tab screen.
8. If timed events have to be added or modified in the Active Method touch the **Events** tab to get to this screen. The Events tab accesses the timed events table and buttons, valves, and Aux gas controls. Timed events may be added and removed while the GC is running.
Setting up a Typical Analysis

9. Touch the **Insert** button to add a timed event to the run. In the Event field select the type of event from the drop down menu. Use the plus minus buttons to input the amount of time for this event in the time field. In the value field use the drop down menu to insert the correct value. When completed touch **OK** to return to the Event tab. Repeat this procedure until you have added all the timed events for your procedure.

10. Once all the fields have been set as required by your application, touch the **ignite button** on the FID tab screen to ignite the FID.
Detector

TCD

1. For the TCD detector touch the TCD icon to get to the TCD tab.

2. To program the temperature in the TCD tab touch the Temperature field and it will go black. Then use the plus minus keys to get to the required temperature for your application. Repeat the same procedure for the Filter (attenuation) and Current. As shown in the example below, this analysis has the heater off.

3. If you require the heater on for your analysis just touch the heater button and it will toggle to heater on.
Setting up a Typical Analysis

4. To have the detector autozero the baseline to a fixed amount touch the **AutoZero** field for the check off to appear (in this example AutoZero will not be used, it is not checked off).

5. The gas flows, output, offset and filter are shown above as reference fields and they cannot be changed in this screen.
6. If the gas flows, output, offset and filter have to be changed touch the **Tools** button and touch **Configuration** from the drop down menu.

7. As shown in the screens below the Configuration screen will allow you to modify the gas flows, output, offset and filter fields as your application requires. Once you have modified the Configuration screen touch **OK** and the new values will now be visible on the FID tab screen.

8. If timed events have to be added or modified in the Active Method touch the **Events** tab to get to this screen. The Events tab accesses the timed events table and buttons, valves, and Aux gas controls. Timed events may be added and removed while the GC is running.
Setting up a Typical Analysis

9. Touch the **Insert** button to add a timed event to the run. In the Event field select the type of event from the drop down menu. Use the plus minus buttons to input the amount of time for this event in the time field. In the value field use the drop down menu to insert the correct value. When completed touch **OK** to return to the Event tab. Repeat this procedure until you have added all the timed events for your procedure.

10. Once all the fields have been set as required by your application for the TCD, touch the **Autosampler** icon on the screen.
1. The Autosampler screen allows you to select the method from the drop down window. Once you select the method you want to use for your application, the injection count down will begin. When the count down goes to zero the analysis will begin. If you need to stop the autosampler run touch the **Stop** button.
2. If you need to modify the method for running the autosampler or enable the autosampler touch the **Tools** button and from the drop down menu touch **Configuration**.
3. In the AutoSampler Configuration screen check off the **Enable Autosampler** field by touching it. If your application requires Recycling and/or Auto Resume touch the field to check off. Use the drop down window to set the volume and mode type. For the Syringe wash use the plus/minus buttons to modify the fields of Viscosity Control, Solvent Pre-wash, Pre-Inject, Post-Inject and Pump.

4. After you touch **OK** on the AutoSampler Configuration screen, the main autosampler screen will appear again. Touch **Start** to begin the run. Touch the **Signal** icon to get to the Signal screen.
5. On the Signal screen you will be able to observe the peaks as they are coming out during the analysis. If at any time you need to stop the analysis touch the Stop button.
Index

A
Abbreviations, screen, 1-6
About This Manual, 1-3
Active Method
  editing, 3-4
  parameters
    editing, 3-4
Adjusting
  carrier gas flow, 3-25
Attenuating
  detector signal, 4-141, 4-144
Auto-ignition, FID, 4-10
Autosampler, 7-19
  controlling, overview, 3-64
  tray, 3-64
  turntable, 3-64
  using with TCD, 3-75, 4-53
  vials, waste & wash, 3-74
AutoSystem
  controlling, 3-3
  glossary, 1-9
Aux Zone, 2-32

B
Background calibration options
  multi, 6-91
  off, 6-91
  once, 6-91
Background compensation
  overview, 6-90
Background Compensation, 6-89
Baking out the ElCD reactor, 4-74
Balancing TCD bridge current, 4-53
Bridge current range, 4-51
Bridge current vs. range, 4-52

C
Calibrating
  optional flow readout, 6-67
  oven temperature, 6-74, 6-81
  reference thermometer, 6-74
Calibrating, PPC module
  carrier gas, 6-61
  detector gas, 6-64
CAP, abbreviation, 1-6
Carrier Gas (PPC)
  velocity, viewing/setting, 3-30
Carrier gas flow
Flow controller
   See optional flow readout, 6-67
Flow Programming, 1-12
Flow readout, calibrating, 6-67
Flowmeter
   attaching to an ECD, 4-36
   attaching to split vent, 3-47
FPD
   abbreviation, 1-6
   adjusting air flow, 4-120
   adjusting hydrogen flow, 4-117
   cross-sectional view, 4-100
   igniting the flame, 4-108, 4-125
   overview, 4-100
   setting up manual pneumatics, 4-111
   setting up PPC, 4-101

G
Gen, abbreviation, 1-6
Ghost Peaks, 1-12
Glossary
   autosampler terms, 1-7
   AutoSystem specific, 1-9
   chromatographic terms, 1-11

H
Hydrogen flow
   adjusting, 4-21, 4-117

I
Inj/vial, abbreviation, 1-6
Injector temperature
   displaying, 3-14
   setting, 3-14
Injectors, 2-18, 7-6
   carrier gas program, 2-22
   configuration options, 2-19
   configuring, 6-9
   isothermal program, 2-22
   manual, 2-26
   packed, 2-26
   PPC, 2-25, 2-27
   program buttons, 2-18
   program display text, 2-19

K
kPa, abbreviation, 1-6

L
Labels
   Warning Signs, 1-5
Logout, 6-95

M
Maintenance, 6-7
Make-up gas
   control valve, 4-40, 4-55
   needle valve, 4-40, 4-55
   PID, needle valve, 4-60
Manual Pneumatics, 6-55
Method Editor, 6-4
   file menu, 5-9
   mode, 5-5
   overwriting the active method, 5-9
Multiprogram mode, 3-69
Multi-ramp temperature program
   setting up, 3-11

N
Navigation Bar, 2-17
NPD
   adjusting the air flow, 4-90
   adjusting the hydrogen flow, 4-88
   bead activation, 4-92
   reactivating a used bead, 4-97
   cross-sectional view, 4-81
   overview, 4-80
   setting up manual pneumatics, 4-85, 4-86
setting up PPC, 4-82
NPD, abbreviation, 1-6

O
One-ramp temperature program
setting up, 3-10, 3-18
Optional flow readout, calibrating, 6-67
Oven, 2-31, 6-19
calibrating the temperature, 6-81
equilibrating the temperature, 6-74
thermometer probe, 6-75
turning on, 4-44, 4-57
Oven Temperature
holding, 3-11
Oven temperature program
setting up, 3-6
setting up a multi-ramp, 3-11
setting up a one-ramp, 3-10, 3-18
setting up isothermal, 3-8
Overview
ECD, 4-32
ElCD, 4-67
FID, 4-5, 4-24
FPD, 4-100
NPD, 4-80
PID, 4-54
PID/ElCD in Series, 4-78

P
PID
abbreviation, 1-6
cross-sectional view, 4-55
lamp, turning on, 4-64
Needle valve
make-up gas, 4-60
optimizing UV lamp intensity, 4-65
overview, 4-54
setting up, 4-56
setting up manual pneumatics, 4-60
setting up PPC, 4-59
setup summary, 4-56
turning on UV lamp, 4-64
Pkd, abbreviation, 1-6
POC
abbreviation, 1-6
PPC
abbreviation, 1-6
calibrating carrier gas, 6-61
calibrating detector gas, 6-64
zeroing the module, 6-56
PPC Modules
connecting, 6-38
Pre, abbreviation, 1-6
Pressure control knob, 3-25
Pressure Programming, 1-12
Pressure Pulse, Splitless Injection, 3-49
Priority sample, inserting, 3-73
Psi, abbreviation, 1-6
psig, abbreviation, 1-6
PSS
abbreviation, 1-6
R
Reactor, ElCD
assembly, 4-69
baking out, 4-74
Reference Pressure
setting, 6-59
Reference Temperature
setting, 6-59
Release, 6-93
Rerouting
detector output, 4-137
Reset, 6-94
S
Screen
abbreviations, 1-6
Septum Purge Mode (PPC)
viewing/setting, 3-33
Setting
injector temperature, 3-14
Setting up
isothermal temperature program, 3-8
multi-ramp temperature program, 3-11
one-ramp temperature program, 3-10, 3-18
split mode, 3-49
splitless mode, 3-49

Setup summary
ECD, 4-34
ElCD, 4-71
FID with manual pneumatics, 4-17
FID with PPC, 4-6
FPD with manual pneumatics, 4-111
FPD with PPC, 4-101
NPD with manual pneumatics, 4-86
PID, 4-56
TCD, 4-44

Split mode
flow knob, 3-47
flow needle valve, 3-47
setting up, 3-49
split vent flow
  adjusting, 3-46
  measuring, 3-46

Split vent
  attaching a flowmeter, 3-47
  locating, 3-46

Split vent flow
  adjusting, 3-46
  measuring, 3-46

Splitless mode
setting up, 3-49
stopwatch, 6-91

Syringe
  cleaning, 3-71
Syringe tower, 3-64
System Status Screen, 7-4

T

TCD
  abbreviation, 1-6
  balancing the bridge, 4-53
  polarity
    changing, 4-135
  range vs. bridge current, 4-133
  setting up manual pneumatics, 4-48
  setting up PPC, 4-46
  using with PPC, 4-46

Temperature program
  isothermal
    setting up, 3-8
  setting up a multi-ramp, 3-11
  setting up a one-ramp, 3-10, 3-18

Temperature Programming, 1-13
Timed Events, 2-49
Timed Events Table, 2-50

Tools Menu, 0-3
  configuration, 6-9
  detector gas modules, calibrating, 6-64
  event log, 6-5
  maintenance, 6-7
  method editor, 6-4
  oven, 6-19
  PPC modules, connecting, 6-38
  reference temperature and pressure,
    setting, 6-59
  utilities, 6-82

Touch Screen, 0-3, 2-4
  autozero button, 2-12
  aux zone button, 2-16
  heated zones, 2-13
  ignite button, 2-12
  injector and detector buttons, 2-14
  manual injection, 2-10
  oven button, 2-16
  run button, 2-8
  signal button, 2-11
  signal display and scaling, 2-12
  signal plot, 2-12
  zero display button, 2-13

Tray, autosampler, 3-64
Turntable, autosampler, 3-64

Typical Analysis
  autosampler, 7-19
  detectors, 7-10, 7-15
  injectors, 7-6

Utilities, 6-82
  background compensation, 6-89
  column flow calculator, 6-83
  column length calculator, 6-88
  logout, 6-95
  release, 6-93
  reset, 6-94
stopwatch, 6-91
UV lamp, PID
  optimizing intensity, 4-65
  turning on, 4-64

V
Valves
  combustion, FID, 4-20

Z
Zeroing, PPC module, 6-56